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1Introducing 
Internet 
Applications 1
The Sage ERP MAS 500 Internet Applications maximize your 
system's capabilities with modules that run from a Web 
server. This chapter describes the modules and how to install 
them.

In this chapter
Internet Applications Modules  . . . . . . . . . . . . . . . . . . . . . . . 10
eCustomer Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
eSalesforce Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Business Insights Dashboard Features . . . . . . . . . . . . . . . . . . 22
Internet Applications  9



Chapter 1
Internet Applications Modules

Overview

Description The Sage ERP MAS 500 Internet Applications consist of the 
following modules:

• eCustomer enables your customers to place orders 
directly to your accounting system from the Internet.

• eSalesforce enables salespeople to manage their sales 
contacts anywhere through a Web browser.

• Business Insights Dashboard allows executives to view 
company financial information from their Web 
browser.

Discontinued 
Modules

eCustomer and eSalesforce are no longer supported by Sage. 
The modules are included on the Sage ERP MAS 500 
installation DVD as a benefit for customers who are currently 
using them and are upgrading to version 7.40. 
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Introducing Internet Applications
eCustomer Features

Overview

Summary of 
features

eCustomer provides what you need to develop a business-to-
business e-commerce system linked to your financial data in 
Sage ERP MAS 500. It includes:

• Data processing enhancements designed for Web-based 
processing.

• Enhancements to the Common Information, Inventory 
Management, and Sales Order modules to set up Web 
site folders; maintain users of the Web site; select items 
to sell through the Web site, organize them into groups 
and attach images to them; and process or purge sales 
orders with errors.

• A Web site that runs on Internet Information Services 
(IIS). You can customize the site with Microsoft Visual 
Interdev or Visual Studio and change security settings 
to fit your company's needs.

Because eCustomer is a part of Sage ERP MAS 500, purchases 
made from the Web site update the financial information in 
Sage ERP MAS 500.

eCustomer Architecture

Components used 
by eCustomer

eCustomer uses the following Microsoft components to 
perform transaction processing on the Internet:

• COM+ applications are designed for processing on the 
Internet. They manage, package, and provide security 
for transactions.
Internet Applications 11
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• IIS is used as the Internet server because it provides 
security, extensibility, and a complete set of tools for 
developing a Web site with dynamic information.

• Microsoft Messaging Queue (MSMQ) processes data in 
queues so that users do not have to wait for the 
database to be updated before completing a transaction. 
Transactions are completed when the database is 
available.

• OLE DB provides links between the databases and the 
ActiveX Data Objects (ADO) used as data interfaces. 
OLE DB enables you to specify servers and provides 
better performance than ODBC.

• Active Server Pages are used by the Web site to retrieve 
and display data. You can customize the format and 
scripting to meet your needs.

eCustomer Integration with the Rest of Sage ERP 
MAS 500

Introduction This section describes how eCustomer fits in with the rest of 
Sage ERP MAS 500. For information about using these 
features to configure eCustomer, see Chapter 5, Configuring the 
System for eCustomer.

Product categories Product categories enable you to organize the merchandise 
on your Web site into different groups, such as refrigerators, 
microwaves, and dishwashers. Within each category, you can 
create an unlimited number of subcategories. You can attach 
inventory and non-inventory items to product categories, 
assign an item to more than one product category, and 
change categories when needed.

For more information about this feature, see Making Items 
Available for Sale on page 95.
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Attaching images 
to items

eCustomer enables you to attach a number of image files to 
the items you sell through the Web site.

When the customer selects an item on the order entry page, 
the image you selected appears in an adjacent frame. If you 
have more than one image assigned to this inventory item, a 
pair of buttons appears that enables you to browse through 
images.

You can provide more than one image to show different 
views of the product, such as showing the exterior and 
interior of a refrigerator, close-ups of details, or the item in 
different colors. You can use images on your Web server, or 
you can use images available on the Internet.

Managing 
external users of 
the Web site

To support customers who will use the Web site, eCustomer 
adds features for managing user names and passwords, 
granting buyers different levels of access to the site, and 
setting transaction limits. For information, see Chapter 5, 
Configuring the System for eCustomer.

Database 
enhancements

eCustomer requires an additional Sage ERP MAS 500 database 
called the Internet application database. This database offers 
the following benefits:

• Greater security: Data used on the Web site is kept 
separate from the rest of your Sage ERP MAS 500 data. 
You can configure the Internet application database 
with different security so it is available to Web users 
while keeping the Sage ERP MAS 500 system and 
application database secure.

• Greater performance and availability: Customers do not 
have to wait to get product information or for orders to 
update the Sage ERP MAS 500 application database. 
Transactions are placed in a queue and processed when 
the Sage ERP MAS 500 production database is available.

For more information about this database, refer to the 
Installation and System Configuration guide.
Internet Applications 13
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eCustomer Web Site Features

Overview of Web 
site

The Web site provided with eCustomer is designed to be 
flexible and freely customizable. The Active Server Pages can 
be modified to use your company's graphics and design 
schemes. You can have the Web site installed on your 
preferred host and use your preferred system of security. This 
section describes features and options of the eCustomer Web 
site.

Site structure The basic eCustomer Web site has the following structure:
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Site customization You can link these pages to your existing site, add pages, and 
customize the pages to fit your needs. eCustomer comes with 
sample home pages that you can customize or replace with 
your own.

To get full functionality from the site, it is recommended that 
you do not remove any of the pages from the User Login 
branch of the Web site.

Order Processing in eCustomer

Introduction When a customer creates an order in the Web site, it updates 
the application database and appears in the Sales Order 
module. This section provides an overview of how orders are 
processed from the Web site. For more information about 
processing sales orders, see the Sales Order Help system.

Viewing Web 
orders as sales 
orders

Orders from the Web site become sales orders in the Sales 
Order module. In Sales Order, you can open, view, edit, and 
process sales orders that came from the Web site.

The following figure shows how information from a Web-
based order, as indicated on the Order Inquiry page, appears 
when you retrieve the order in Sales Order.
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Sales order  
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PO number Order total 
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Order fulfillment After the order is entered into Sage ERP MAS 500 from the 
Web site, it follows the same order fulfillment process as any 
sales order. This includes acknowledgement, picking, 
shipping, and invoicing. For more information, see the Sales 
Order Help system.

As the order is processed in Sales Order, the changes are 
reflected on the Order Inquiry page. The order status on the 
inquiry is reported as Open from the time it is received as an 
unacknowledged sales order to when it is closed.

Closed orders When you close an order from Sales Order, the order no 
longer appears on the Order Inquiry page of the Web site.

Cancelled orders Orders cannot be cancelled from the Web site. Customers 
need to contact you to have orders cancelled from Sales 
Order. When you cancel an order, it is removed from the 
Order Inquiry page.
Internet Applications 17
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eSalesforce Features

Overview

Introduction eSalesforce enables salespeople to manage their customers 
from any system through their Web browser. This enables 
salespeople to retrieve customer information while they are 
at the customer's site and place orders for that customer 
through the eCustomer Web site. 

Main features eSalesforce includes a Web site for searching and retrieving 
customer information. Like the Web site in eCustomer, you 
can customize the eSalesforce Web site to match your 
company colors and add other information.

This section explains the different parts of eSalesforce.

eSalesforce Web Site

Introduction The eSalesforce Web site is designed to be used by your 
salespeople as an interface to Sage ERP MAS 500. It gathers 
information from Sage ERP MAS 500, generates credit 
applications, and provides links to eCustomer for placing 
sales orders. For more information, see Using eSalesforce with 
eCustomer on page 21.
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Site structure The basic eSalesforce Web site has the following structure:

Supported 
customization

You can customize the eSalesforce site to use your company 
colors and formats. End users can also customize information 
that appears on the My Information page.

Orders

Shipments

Invoices

Payments

Check Out

Confimation
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Using eSalesforce in the Sales Cycle

Introduction Salespeople use the different pages of eSalesforce at different 
stages of the sales cycle. They can use pages to convert leads 
into customers and generate orders. These features are 
described in this section.

Terminology eSalesforce uses the following terminology to describe the 
parts of the sales process:

Term Description

Customer A person or company who is ready to 
order or has already placed an order. A 
customer record is set up in Sage ERP 
MAS 500 that enables that person or 
company to place orders.
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Overview of 
process

The following figure shows the sales process.

Using eSalesforce with eCustomer

Introduction Use eSalesforce with eCustomer to enable salespeople to place 
orders for the customer. 

Process of using 
the modules 
together

Salespeople use the combined modules as follows:

1 When customers want to place an order, salespeople 
look up the customer information on the eSalesforce 
Web site using the Customer Search page.

2 From the search page, they launch eCustomer. They are 
logged into your company eCustomer site as an 
authorized buyer for that customer.
Internet Applications 21



Chapter 1
Business Insights Dashboard 
Features

Overview

Introduction Business Insights Dashboard includes a series of key business 
data components (also referred to as Web Parts) that generate 
summary information and charts from your financial 
information. These components appear in the user's Web 
browser and can be customized. 

The Business Insights Dashboard contains three tabs: 
Dashboard, Explorer, and Links. The Dashboard tab contains 
a one-stop view of all your key business data. The Explorer 
tab allows you to view sales, purchases, inventory, project, 
and production information for the selected company. The 
Links tab allows you to view or add links to other Web sites. 

This section describes information about Business Insights 
Dashboard installation. For more information about 
configuring Business Insights Dashboard, see Chapter 7, 
Configuring Business Insights Dashboard. For information about 
using Business Insights Dashboard, refer to the Help system.
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Operation of Business Insights Dashboard

Overview The Business Insights Dashboard is a Web site that provides 
executives with the ability to view and customize key 
business data for a selected company. You can also use the 
Business Insights Dashboard Web site to view Business 
Insights Explorer data, as well as set links to commonly used 
sites. Business Insights Dashboard uses ASP.NET technology 
to deliver consolidated data from the Sage ERP MAS 500 
database to the client Web browser. ASP.NET contains the 
Web Part Manager which is a server control that manages all 
functionality, events, and customization of Web Parts within 
the Dashboard Web pages.

To learn more about using the Business Insights Dashboard, 
access the Business Insights Dashboard tutorial by clicking 
Tutorials on the Sage ERP MAS 500 Desktop.

Flow chart The following figure shows how the Business Insights 
Dashboard works:
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Updates The data that appears in the Business Insights Dashboard 
Web site is updated according to the schedule you define in 
Set Up CI Options. You can also generate manual updates. For 
more information, see Setting Site Options in Sage ERP MAS 500 
on page 78.

Installation of Business Insights Dashboard

Where Business 
Insights 
Dashboard is 
installed

Business Insights Dashboard is installed as an IIS application 
on the same Web server as the other Internet applications. 

Requirements Business Insights Dashboard requires ASP.NET and AJAX 
extensions, both of which are installed automatically if your 
system does not have these installed.

Security Business Insights Dashboard requires Windows 
authentication. It cannot be configured for anonymous 
access. For more information, see Security on page 32.
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2Site Hosting 
and 
Configuration 2
This chapter describes hosting and configuration issues to 
consider when setting up your Web sites. Each Internet 
Application has different requirements, so you need to 
configure the sites for the appropriate level of security. The 
server where the Web sites are hosted need access to the Sage 
ERP MAS 500 server, so you need to configure the necessary 
components to enable the Web sites to communicate with 
the Sage ERP MAS 500 databases.

In this chapter
Information Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Site Hosting Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Security. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Addresses of the Web Sites. . . . . . . . . . . . . . . . . . . . . . . . . . . 37
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Information Processing

Overview

Introduction This section provides examples of how information is 
processed by the Internet Applications and Microsoft Web 
components. An understanding of this information will help 
you to plan your Web sites.

Internet Application Processing

Introduction When customers connect to the Internet Applications Web 
sites, they interface with IIS and COM+ applications. The 
COM+ applications perform data retrieval and update tasks.

Data inquiries for 
eCustomer and 
eSalesforce

When a user requests information on the Web site, such as an 
order inquiry or to see what merchandise is available, the 
request is sent through HTTP to IIS. A COM+ application for 
data access retrieves a disconnected set of tabular data and 
copies it to the user's client system.
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eCustomer 
processing

eCustomer uses queued processing. When a customer places 
an order from the eCustomer Web site, it is put into a queue 
to be added to the database as soon as it is available. This 
type of processing benefits the user in the following ways:

• The customer does not need to wait until the database 
is updated to continue using the Web site. 

• If the connection to the application database is down, 
the request is not lost. The request remains in the queue 
and is processed on the database when the server 
becomes available.

When a request is made from the eCustomer Web site, two 
queued COM+ applications are used. These components are 
part of Microsoft Messaging Queue (MSMQ):

• Recorder: Packages the order into a request to update 
the database.

• Player: Sends the information to the server to update 
the database.

For example, when the customer places an order on the 
eCustomer Web site, the following happens:

1 The recorder does the following:
� Draws information from the Internet application 

database to package a transaction to update the 
application. 

� Sends a message back to the customer 
acknowledging the order. 

2 The package is then put in a queue to be sent to the 
application database. 
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3 Depending on the availability of the application, one of 
the following happens:
� If the application database is available, the 

transaction updates the application database 
immediately. 

� If the COM+ application cannot connect to the 
application database, the transaction remains in the 
queue until the application database can be 
updated.

The following chart shows how the process works.

After the order enters Sage ERP MAS 500, it is processed as if it 
were entered directly in the Sales Order module. For more 
information, see Internal Hosting on page 29.

eSalesforce and 
Business Insights 
Dashboard

eSalesforce and Business Insights Dashboard use scheduled 
SQL Server tasks to update data. For more information, see 
Setting SQL Server Schedules on page 80.
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Site Hosting and Configuration
Site Hosting Options

Overview

Introduction The Internet Applications are flexible enough to work with 
your current Web hosting system and preferred method of 
security. This section describes options for hosting and 
security.

You can place the Web site on an intranet, an internal Web 
server, or a separate Internet service provider (ISP). This 
section explains how to configure the Internet Applications 
for different types of hosting.

Internal Hosting

Introduction If your company does its own Web hosting (either on-site or 
in a co-location), install the Internet Applications on your 
Web server. Then surround the Web server with firewalls (one 
to protect it from the outside and the other to limit access by 
internal users).

NetBIOS 
connection 
requirement

To install the Internet Applications Web components on the 
Web server, you need to have local access on your system to 
the system's local drives through NetBIOS. You also need 
NetBIOS access to the shared folder for inventory images. 
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Sample site 
configuration

The following figure shows an example of an internal hosting 
setup.

Hosting Through an ISP

Introduction The Internet Applications can also be hosted by an external 
ISP.

NetBIOS 
connection 
requirement

As with the internal Web server, you need to have direct 
access to the Web server's local C drive through NetBIOS to 
install the eCustomer Web components. You also need 
NetBIOS access to the folder used for inventory images for 
eCustomer.

The ISP can grant you access through a virtual private 
network (VPN) to communicate to the Web server. If the ISP 
does not have a VPN available, you will need to either go to 
the physical server and install it directly or send the Internet 
Applications installation DVD-ROM to the ISP and have them 
install it for you.

NetBIOS access to

share on server

for Inventory images

OLEDB access to 

SQL Server through the 

firewall

Internet

Internet

Applications

user

Firewall

HTTP

access

to Web

server

Internet

Applications

Web server

with IIS
Firewall

Local Area Network

LAN

Sage ERP 

MAS 500 user

SQL Server

with Sage ERP MAS 500 

databases
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Sample 
configuration

The following figure shows an example of a hosted setup.
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Security

Overview

Introduction To protect your data and control access, Internet Applications 
work with security provided with Sage ERP MAS 500, IIS, and 
the COM+ applications.

This section describes features and issues that you should 
consider in setting up security for your site. For more 
information, see the Microsoft IIS and COM+ documentation 
or the Microsoft Web site at www.microsoft.com. If you have 
concerns about setting up security yourself, work with your 
ISP or a consultant to set up the best security for your site.

General Security Considerations

Public and private 
site 
considerations

The amount of security you set for a Web site depends on 
whether the site should be public or private. For private sites, 
configure them for high security. For public sites, you must 
balance the need for security with the need to make your 
Web site accessible. Some forms of security can make it 
difficult for legitimate users to enter and discourage them 
from visiting your site.

Web Site
Recommended 
type of site

Security issues

eCustomer Public Anonymous access can be 
used for greater access

Secure administrative 
folders to prevent public 
access
32 Internet Applications
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Site Hosting and Configuration
Controlling access 
to the Web site 
and data

To gain access to portions of the Web site and data, users 
need to be authenticated either by having them enter a logon 
name and password or by using logons set up in the system. 

This section explains how security and logons work. For more 
information, see Configuring the Web Site on page 91.

Firewalls Surround the Web server with two firewalls: one protecting 
the links from Internet and the other protecting links from 
internal users. The firewall on the internal link also protects 
your internal systems if someone manages to breach the 
external firewall. Configure the firewalls to allow access to 
port 80.

Firewalls are your first line of defense, but they should not be 
the only one. You should configure the Web server to provide 
additional protection.

Access to the Web 
site

The Internet Application Web sites use IIS to grant access. 
The settings for each site are different:

• The eCustomer Web site uses an anonymous logon 
because it is a site you want to make readily available to 
external customers. When users go to your Web site, 
they are not prompted to log on. They are 
authenticated automatically by the system using a 
system-generated logon and password. (You can replace 
the system-generated logon with a dedicated user logon 
on the system.)

eSalesforce Private Anonymous access not 
recommended

Business 
Insights 
Dashboard

Private Windows authentication 
required

Cannot use anonymous 
access

Web Site
Recommended 
type of site

Security issues
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• The eSalesforce Web site uses Windows authentication 
to restrict access to salespeople on your domain who are 
configured to have access in Sage ERP MAS 500.

• The Business Insights Dashboard Web site uses 
Windows authentication. You need to configure the 
Web server to grant access to the Web site only to the 
users who need it.

You can provide additional security through IIS by granting 
authenticated access to folders, the system, or the domain. If 
you use this feature, you also need to create a local account 
on the Web server with a user name and password for the 
system or domain; this account does not create the logon for 
the Web site in Sage ERP MAS 500. The authentication of 
folders in IIS requires that the Web site be on an NTFS 
volume. 

You can also use the options provided with NTFS to provide 
additional access to your Web site. For example, you can set 
some folders as read-only to prevent them from being 
modified by unauthorized users. You can also limit access to 
some folders entirely to all but specific users.

Access to 
transaction 
processing

The eCustomer Web site uses Sage ERP MAS 500 security to 
restrict access to the transaction portion of the Web site. The 
Web site has a logon page where the user name and password 
are authenticated.

Users of the site are granted access either through Sage ERP 
MAS 500 or through a page on the Web site available to 
administrators. For more information, see Chapter 5, 
Configuring the System for eCustomer.

Access to COM+ 
applications

COM+ applications require a valid logon by a user of either 
the Windows Server or the domain where it is located. A 
default COM+ logon is created during installation. This logon 
can be changed. For more information, see Settings Generated 
Automatically by the Installation on page 56.
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Secure Socket Layers (SSL)

Introduction You can use SSL with any of the security methods described 
in this section to add greater security to the Web site. Your 
customers will appreciate the protection SSL gives them as 
they send their sensitive information through your site.

How SSL works SSL provides a secured communications channel. Data is 
encrypted while it is in transit. The data is decrypted when it 
reaches its destination, but it is also decrypted at routers and 
bridges that it stops at on the way.

Web sites with SSL are connected with HTTPS instead of 
HTTP. A padlock icon appears on the status bar of the browser 
window when a user visits a site with SSL.

SSL and 
certificates

To use SSL on a Web site, you need to set up a certificate for 
the Web server. Certificates grant further security by using 
keys to authenticate the transaction: your public key and the 
customer's private key.

Certificates can be generated in the following ways:

• You can obtain certificates from a public certificate 
authority. These certificates are normally accepted 
automatically by external users.

• You can generate your own certificate using Windows 
certificate services. By default, these certificates are not 
trusted by external users. Users are prompted to accept 
the certificate each time they log on to your site, but 
they have the option of installing the certificate so that 
they accept the certificate automatically.

See the IIS documentation for instructions on obtaining and 
installing certificates.
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SSL options After you have set up a certificate for the server, you can 
select SSL options for the Web site. 

One of the options you can use is 128-bit encryption. This 
offers a high level of security for data transmissions. Keep in 
the mind that if you use 128-bit encryption, the user of your 
site must have a 128-bit version of Internet Explorer, which is 
not available outside the United States. If you plan to support 
users from different countries, avoid using 128-bit 
encryption.

Effects of using 
graphics

If you use SSL with your Web site, you should put all images 
of items on your Web server or on another server with SSL. If 
you have images on a server without SSL, the following 
message appears each time the user connects to your site:

The message indicates that there are elements on the page 
that are not secure. This does not affect the secure 
communications between the client system and your Web 
site. To avoid having the message appear whenever customers 
enter the site, put all images on your server.
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Addresses of the Web Sites

Overview

Introduction An address of a Web site is based on the IIS application name 
of the Internet Applications Web site. The Web sites are 
typically installed in subfolders of \Inetpub\wwwroot. When 
you access the pages from a browser, replace 
\Inetpub\wwwroot with the domain name of the Web server.

This section describes how the addresses are determined, so 
that you can determine what URL to use for the Web sites.

IIS Folder Names

Default IIS 
application names

The default IIS folder names for the Internet Applications are 
as follows:

Location of files By default, files for an Internet Application are installed into 
a folder based on the IIS application name. If you used 
eCustomer as the IIS application name for eCustomer, the 
files are installed into C:\inetpub\wwwroot\eCustomer. You 
can have the files installed into a different folder by using 
Custom installation. For more information, see Installing the 
Software on page 60. 

Application Default Folder

eCustomer eCustomer

eSalesforce eSalesforce

Business Insights Dashboard BusinessInsightsDashboard
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Changes on 
upgrades

If you are upgrading from a previous version of the Internet 
Applications that used the default folder names, the old 
folders and IIS application names are deleted and new ones 
are created with the new default names. Be sure to inform 
your users of the changes and have them update their 
bookmarks. The Business Insights Dashboard ChartImages 
folder may remain and requires manual removal. 

Determining the URL

Domain and 
folder names

The URL for an Internet Application is the following format:

http://WebServer/ApplicationName

Where WebServer is the Web server domain name and 
ApplicationName is the name of the IIS application name.

For example, if the domain name of the Web server is 
www.mycompany.com, and you use the default IIS 
application name, eCustomer, the eCustomer URL is:

http://www.mycompany.com/eCustomer

Typing this URL opens the default page of the Web site after 
you finish configuring the Web site.

Using different 
folder names

During installation, you can select a different IIS application 
name. If you are running a publicly accessible site, you might 
choose a more descriptive name than the default.

Suppose you want to use the following URL:

http://www.mycompany.com/weborder

In the Installation wizard, enter weborder as the IIS 
application name for the Web site.

Changing the 
computer name

Use caution when changing the name of the Web server. 
After renaming the Web server, edit the anonymous logon 
account for the Internet Information Services (IIS). Then 
change the logon to a valid domain and user account.
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3Preparing for 
Installation 3
This section covers prerequisite steps and information that 
you need before you start installing the Internet 
Applications. This information affects how the Web site 
operates, so read this information carefully before installing 
the Web components.

In this chapter
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Installing Required Software  . . . . . . . . . . . . . . . . . . . . . . . . . 46
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System Requirements

Overview

Introduction To ensure a smooth installation, make sure that the servers 
and workstations you plan to use with the Internet 
Applications meet the system requirements shown in this 
section.

Overall System Requirements

Compatibility and 
Resource Guide

For more information about system requirements, supported 
platforms, and recommended configurations, refer to the Sage 
ERP MAS 500 Compatibility and Resource Guide located in the 
Support area of the Sage Online Web site at:

http://support.sagesoftwareonline.com/mas500/support/
documents/matrices.cfm

eCustomer Requirements

Required software To set up customers in eCustomer, you require the Sage ERP 
MAS 500 Inventory Management and Sales Order modules.

Business Insights Dashboard Requirements

Required software Business Insights Dashboard requires ASP.NET and AJAX 
extensions, both of which are installed automatically if your 
system does not have these installed.
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Case Sensitivity

Description This version of Sage ERP MAS 500 supports case-insensitive 
SQL Servers only. To upgrade from a case-sensitive server, see 
your authorized reseller for assistance.

Administrator Requirements

Accounts that 
need 
administrator 
access

Before installing the software, you need to be logged onto the 
Web server as a local administrator. You also need to make 
sure that the following user accounts on the server where the 
Web components will be installed are also configured as 
administrators:

• IUSR_computername

• IWAM_computername

Where computername is the physical name of the computer. 
For example, if the name of the computer is WEBSERV1, 
these accounts would be called IUSR_WEBSERV1 and 
IWAM_WEBSERV1.

Note: When configuring Internet Information 
Services (IIS) 7 on Windows Vista and Windows 
Server 2008, you need to add the IUSR user and the 
user used in the Application Pool Identity field to 
have access as an administrator.

Checking the 
settings

Follow these steps to check the settings:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Computer Management.

2 In the Tree pane of the Computer Management 
window, click Local Users and Groups.

3 In the Computer Management window, click Users. A 
list of user accounts appears. Widen the column if 
needed to view the entire name.

4 Right-click IUSR_computername and select Properties.
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5 In the Properties window, click the Member Of tab. 
Perform the following:
� In the Member Of box, click Guest, and then click 

Remove.

� Click Add. From the window that appears, select 
Administrators and then click Add. Click OK to 
close the window.

6 Click OK to close the Properties window.

7 Repeat steps 4 through 6 for IWAM_computername.

Configure Windows 2003 Server
If you are running Windows 2003 Server, make the following 
settings in addition to the settings mentioned in Installing 
MSMQ for Windows 2003 Server on page 46.

Note: The following information regarding enabling 
ASP.NET, Active Server Pages, and WebDAV applies 
to the Standard and Enterprise editions of Windows 
2003 Server.

Enable ASP.NET Use the following steps to enable the ASP.NET component in 
the Windows Component Wizard.

1 In the Control Panel window, open Add/Remove 
Programs.

2 In the Add/Remove Programs window, click Add/
Remove Windows Components. 

3 In the Windows Components Wizard page, select the 
Application Server check box, and then click Details.

4 In the Application Server window, select the ASP.NET 
check box, and then click OK.
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Enable the Active 
Server Pages and 
WebDAV 
extensions

Use the following steps to enable the Active Server Pages and 
WebDAV extensions in the Internet Information Services (IIS) 
Manager window.

1 In the Control Panel window, open Administrative 
Tools.

2 In the Administrative Tools window, open Internet 
Information Services (IIS) Manager.

3 In the Internet Information Services (IIS) Manager 
window, expand the Web Service Extension folder.

4 Highlight Active Server Pages, and then click Allow.

5 Highlight WebDAV, and then click Allow.

6 Close the Internet Information Services (IIS) Manager 
window.

Configure Windows 2008 Server
If you are running Windows 2008 Server, make the following 
settings in addition to the settings mentioned in Installing 
MSMQ for Windows 2008 Server on page 47.

Enable ASP.NET Use the following steps to enable the ASP.NET component.

1 In the Administrative Tools window, open Server 
Manager.

2 Select the Roles folder, and click Add Role Services.
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3 In the Select Server Roles window, select the Web Server 
(IIS) check box, and click Next.

4 In the Web Server (IIS) window, click Next.
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5 In the Select Roles Services window, select the ASP.NET 
and ASP check boxes, and then click Next.

6 In the Confirm Installation Selections window, click 
Install.
Internet Applications 45



Chapter 3
Installing Required Software

Overview

Introduction Before installing the Internet Applications, you need to 
install the software as shown in following sections:

Installing MSMQ for Windows 2003 Server . . . . . . . . . . . . . 46
Installing MSMQ for Windows 2008 Server . . . . . . . . . . . . . 47
Installing and Upgrading Sage ERP MAS 500 . . . . . . . . . . . . 48

This section covers issues you need to know when installing 
this software for use with the Internet Applications. For more 
information about installing these products, refer to the 
applicable installation documentation. 

Installing MSMQ for Windows 2003 Server

Introduction You need to have Microsoft Messaging Queue (MSMQ) on the 
Web server before you can install the Internet Applications. If 
MSMQ is not installed on the Web server, a message appears 
when you start the Internet Applications installation 
prompting you to install MSMQ.

Procedure Follow these steps to install MSMQ:

1 In the Control Panel window, open Add/Remove 
Programs.

2 In the Add/Remove Programs window, click Add/
Remove Windows Components. 

3 Select the Message Queuing check box, and click 
Details.

4 When the Message Queuing window appears, clear the 
Active Directory Integration check box, and then click 
OK.
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5 As you run the Windows Component Wizard, use the 
default settings, except for the settings that you already 
set in steps 3 and 4 (keep the Message Queuing check 
box selected and the Active Directory Integration check 
box cleared).

6 When you have selected your options, click Finish to 
add the components. Reboot the system, if directed.

Installing MSMQ for Windows 2008 Server

Introduction You need to have Microsoft Messaging Queue (MSMQ) on the 
Web server before you can install the Internet Applications. If 
MSMQ is not installed on the Web server, a message appears 
when you start the Internet Applications installation 
prompting you to install MSMQ.

Procedure Follow these steps to install MSMQ:

1 In the Administrative Tools window, open Server 
Manager.

2 Select the Features folder, and click Add Features.

3 In the Select Features window, scroll down the list of 
component to Message Queuing. 
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4 Select the Message Queuing Services check box, and 
click Next.

5 When you have selected your options, click Install. 
Reboot the system, if directed.

Installing and Upgrading Sage ERP MAS 500

General 
installation steps

Installing Sage ERP MAS 500 and the Internet Applications 
consists of installing or upgrading Sage ERP MAS 500, and 
installing and configuring the Internet Applications on the 
Web server. For complete installation instructions for Sage 
ERP MAS 500, refer to the Installation and System Configuration 
guide.
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The following chart shows an overview of the installation 
and configuration process.

Required tasks Before installing the Internet Applications, install or upgrade 
Sage ERP MAS 500. Follow the instructions in the Installation 
and System Configuration guide and be sure to perform the 
following:

• For a new installation, install new system, application, 
and Internet application databases. For an existing 
installation, upgrade the current system and 
application databases to the new version and install an 
Internet application database on the same SQL Server.

Are you

upgrading an existing 

Sage ERP MAS 500 

system?

No

Do you have all 

of the Internet 

Applications?

Upgrade

Sage ERP 

MAS 500, 

including all 

databases

Yes

Upgrade Sage ERP 

MAS 500 and install the 

needed databases

No

Install Sage ERP 

MAS 500, including all 

databases

Back up your 

existing Internet 

Application sites 

before installing 

the new version

Install the Internet 

Applications

Make sure Web 

server meets 

requirements and 

has MSMQ

Yes

Configure security 

on IIS

Configure data link  

between Web sites 

and Sage ERP 

MAS 500 

databases

Use site 

configuration 

pages to start site 

and select 

company

Set site options in 

Sage ERP 

MAS 500

Customize the site 

to use your 

company name 

and colors
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• Install the Sage ERP MAS 500 client software on at least 
one system. For eCustomer only, the system needs to 
have NetBIOS access to the shared folder for inventory 
images either through the network or a VPN. For 
information, see Using the Folder for Item Images on 
page 90.

• Register and activate the applicable modules:

Note: There are no eCustomer, eSalesforce, and 
Business Insights Dashboard links on the Sage ERP 
MAS 500 Desktop. These modules refer to the Web 
components and features in Sage ERP MAS 500 
modules to support the Web site. 

• Make sure your sales order system is set up correctly. See 
the Sales Order, Accounts Receivable, and Inventory 
Management Help system for information on which 
options need to be configured.

eCustomer eSalesforce
Business Insights 
Dashboard

  Accounts 
Receivable 

eCustomer 

Sales Order 

Inventory 
Management

Accounts 
Receivable

Accounts 
Receivable 

Cash Management 

Business Insights 
Dashboard *

General Ledger 

Inventory 
Management 

Sales Order 

* Only Business Insights Dashboard is required to be registered and activated. The 
other modules listed under Business Insights Dashboard provide data for Web Parts. 
Activate only the modules you purchased. Business Insights Dashboard Web Parts 
show data only for modules you registered and activated.
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Security rights 
required

Users who administer and configure the Internet 
Applications need access rights to several tasks in Sage ERP 
MAS 500. The following table lists the minimum set of tasks 
that require Normal access rights for each of the Internet 
Applications.

Module eCustomer eSalesforce
Business Insights 
Dashboard

Common 
Information

CI External User 
List 
CI Maintain 
External Users 
CI Maintain Non-
Stock Items 
CI Options Setup

CI Contact Maint 
CI Options Setup

CI Options Setup

Accounts 
Receivable

AR Customer Maint AR Customer Maint 
AR Salesperson 
Maint

Inventory 
Management

IM Maintain Items 
IM Product 
Category List 
IM Set Up Product 
Categories

Sales Order SO Entry
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4Installing 
Internet 
Applications 4
This chapter shows you how to install the Internet 
Applications.

In this chapter
Web Component Installation . . . . . . . . . . . . . . . . . . . . . . . . 54
Configuring Internet Applications  . . . . . . . . . . . . . . . . . . . . 70
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Web Component Installation

Overview

Introduction After the Web server is ready, run the installation wizard to 
install the Web components with the parameters you specify.

Method of Installation

Description You can install the Internet Applications using the Internet 
Applications Installation wizard, which allows you to install 
the Internet Applications alone. Use this wizard for installing 
a production system.

For information about this installation method, run the 
Installation Advisor from the Installation screen or refer to 
the Installation and System Configuration guide.

Pre-Installation Checklist

Introduction Before you begin installing the Internet Applications, make 
sure you have the following information. See the indicated 
pages of the Internet Applications guide for details.
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Checklist Complete the following checklist:

Information See

Applications 
to install

• All (Can use Complete 
installation)

• eCustomer alone or with 
another application (Use 
Custom)

• eSalesforce alone or with 
another application (Use 
Custom)

• Business Insights 
Dashboard alone or with 
another application (Use 
Custom)

Page 60

IIS 
application 
names

eCustomer 
_____________________________ 
eSalesforce 
_____________________________ 
BusinessInsightsDashboard 
_____________________________

Page 38

Sage ERP 
MAS 500 
databases

_iapp 
___________________________ 
_app  
___________________________ 
User name for databases 
___________________________ 
Password for user 
_____________________________

Page 48
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Settings Generated Automatically by the 
Installation

Description This section describes the settings that are generated 
automatically by the eCustomer and eSalesforce installation. 
You can change these settings after the installation if needed. 
These include:

• Default Windows user for launching COM+ 
applications.

• Default data link user for linking Sage ERP MAS 500 
databases to the Internet Applications.

Default COM+ 
user

COM+ applications are usually in Interactive User mode, 
which means that they are not started until a user physically 
logs into the Windows Server where the Web server is 
located. To start COM+ applications automatically whenever 
the Windows Server is booted (whether or not someone logs 
on), the Internet Applications installation creates a default 
dedicated user logon. You can use it or assign it to another 
user.

The default COM+ user created by the installation is 
MAS_500_USER and has a randomly generated password.

Default data link 
user

To link the databases to the Internet Applications, the 
installation creates a data link configuration file for each 
Internet Application. These files have .udl extensions.

The installation program also creates a default user on the 
SQL Server called IAppUser. This has a randomly generated 
password.
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Assigning the 
COM+ user to the 
data link

The default COM+ user and default data link user created by 
the installation are separate and do not need to be connected.

To create a trusted connection, you can assign the default 
COM+ user in the data link configuration file, but you need 
to grant the COM+ user access rights to the SQL Server. For 
instructions on doing this, see the Microsoft documentation.

Starting the Internet Applications Installation 
Wizard

Introduction This section describes how to install the Internet Applications 
by using the Installation wizard.

Ways of starting 
the Installation 
wizard

To start the Internet Applications Installation wizard, 
perform one of the following:

• Insert the Sage ERP MAS 500 DVD-ROM into the DVD-
ROM drive. From the installation window that appears, 
click Internet Applications.

• Use Windows Explorer to navigate to the InternetApps 
folder on the DVD-ROM. Run Setup.exe.

• If you send the installation files to an ISP by FTP, have 
them copy all the files to the same folder. Then, have 
them run Setup.exe.

Use of Windows 
Installer

All Sage ERP MAS 500 installation programs use the Microsoft 
Windows Installer engine. The installation program uses the 
latest version of the Windows Installer engine if it is already 
on the system; however, if it is not currently on the system, a 
message appears indicating that the Windows Installer 
engine is installing. It may take a moment to install the 
software, and then the installation starts.

The installation program also installs Microsoft .NET 
Framework if it is not already installed on the system.
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Installation 
Wizard opening 
screen

When the Internet Applications installation starts, the 
following window appears:

Click Next. To continue with the installation, see the section, 
Installing the Software.
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Uninstallation of Prior Versions

What gets 
removed

If you have an earlier version of the Web components on 
your system, the installation wizard detects it and prompts 
you to remove it before you install the new software. 
Removing an earlier version does the following:

Click Remove to uninstall the old software. The wizard then 
starts the installation process.

Important: The old folders and IIS application names 
are removed and new ones are created using either 
the new default names or the names you specified. 
For more information, see IIS Folder Names on 
page 37.

Removed Not Removed

All files that were installed. 
including HTML pages, 
graphics, scripts

Customized pages that have 
the same names as the 
original

COM+ applications and 
packages

Service packs and monthly 
updates added to the 
installation

Pages added to the site

Customized pages

Queues

Business Insights 
Dashboard ChartImages 
folder

Digital Dashboard
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Installing the Software

Procedure Use the following procedure to install the Internet 
applications.

1 In the Welcome screen, click Next.

2 Review the license agreement that appears on the 
Customer Information page. Then, select “I accept the 
terms in the license agreement” and click Next to 
continue.

3 You are prompted to enter your information. The fields 
display the name and organization as recorded in the 
Windows Registry. You can change this information as 
needed and select whether the software is available to 
all users or just yourself. Click Next to continue.

4 The following setup options are available:
� Complete: Installs all components into their default 

folders. Use this option if you want to be sure you 
are installing all files and have sufficient space on 
drive C. For more information, see IIS Folder Names 
on page 37.
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� Custom: Allows you to select which components to 
install and the drive and folder where files will be 
installed. Use this option if you are limited on disk 
space or want more control over the installation. 
eCustomer and eSalesforce are installed in folders 
based on their IIS application name; Business 
Insights Dashboard is installed in the 
BusinessInsightsDashboard folder under the folder 
you selected.

Important: Use the Custom option if you do not want 
to install all of the Internet Applications or if the 
default installation is not an NTFS volume. 
Installing the Internet Applications on an NTFS 
volume is not required, but it enables you to take 
full advantage of security features. 

Select the option and click Next.

If you selected Custom, go to the next step. If you selected 
Complete, go to step 6.
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5 If you select Custom, the following page appears: 

Complete the page as follows:

� By default, all Internet Applications are installed. If 
you do not want to install a module, click it and 
select “This feature will not be available” from the 
menu that appears. To install the feature, select 
“This feature, and all subfeatures, will be installed 
on local hard drive.”

� To change the drive and path where the Internet 
Applications will be installed, click Change. Click 
Space to see how much space is available on your 
drives and how much space will be used by the 
database installation software. Note that some files 
will be installed on the local hard drive.

Click Next to continue.
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6 If you are installing eCustomer, the Installation 
Requirements page appears.

Enter the following for eCustomer:

� The IIS application name for eCustomer. This is 
used as the name of the folder where the Web 
components are installed and to identify the Web 
site in IIS, queues, and other places in the system.

� The name of the SQL Server and the Sage ERP 
MAS 500 database you are using. Enter the name of 
the Internet Applications database (_iapp).

� A user name and password for that database.

Click Next to continue.
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7 If you are installing eSalesforce, the Installation 
Requirements page appears.

Enter the following for eSalesforce:

� The IIS application name for eSalesforce. This is 
used as the name of the folder where the Web 
components are installed and to identify the Web 
site in IIS, queues, and other places in the system.

� The name of the SQL Server containing the Sage 
ERP MAS 500 database you are using. If you have 
already selected a server for eCustomer, it will 
display in this field and must be used.

� The name of the application (_app) Sage ERP 
MAS 500 database you are using. The database must 
be on the indicated or selected SQL Server.

� A user name and password for that database.

Click Next to continue.
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8 If you are installing Business Insights Dashboard, the 
Installation Requirements page appears.

Enter the following for Business Insights Dashboard:

� The IIS application name for Business Insights 
Dashboard. This is used as the name of the folder 
where the Web components are installed and to 
identify the Web site in IIS, queues, and other 
places in the system.

� The name of the SQL server containing the Sage ERP 
MAS 500 database you are using. If you have already 
selected a server for other Internet applications, it 
will appear in this field and must be used. For more 
information on securing your connection, see 
Chapter 7, Configuring Business Insights Dashboard.

� The name of the application (_app) Sage ERP 
MAS 500 database you are using. The database must 
be on the indicated or selected SQL Server.
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� A user name and password for the application 
database.

Click Next to continue.
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9 In the Ready to Install the Program page, click Install to 
install the software. 

10 In the final page that appears, click Finish.
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Changing the Installation

Introduction You can remove Web components, change the configuration, 
or reinstall components by running the Installation wizard. 
When you run the wizard on a system that already has the 
the Internet Applications installed, the wizard presents an 
appropriate set of options.

Procedure Follow these steps to run the client installation to make 
changes:

1 Start the Installation wizard as shown in Settings 
Generated Automatically by the Installation on page 56. 
When the Installation wizard starts, click Next to 
continue.

2 The following page appears: 
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Note: Selecting Remove from this screen does not 
uninstall service packs, monthly updates, or hot 
fixes you added to the current version of the Web 
components. If you are running the installation 
wizard to update an older version, clicking the 
Remove button does remove those items. 

Select the desired option:

� To change the installation, select Modify.

� If you experienced problems with the software or 
need to repair a corrupted installation, select Repair. 
This reinstalls any missing or damaged files.

� To uninstall the software from the system, select 
Remove.

3 A screen appears where you can confirm your action. 
Click Install (for Modify or Repair) or Remove to 
proceed.
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Configuring Internet Applications

Overview

Introduction You need to configure the Web components to connect to the 
Sage ERP MAS 500 databases, set up the security, open the 
Web site, and set general options in Sage ERP MAS 500. 

Follow all of the procedures in this section in the order listed 
in the following sections:

Setting Web Site Security  . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Securing Specific Pages and Folders  . . . . . . . . . . . . . . . . . . . 74
Setting Site Options in Sage ERP MAS 500 . . . . . . . . . . . . . . 78
Setting SQL Server Schedules  . . . . . . . . . . . . . . . . . . . . . . . . 80
Setting SQL Server Schedules for an Express Installation . . . 83
Continuing the System Configuration . . . . . . . . . . . . . . . . . 87
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Setting Web Site Security

Introduction Run the Internet Information Services Manager to check 
security and other Web site settings. You can use the standard 
security or add other levels of security. For more information, 
see Security on page 32.

Note: If you are setting up the Web site security for a 
Windows 2008 Server, refer to the Setting Web Site 
Security on Windows 2008 Server on page 73.

Procedure To set security options, perform the following:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Internet Information Services. 

2 Look for the name of the Web site and right-click it. 
From the menu that appears, select Properties. The 
following window appears:

From this window, set the options you need for the site as 
shown in the following sections.
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Setting up 
standard security

To use standard security, follow these steps in the Web site 
Properties window.

1 Click the Directory Security tab. Under “Anonymous 
access and authentication control,” click Edit. The 
following window appears:

2 Depending on the Web site you are configuring, set the 
options as follows:
� eCustomer: Select the Anonymous access and 

Integrated Windows authentication check boxes.

� Business Insights Dashboard and eSalesforce: Clear 
the Anonymous access check box. Leave the 
Integrated Windows authentication check box 
selected.

3 Click OK to accept the changes.

Setting up 
authenticated 
access

For additional security for the Web server, you can set up IIS 
to authenticate people using the site. Users first need to log 
on to the Web server and then log on to the Web site. The 
logons are separate and unlinked. They can be different for 
the same customer. See the IIS documentation for 
instructions.
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Setting Web Site Security on Windows 2008 
Server

Introduction Run the Internet Information Services Manager to check 
security and other Web site settings. You can use the standard 
security or add other levels of security. For more information, 
see Security on page 32.

Procedure To set security options, perform the following:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Server Manager. 

2 Select Roles folder > Web Servers (IIS) > Internet 
Information Services (IIS) Manager.

3 Select the application to configure, and double-click 
Authentification.
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4 Enable the appropriate security model for your 
application, and close the window.

Securing Specific Pages and Folders

Introduction To prevent pages and folders from being used by 
unauthorized people, apply security to them through IIS. If 
you installed the Internet Applications on an NTFS volume, 
you can limit access to specific users or groups using NTFS 
security permissions.

Setting 
authenticated 
access in IIS

The first step in securing pages is to require authenticated 
access. An external user must log on with a valid user name 
for the Web server or its domain to gain access to the files.

To run Internet Information Services (IIS) Manager, follow 
the procedures in Setting Web Site Security on page 71. Then, 
perform the following:

1 In the Tree pane, expand the listing for the Web site. 
One of the folders in the listing is Administration. You 
can set security for an entire folder or individual files.

2 Right-click the folder or the file, and from the menu 
that appears, select Properties.

3 In the Properties window that appears. Click the 
Directory Security tab. Under “Anonymous access and 
authentication control,” click Edit.
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4 In the Authentication Methods window that appears, 
remove checks from all boxes, except Integrated 
Windows authentication, as shown in the following 
figure:

Note: If you are not using SSL, you will receive a 
warning that your password might be examined 
during authentication. Click Yes to continue. 

5 By default, the system uses the local Windows domain 
where there Web server is located to authenticate. To 
authenticate using another domain, click Edit. In the 
dialog box that appears, select the domain to use and 
click OK.

6 Click OK to close the Authentication Methods dialog 
box. Then close Internet Information Services.
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Limiting access to 
the file or folder

IIS only enables you to limit access to a folder or file to 
authenticated users of the Web server or domain. To restrict 
access to certain user groups, you need to set file sharing 
options in Windows Explorer. These options are available if 
you installed the Web components on an NTFS volume.

Follow these steps:

1 In Windows Explorer, navigate to the folder or files for 
which you want to control access.

2 Right-click the folder or file. From the menu that 
appears, select Properties.

3 In the Properties window that appears, click the Sharing 
tab.

4 Select “Share this folder.” You can then set options for 
controlling access.
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5 Click Permissions. The following window appears:

Select Everyone. In the Permissions box, select the Deny 
check boxes for all types of permissions.

6 Click Add. The following window appears:

Select the computer or domain at the “Look in” field, and 
then select the users or user groups to which you want to 
grant access and click Add. Click OK when you are 
finished.

7 In the Permissions window, select the users or groups to 
which you want to grant access. Select the Allow check 
boxes for those users and groups. Click OK when you 
are finished.
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Setting Site Options in Sage ERP MAS 500

Procedure Use the Common Information (CI) module for general 
settings for all Internet Applications. Follow these steps in 
Sage ERP MAS 500:

1 Select Common Information Maintenance menu >  
CI Setup > Set Up CI Options. The following window 
appears:

Finish and Exit
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2 Click the Internet Applications tab. The following fields 
appear:

Complete the tab with the information for your 
configuration. For more information, refer to the Help 
system.

Important: The Inventory Images Share Name is 
required and should refer to a folder available on the 
network. For more information, see Using the Folder 
for Item Images on page 90. 

3 If you are using Business Insights Dashboard, set the 
update schedule and make sure that the SQL Server 
Agent is running. For more information, see Setting SQL 
Server Schedules on page 80.

To update Business Insights Dashboard data without 
scheduling, click Update Now.

4 When you are finished, click the Finish and Exit button.
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Setting SQL Server Schedules

Introduction For tasks with data from SQL Server databases, such as data 
for Business Insights Dashboard Web Parts, you can set an 
update schedule so that the data is updated automatically at 
the intervals you set. For more information about SQL Server 
scheduling, see SQL Server Books Online.

Procedure Follow these steps to set the schedule:

1 On the Internet Applications tab in Set Up CI Options, 
click Change Schedule. The following window appears:

2 In the Occurs section, choose one of the following 
options. The section to the right of Occurs changes 
according to the option you select.
� Select Daily to pick a frequency of days, such as 

every day or every two days.

� Select Weekly to select a frequency of weeks and the 
days of the week that the export takes place, such as 
every two weeks on Monday, Wednesday, and 
Friday.

� Select Monthly to select a specific day in the month 
and an interval of months, such as the second day 
every three months or the third Sunday every 
month. 
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3 In the Daily Frequency section, select the time and 
frequency of the backup on the days you selected. 
Perform one of the following:
� To perform the export only once, select “Occurs 

once at” and select the time.

� To perform the export several times a day, select 
“Occurs every” and select the frequency and the 
period of time that the export occurs.

Note: For the purpose of scheduling, midnight is 
12:00 A.M. and noon is 12:00 P.M. The day ends at 
11:59 P.M. 

4 In the Duration section, indicate the period that the 
task takes place. If you do not want to specify a limited 
time, leave the fields at their defaults of the current date 
as the start date and December 31, 2099 as the end date.

5 Click Update to accept the changes. The schedule 
portion of the tab indicates the new setting and the last 
time it was run, as in this example.
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Running SQL 
Server Agent

To perform scheduled tasks, the SQL Server Agent must be 
running. Use SQL Server Enterprise Manager to perform the 
following:

1 In the Tree pane, expand the listing of the SQL Server. 
Expand the Management folder to reveal SQL Server 
Agent as shown:

2 If a green arrow appears in the icon for SQL Server 
Agent, it is running. If there is a red square, you need to 
start the service. Right-click the icon, and from the 
menu that appears, select Start.

If you need information about using SQL Server Agent 
automatically, see SQL Server Books Online.

Viewing the 
scheduled events

Data update tasks are added to the jobs for the SQL Server 
Agent. To view these tasks, use SQL Server Enterprise 
Manager.
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Setting SQL Server Schedules for an Express 
Installation

Introduction When installing Sage ERP MAS 500 Express, the SQL Server 
Agent is not installed. You can set an update schedule for 
Business Insights Dashboard so that the data is updated 
automatically at the intervals you set. For more information 
about SQL Server scheduling, see SQL Server Books Online.

Procedure Follow these steps to set the schedule:

1 Select Windows Start menu > All Programs > Accessories 
> System Tools > Task Scheduler. 
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2 Select the Actions menu and click Create Task. The 
following window appears:

3 At the Name field, enter Update Web Parts Data.

4 In the Security Options section, select the appropriate 
user or group. If you are using a trusted connection, 
make sure this user or group can log on to SQL Server.

5 Select the Hidden check box and configure the security 
options for the appropriate operating system.
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6 Click the Triggers tab. Click New to configure the 
schedule type. The following window appears:

7 Select the appropriate settings to run the schedule and 
click OK.

Click Edit, to change the schedule configuration.
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8 Click the Actions tab. Click New to configure the task to 
execute. The following window appears:

9 Select the action and script to execute using a trusted 
connection and click OK.

You can also assign the script to execute for a specific SQL 
user.

10 Click OK.
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PopWebParts.sql 
contents

The PopWebParts.sql file contains the following web parts. 
Replace the mas500_app with the appropriate database name.

• Exec mas500_app..spbpPopWPFinancialInfo

• Exec mas500_app..spbpPopWPCashFlowProjections

• Exec mas500_app..spbpPopWPInvoiceAnalysis

• Exec mas500_app..spbpPopWPInventoryAnalysis

• Exec mas500_app..spbpPopWPIncomeTrend

• Exec mas500_app..spbpPopWPTopInventoryItems

• Exec mas500_app..spbpPopWPTopCustomers

• Exec mas500_app..spbpPopWPDailySalesOrdSummary

• Exec mas500_app..spbpPopWPCustTransSummaExec

Continuing the System Configuration

Where to find 
procedures

To continue configuring the Internet Applications, use Sage 
ERP MAS 500 to set options for the Web site. See the 
following chapters:

• For eCustomer, see Chapter 5, Configuring the System for 
eCustomer.

• For eSalesforce, see Chapter 6, Configuring the System for 
eSalesforce to complete the configuration.

• For Business Insights Dashboard, see Chapter 7, 
Configuring Business Insights Dashboard.
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5Configuring 
the System for 
eCustomer 5
You need to set up options in Sage ERP MAS 500 to use 
eCustomer. These include:

• Setting general options, such as the server and database 
used by eCustomer and search settings.

• Creating product groups for organizing merchandise on 
the Web site and assigning graphics to them.

See the following sections for instructions on performing 
these tasks. For more information about individual windows, 
refer to the online Help.

In this chapter
Setting Up the eCustomer Web Site  . . . . . . . . . . . . . . . . . . . 90
Making Items Available for Sale. . . . . . . . . . . . . . . . . . . . . . . 95
Adding Images and Descriptions to an Item . . . . . . . . . . . . 107
Setting Up Customers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
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Setting Up the eCustomer Web Site

Overview

Introduction This section shows you how to configure the eCustomer Web 
site. This process consists of the following tasks that need to 
be performed on the Web server and in Sage ERP MAS 500:

• On the Web server:
� Make sure that a folder is set up for inventory 

images.

� Use the Site Maintenance page to select the database 
and company used by the site and set the site status.

• In Sage ERP MAS 500: Make sure you have Set Up CI 
Options to set site options. For more information, see 
Setting Site Options in Sage ERP MAS 500 on page 78.

Using the Folder for Item Images

Introduction The Web site uses the InventoryImages folder to store images 
of items to appear in the Web site. You can also use images on 
the Internet at their present location. For more information, 
see Adding Images and Descriptions to an Item on page 107.

Requirements You need to do the following with InventoryImages before 
using it:

• Keep the folder with the name InventoryImages and in 
its location within the Web site folder. Do not move or 
rename it.

• Set the folder up as a shared folder that can be accessed 
by Sage ERP MAS 500 client systems. You can use any 
name you want as the share name. See the Windows 
documentation for instructions on setting up shared 
folders in Windows Explorer.
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• Make sure you have NetBIOS access to the shared folder 
either through the network or a VPN. You need 
NetBIOS access to be able to maintain the graphic files.

Designation of 
folder

In the path to the images folder, use the UNC (Universal 
Naming Convention) designation of the drive. Mapped drive 
letters are also supported, but using them requires all users to 
map the folder to the same drive letter.

Setting up the 
folder

In Common Information, enter the name of the shared folder 
so that images are linked to items in the database. For 
instructions, see Adding Images and Descriptions to an Item on 
page 107.

Configuring the Web Site

Introduction Use the Web Site Maintenance page to select the company 
and open the Web site for business. You can also use this 
page to perform the following:

• Open or close the store, as shown in Managing the Site on 
page 93.

• Process transactions that cannot be processed as shown 
in Processing Orders in Queues on page 183.

You can open the page either remotely from a browser or 
from the Web server.

Procedure Follow this procedure.

1 Do either of the following:
� To launch the page from the Web server: Select 

Windows Start menu > All Programs > Sage ERP 
MAS 500 Internet Applications > eCustomer > 
eCustomer Site Maintenance.
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� In Internet Explorer, open the following Web page:

http://server/folder/administration/
sitemaint.asp

Where server is the Web server and folder is where 
the eCustomer Web components are installed. For 
an explanation of how the address of the site is 
determined, see Determining the URL on page 38.

The following Web page appears.

2 Select the company. The Web site supports only one 
company at a time.

Note: If the company you want does not appear in 
this field, it means that eCustomer has not been 
activated for that company. For more information, 
refer to the Installation and System Configuration 
guide. 

3 Click Update to make the change.
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When changes 
take effect

If there are people using the Web site when you make 
changes, they will see and use the new settings as they refresh 
data in the browser and process information.

Managing the Site

Introduction The eCustomer Web site enables you to open or close the 
order entry portion, enable or disable order processing, and 
specify a message describing the status of the site. You 
perform these functions through sitemaint.asp.

Setting site status To open sitemaint.asp, see the instructions in Configuring the 
Web Site on page 91. Set the Web Processing Options fields as 
follows:

Field Options

Company Select the current processing company 
from those in the Sage ERP MAS 500 
Internet application database.

Store Status Closed: Users cannot log on to the 
order entry portion of the Web site.

Open: Users can log on.

Sales Order 
Processing

Running: Orders from the Web site are 
being processed and updating the 
databases.

Stopped: Orders can still be accepted 
from the Web site, but the databases are 
not being updated.

Status Bar 
Message

Type a message of up to 128 characters 
to appear on the status bar of the user 
browser. This field should only be used 
to provide important messages to users. 
Because this message is not saved in the 
database, it should not be used for 
long-term advertising.
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Closing the Web 
site

If you set the Store Status to Closed, the following page 
appears when users click Login:

Customizing the 
Store Closed page

You can customize this page (/Common/StoreClosed.htm) to 
give additional information. For information about changing 
this and any of the pages on the Web site, see Chapter 10, 
Customizing eCustomer and eSalesforce.

Diagnosing 
processing issues

Sitemaint.asp also provides status on the operation of the 
Web site. If customers are placing orders but the database is 
not being updated, make sure that the Sales Order Processing 
field is not set to Stopped. If it is, set it to Running. For more 
information, see Diagnostic Web Pages on page 174.
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Making Items Available for Sale

Overview

Introduction To make items available for sale through the eCustomer Web 
site, perform the following:

• Create or modify the inventory or noninventory item 
with the necessary settings.

• Assign the item to at least one product category. 
Product categories enable you to organize items so that 
they are easy for customers to find. The product 
categories you set up for eCustomer can also be used in 
Sales Order and Purchase Order entry.

Before you begin, refer to the Inventory Management Help 
system. 

Selecting Items to Sell

Requirements To enable an item to be sold through the Web site, perform 
the following:

• Assign inventory items to at least one warehouse. 
Customers will only see on the Web site inventory 
items at their assigned warehouse. This rule does not 
apply to non-inventory items.

• Set up the pricing structure and set prices for the items 
you want to sell through the Web site.

• Assign inventory and non-inventory items to a sales tax 
class so that they can be processed in Sales Order.

• On the Maintain Items UOM tab, select the Use For 
Sales check box. The box must be selected for at least 
the standard Sales unit of measure and for any units of 
measure you plan to use on the eCustomer site.
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Structure of Product Categories

Introduction Product categories enable you to organize items to make 
them easy for customers to find on your Web site. This 
section describes how product categories work and some 
precautions you need to know when setting up categories.

Hierarchy of 
product categories

You can organize product categories in a hierarchy with 
different levels of categories. The number of product 
categories and levels you can create is only limited by system 
memory and disk space.

The following figure shows another example of a hierarchy 
and how it appears when you set up categories in the 
Inventory Management module.

Assign items to a product group that does not have subgroups 
attached to it. In the example above, you can assign items to 
the Complete System and Audio Components group, but you 
cannot assign items to the Computers or Components 
groups.

You can assign an item to more than one product category.
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Rules on product 
category names

Product category names have the following rules:

• They must be unique within a Sage ERP MAS 500 
company. You can use the same name in another 
company, even if it is in the same database.

• You can use uppercase and lowercase characters and 
spaces.

• They must be a maximum of 20 characters; however, 
keep in mind that there is a limitation in the width of 
the catalog frame on the Web site. If you have a long 
product category name that is several levels down in the 
hierarchy of categories, the full name might not appear.

How product 
categories appear 
on the Web site

The product categories appear in the catalog frame of the 
order entry page. The Active Server Page for the catalog frame 
reads the category information from the database and 
automatically creates expanding and contracting headings 
when you have more than one level of categories.

Clicking a heading expands a contracted listing and contracts 
an expanded listing.
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Creating and Changing Product Categories

Procedure Follow these steps to create product categories and change 
them as needed:

1 Select Inventory Management Maintenance menu > IM 
Setup > Set Up Product Categories. The following 
window appears:
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2 Depending on whether you want to put the product 
category at the top level or make it a subgroup of an 
existing product group, do one of the following:

3 From the menu that appears, select New Category. A 
space appears in the box where you can type the name 
of the new category. Make sure it is a unique name.

4 You can change any of the categories. Select the 
category and do any one of the following:

Task Procedure

To put the category 
at the top level of 
the hierarchy.

Right-click any empty space in 
the box.

To make a new 
subcategory of an 
existing product 
category.

Right-click the category where 
you want to put the new group.

If the category already has items 
assigned to it, you need to move 
the items to another category 
before creating the subcategory. 
For instructions on assigning 
and removing items from 
product categories, see Assigning 
Items to Product Categories on 
page 101.

Task Procedure

Change the order 
that a category 
appears in its level 
of the hierarchy.

Click Move Category Up to 
move it up the list or Move 
Category Down to move it 
down.

Move a category up 
a level in the 
hierarchy.

Click Move Category Out.
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Tip:  You can also right-click a category and select 
commands for moving it from the menu that 
appears. 

5 To assign items to product categories now, skip to 
Assigning Items to Product Categories on page 101.

If you are finished, click Finish and Exit to accept the 
changes you made.

Deleting Product Categories

Procedure To delete a category, right-click it and, from the menu that 
appears, select Delete Category. 

Precautions Note the following if you delete a category:

• You can only delete categories that do not have 
subcategories assigned to them. If you have to delete an 
entire category with subcategories, delete each of the 
subcategories first and then delete the main category.

• When you delete a category, you lose the assignments 
you made to items. The items must be assigned to other 
categories in order for them to appear on the Web site.

Make an existing 
category a 
subcategory of 
another category.

Click Move Category Up or 
Move Category Down so the 
category is below the category 
where you want to assign it. 
Then, click Move Category In. It 
becomes a subcategory of the 
category above it.

Rename a category. Right-click the category. From 
the menu that appears, select 
Rename Category. You can then 
type a new category name.

Task Procedure
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• The deletion takes effect after you click Finish and Exit. 
If you deleted a category by mistake, click Cancel and 
Exit. This also means that you will lose any other 
unsaved changes. After you click Finish and Exit, the 
change cannot be undone.

Assigning Items to Product Categories

Ways of assigning 
product categories

You can assign inventory and non-inventory items to 
product categories in either of the following ways in 
Inventory Management.

• To assign multiple items at one time, use the Set Up 
Product Categories window.

• To assign categories to an individual item, use the 
Maintain Items window.

You can put an item in more than one product category.

Assigning 
multiple items to 
product categories

To assign multiple items to product categories through the 
Set Up Product Categories window, follow these steps:

1 In Sage ERP MAS 500, select Inventory Management 
Maintenance menu > IM Setup > Set Up Product 
Categories.

2 Click the Assign Items tab as shown:
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3 Select a product category to which you want to assign 
items. If there are items already assigned to that 
category, they appear under Items Assigned to Product 
Category on the right. The Select Items button becomes 
active.

Note: The Product Category field only lists categories 
to which items can be assigned. These categories do 
not have subcategories. For an explanation, see 
Structure of Product Categories on page 96. 

4 Click Select Items. A search window appears as follows:

Select the search criteria you want and then click the 
Proceed button. The items that match the criteria appear 
under Items Available to Assign.

Proceed button
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5 Do any of the following to assign or remove items to 
product categories:

Tip:  You can also drag and drop items from one box 
to another. 

Task Procedure

To add individual 
items to the 
selected product 
category.

Select the items you want to 
assign under Items Available to 
Assign. To select more than one, 
hold down the CTRL key as you 
click each item. To select a range, 
click on the first item, press the 
SHIFT key, and then click on the 
last item.

Click >. The selected items move 
to the Items Assigned to Product 
Category boxes.

To add all items to 
the selected 
product category.

Click >>. All of the items under 
Items Available to Assign move 
to Items Assigned to Product 
Category.

To remove 
individual items 
from the selected 
product category.

Select the items you want to 
assign under Assigned to Product 
Category. To select more than 
one, hold down the CTRL key as 
you click each item. To select a 
range, click on the first item, 
press the SHIFT key, and then 
click on the last item.

Click <. The selected items move 
to Items Available to Assign.

To remove all items 
that were assigned 
to the selected 
product category.

Click <<. All of the items under 
Items Assigned to Product 
Category move to Items 
Available to Assign.
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6 When you have finished making assignments for this 
product category, you can select another product 
category. You are prompted to save your changes.

Repeat steps 3 through 5 for each product category to 
which you want to assign items. You can place the same 
item in more than one product category.

7 Click Finish and Exit when you are done. This saves any 
unsaved changes.

Assign product 
categories to an 
individual item

You can use the Maintain Items in Inventory Management or 
Maintain Non-Inventory Items in Common Information to 
assign an individual item to a product category. You can use 
this procedure in the following situations:

• When you need to make other changes to an item.

• When you are creating a new item and want to assign it 
to a category.

• When you want to add images to the item as you assign 
it to a product category. For more information about 
adding images, see Adding Images and Descriptions to an 
Item on page 107.

The following procedure shows how to assign product 
categories.

1 Do either of the following in Sage ERP MAS 500:
� For inventory items, select Inventory Management 

Maintenance menu > Maintain Items.

� For non-inventory items, select Common 
Information Maintenance menu > Maintain Non-
Inventory Items > Maintain Non-Inventory Items.

2 Open the item that you want to assign.
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3 Click the Categories tab, which appears as shown:

If the item has been assigned to product categories, they 
are listed in the Product Categories Assigned to Item box.

4 Assign or remove product categories as shown:

Task Procedure

To assign 
individual 
product 
categories.

Select the items you want to assign 
under Available Product Categories. 
To select more than one, hold down 
the CTRL key as you click each 
item. To select a range, click on the 
first item, press the SHIFT key, and 
then click on the last item.

Click >. The selected items move to 
the Categories Assigned to Item 
box.

To add the item 
to all product 
categories

Click >>. All of the items under 
Available Product Categories move 
to Categories Assigned to Item.
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Tip:  You can also drag and drop items from one box 
to another. 

5 Click Save to accept the changes.

To remove 
individual items 
from the 
selected product 
category.

Select the items you want to assign 
under Categories Assigned to Item. 
To select more than one, hold down 
the CTRL key as you click each 
item. To select a range, click on the 
first item, press the SHIFT key, and 
then click on the last item.

Click <. The selected items move to 
Available Product Categories.

To remove all 
items that were 
assigned to the 
selected product 
category.

Click <<. All of the items under 
Categories Assigned to Item move 
to Available Product Categories.

Task Procedure
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Adding Images and Descriptions to an 
Item

Overview

Description eCustomer enables you to add images and a description of 
each item you sell through your Web site. You can use images 
saved to your server or upload images from the Internet or an 
intranet.

Requirements for Images

Supported 
formats

You can use any image format that is supported by Internet 
Explorer, including JPEG files and static, interlaced, and 
animated GIFs. Keep the following in mind:

• The image will appear in the Web site in a box of 140 x 
140 pixels and be resized as needed to fit in the box. For 
best image quality, use an image that is 140 x 140 pixels 
so that it does not get distorted through resizing.

• Avoid using a high number of colors. If a user has set 
the display to a low number of colors (such as 256), a 
high-color image might not look right.

• Make sure you have legal rights to use the images on 
your site.

Where to Store Images

Introduction With eCustomer, you can either upload images to your server 
or use them from the URL where you found them. 
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Location where 
images are stored

When you upload images, they are saved in the location you 
specify in the Inventory Images Share Name field in Set Up CI 
Options. (For more information, see Setting Up the eCustomer 
Web Site on page 90.) To maintain images through the shared 
folder, you need NetBIOS access to that folder.

Images and 
security

If you are using Secure Socket Layer (SSL) security, it is 
recommended that you upload images to your Web site. SSL 
generates a warning when a secured Web site makes reference 
to elements on non-secure Web sites. For more information, 
see Secure Socket Layers (SSL) on page 35.

Comparison of 
image locations

The following table lists the advantages and disadvantages of 
each option:

Option Advantages Disadvantages

Uploading 
to server

Images are always 
available; you do not 
need to worry about 
missing files.

You do not need to 
provide a long path 
for specifying the file 
location.

You can edit the file 
as needed.

You do not get 
updated images 
automatically. You 
need to upload new 
images when they 
change.

You need NetBIOS 
access to shared 
folder to maintain 
files.
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Adding Images and Descriptions

Procedure Use the Maintain Items task in Inventory Management to 
add images and descriptions. Follow these steps:

1 Do one of the following:
� For inventory items, select Inventory Management 

Maintenance menu > Maintain Items.

� For non-inventory items, select Common 
Information Maintenance menu > Maintain Non-
Inventory Items > Maintain Non-Inventory Items.

2 Open the item to assign.

3 Make sure the name of the item clearly identifies it. The 
Web site uses the name in the header to label the 
product on the Web site.

Keeping 
them at 
their 
location

When images are 
updated at the other 
site, the updated 
images go on your 
site as well.

Frees drive space on 
your server.

This makes you 
dependent on some 
other company's Web 
system. When the 
other company 
changes paths or 
filenames, you can 
lose the file, affecting 
the appearance of 
your Web site.

You cannot edit the 
file.

You need to provide a 
long path to the 
graphic.

This is not 
recommended if your 
Web site uses SSL.

Option Advantages Disadvantages
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4 In the Long Description field in the header of the 
Maintain Items window, type a description of the item 
that you want to have appear in the Web site. You can 
enter up to 255 characters.

5 Click the Categories tab. Add image files by doing any 
one of the following:
� If you know the name of the file, type it in the 

Location column. If the file is in a location other 
than the one specified in Set Up CI Options, include 
the whole path.

� To select a file from a local drive or a network drive 
to which your system is attached, click Browse 
Network. An Open window appears from which you 
can select the path and file.

� To select a file by specifying a URL, click Browse 
Internet. The following window appears:

Proceed 
Stop
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Type the address of the site in the Address field and press 
ENTER or click the Proceed button. The browser only 
connects to addresses through HTTP and HTTPS, not FILE 
and FTP.

The Web page appears in the middle of the window. You 
can click on the links in the window to go to other pages, 
but the browser does not support links that open in a 
separate browser window. As you navigate, the list of 
images changes to show the images on the page you are 
viewing.

A list of the GIF and JPG files in the site appears in the 
bottom left box. When you select an image, it appears in 
the box on the bottom right.

Select the image you want. Then, select whether you want 
to copy the image to your server or use Internet image 
(which means that it will be left at its current location). 
Click OK to add the image.

6 To continue to adding images, repeat step 5. If you are 
finished adding images, click Save.
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Setting Up Customers

Overview

Introduction In order for customers to use the Web site, they need to be 
granted access. In Sage ERP MAS 500, you set up one of the 
customer's buyers to be administrator. That person can then 
set up access for the other buyers for that customer.

This section explains how the eCustomer Web site uses 
customers, how to set them up in Sage ERP MAS 500, and 
how customers set up additional buyers from the Web site.

Note: If the Sales Order and Inventory Management 
modules are not activated, you cannot use Sage ERP 
MAS 500 to set up customers. In this case, use eOrder 
or eSalesforce to launch eCustomer, and then set up 
customers in eCustomer's Buyer Maintenance page.

Explanation of 
“customer”

The term “customer” refers to the organization that uses your 
site, whether it is a purchasing department or an individual 
who buys products for a company. A customer can have more 
than one buyer. With eCustomer, each buyer can have an 
individual logon and password. Customers designate 
supervisors who review and approve orders generated by the 
buyers and administrators who set up and maintain other 
buyers for a customer.

Levels of Access Rights

Introduction This section explains the different levels of access available to 
customers and other issues involved in setting up a customer 
on the site.
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Basic access rights Every buyer on the Web site has basic user access rights that 
enable them to place and process their own orders. You can 
assign additional access rights that enable users to perform 
additional tasks on the Web site.

Additional access 
rights

Each user can be granted additional levels of access.

You can assign more than one of these additional levels to 
the same buyer. For example, a customer should have a main 
administrator who has all four of these additional access 
rights.

Administrators Each customer needs to have at least one buyer to be 
designated as an administrator. Administrators can create, 
modify, and delete other buyers from the Web site.

A customer can have more than one administrator. After you 
have created the first administrator from Sage ERP MAS 500, 
that person can create other administrators.

Level Description

Administrator Can add new buyers for a customer 
through the Web site, set up 
transaction limits, and set access 
options for any user. You must have at 
least one administrator per customer.

Supervisor Can process other buyers' shopping 
carts if the cart total is less than the 
supervisor's transaction limit.

Allow Inquiry Can view account information and run 
inquiries.

Allow 
Maintenance

Can change customer address 
information, when this feature is 
available.
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A customer cannot create its first administrator from the Web 
site. Consider adding an e-mail link or a form to your Web 
site where customers can request to be added as an 
administrator to the Web site. The Web site cannot be 
modified so that the first administrator for a new customer 
can be added directly from the Web site.

Customers who do not have administrators cannot 
administer the buyers from the site, but you can administer 
all buyers from Sage ERP MAS 500, whether they were created 
from the Web site or in the CI module.

Transaction Limits

Introduction Each buyer can have a transaction limit, which is the 
maximum amount the buyer can purchase on a single order. 
Customers can set different transaction limits for each of 
their people who use the site. For example, they can put a 
$10,000 limit on buyers and a $25,000 limit on supervisors.

Unlimited 
transactions

If you do not want to restrict the amount a buyer can enter 
for a single order, set the transaction limit to 0.

Limits on total 
orders

There is no limit on the total of orders generated by a buyer, 
but the total of orders are subject to the customer's credit 
limit. If the customer is over the credit limit, the orders still 
go to Sage ERP MAS 500, but they are placed on hold until the 
customer pays down their account or their credit limit is 
increased.

For information about setting the credit limit, see Activating 
Customers Created from the Web Site on page 129.
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Currency of the 
transaction limit

The currency of the transaction limit is determined by the 
home address of the transaction company selected in Sage 
ERP MAS 500. If the home address is in London, enter the 
transaction limit in British pounds. If you change the home 
address to Los Angeles, the transaction limit is interpreted as 
United States dollars, but the amount is not translated from 
pounds to dollars. The former £10,000 limit becomes 
$10,000. Therefore, remember to change the amount of 
customer transaction limits when you change the home 
address to another country.

Adding and Administering Buyers

Linking buyers to 
customers

All the buyers for a customer are linked to the customer 
record in Sage ERP MAS 500. Their information is retained in 
transaction records for audit trail purposes.

Where to create 
buyers

You can create any buyer for a customer through Sage ERP 
MAS 500. Typically, you just create the first administrator 
through Sage ERP MAS 500 so that customers can add, 
manage, or delete buyers themselves through the Web site. 
However, you can change or delete any buyers through the 
Sage ERP MAS 500, including those created from the Web 
site.

Setting up 
customers in 
Accounts 
Receivable

Before you add a buyer, you need to set up the customer 
information in Accounts Receivable and follow the 
requirements for logon names and passwords.

You need to set up the customer in Accounts Receivable as an 
Accounts Receivable customer. The customer needs to have 
at least one of the following:

• Ship-to address

• Contact

• Default warehouse
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For instructions on setting up customers, ship-to addresses, 
and contacts see the Accounts Receivable Help system. For 
information about setting up warehouses, see the Inventory 
Management Help system.

Important: Customers will only be able to order 
inventory items that are in their assigned 
warehouse. For more information, see Selecting Items 
to Sell on page 95.

Logon name and 
password 
requirements

The logon name and password for each buyer needs to meet 
the following requirements:

• The logon name must be at least six characters long.

• The password must meet the following requirements:

� At least six characters long.

� Alphanumeric characters only.

� Different from the logon name.

• Passwords are always case-sensitive. Note the case you 
use for the password.

Adding Sage ERP 
MAS 500 users to 
eCustomer

There are two ways that Sage ERP MAS 500 users can gain 
access to the eCustomer Web site:

• If you are using eSalesforce, you can configure 
salespeople so that they can enter eCustomer through 
the eSalesforce Web site. For more information, see 
Setting Up Salespeople on page 124.

• To enable Sage ERP MAS 500 users to enter the 
eCustomer Web site directly, you need to set them up as 
external users. Logons for external users are separate 
from those for Sage ERP MAS 500. A user's logon name 
for eCustomer could be the same as that for Sage ERP 
MAS 500, but there is no connection between the two 
logons.
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Adding buyers 
through Sage ERP 
MAS 500

Follow these steps to add buyers in Sage ERP MAS 500:

1 Select Common Information Maintenance menu > 
Maintain External User for Internet App. The following 
window appears:

2 Type the logon name to use.

Important: A dedicated user, ProcessWebSOUser, has 
been set up for adding sales orders to the application 
database. Do not delete this user. For more 
information, see Requirement for ProcessWebSOUser on 
page 183. 

3 Select the customer, a customer contact (in the User 
Name field), and default ship-to address for this user. 
This information is defined through the Maintain 
Customer form in Accounts Receivable.

4 Type a transaction limit. For more information, see 
Transaction Limits on page 114.

5 To grant additional access rights, select the check box 
for each of the rights you want to add. For more 
information, see Levels of Access Rights on page 112.

6 Enter the password into both of the fields in the 
Password section.

7 Click Save. The user now has access to the Web site.
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Changing User Information and Replacing Lost 
Passwords

Introduction Use the Maintain External Users window to change the 
settings and passwords of any customers of the Web site, 
including buyers and administrators created through the 
Web site. You can change customer information, access 
rights, and passwords.

Procedure Perform the following to change information and passwords.

1 Open the Maintain External Users window as shown in 
Adding and Administering Buyers on page 115.

2 Click the Search button to the right of the Login Name 
field. From the Search window that appears, select the 
user. The user's information appears in the Maintain 
External Users window.

3 Change the information as needed. If you are issuing a 
new password, type it in both the Enter Password and 
Repeat Password fields.

4 Click Save.

Deleting Administrators and Buyers

Introduction Deleting administrators and buyers removes their access to 
the Web site. 

Precautions Be careful of the following:

• Do not delete all of the administrators. You need at 
least one administrator to enable customers to 
administer users themselves through the Web site.
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• Do not delete an administrator or buyer if there is an 
order from that person in the queue, because this can 
cause errors. Wait until the order is cleared from the 
queue before deleting the administrator. For 
information about viewing orders in the queue, see 
Processing Orders in Queues on page 183.

Procedure To delete an administrator or buyer, perform the following:

1 Open the Maintain External Users window as shown in 
Adding and Administering Buyers on page 115.

2 Click the Search button to the right of the Login Name 
field. From the Search window that appears, select the 
user. The user's information appears in the Maintain 
External Users window.

3 Click Delete. The administrator is removed.

Adding and Administering Buyers Through the 
Web Site

Buyer 
Maintenance page

After you have created an administrator for a customer, that 
person can then add, change, and delete buyers through the 
Buyer Maintenance page of the eCustomer Web site. 
Administrators can get instructions from the online help of 
the Web site. 
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The following figure shows the Buyer Maintenance screen as 
it appears when an administrator uses the Web site:

Changes buyers 
can make 
themselves

Buyers who are not administrators can use the Buyer 
Maintenance page to view and change their own 
information, including their password. Buyers who are not 
administrators cannot perform the following:

• Change their own access rights and transaction limit

• Add or delete buyers

When Changes Take Effect

Description Changes in buyer information take effect the next time that 
the buyer logs into the Web site. If the buyer is logged in 
while the changes are made, the old settings apply until the 
buyer logs out. This is true whether the changes are made 
through the Web site or Sage ERP MAS 500.
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6Configuring 
the System for 
eSalesforce 6
This chapter shows how to set up options in Sage ERP 
MAS 500 to use eSalesforce. See the following sections for 
instructions on performing these tasks. For more information 
about individual windows, see the Help system.

In this chapter
Setting Up Credit Manager Messages. . . . . . . . . . . . . . . . . . 122
Setting Up Salespeople . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Setting Up Customers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Changing eSalesforce Settings . . . . . . . . . . . . . . . . . . . . . . . 130
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Setting Up Credit Manager Messages

Overview

Introduction When a salesperson completes a credit application through 
the eSalesforce Web site, it is sent to the credit manager. To 
enable this feature, you need to specify the credit manager's 
e-mail address in Set Up AR Options. You can also configure 
the system for additional e-mail communications between 
the credit manager and salespeople. 

Setting up credit 
manager e-mail

Follow these steps:

1 Select Accounts Receivable Maintenance menu > AR 
Setup > Set Up AR Options. The following window 
appears:

2 Type the credit manager's complete e-mail address 
(name@company.com) in the E-Mail field. This enables 
the credit manager to receive credit applications that 
are sent from the eSalesforce site.
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3 If you are using Microsoft Exchange and want to send  
e-mail messages from the credit manager to salespeople, 
type the credit manager's mailbox in the Mailbox field. 
This enables the credit manager to send documents 
through Microsoft Exchange.

4 Click the Finish and Exit button to save the change.
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Setting Up Salespeople

Overview

Introduction You need to set up your salespeople in Sage ERP MAS 500 to 
enable salespeople to log on to the eSalesforce Web site. Only 
salespeople whose logon information is entered in Accounts 
Receivable can log on to the eSalesforce Web site. 

This section explains how to set up salesperson records in 
Accounts Receivable to use eSalesforce. For more information 
about setting up salespeople, see the Accounts Receivable 
Help system.

Setting Up Salespeople in Accounts Receivable

Introduction This section shows you how to set up salespeople in Accounts 
Receivable to use eSalesforce. For information about setting 
up salespeople, see the Accounts Receivable Help system.

Prerequisites Before setting up a salesperson for eSalesforce, set up a Sage 
ERP MAS 500 user logon. The user must be configured for 
Windows integrated logon. For more information, refer to 
the Installation and System Configuration guide.

Limitation in the 
number of 
salespeople

The number of salespeople you can create in Sage ERP 
MAS 500 is limited according to the terms of your license. It 
is the total number of named users for all companies. One 
named user can be set up for more than one company and 
take up one named license. The system displays a message 
when you approach the maximum number of salespeople. To 
add more salespersons, purchase additional licenses. For more 
information, refer to the Installation and System Configuration 
guide.
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Procedure Follow these steps:

1 Select Accounts Receivable Maintenance menu > 
Maintain Salespersons. The following window appears:

2 In the User ID field, type the salesperson's Sage ERP 
MAS 500 user ID. You can also click the Lookup button 
and select the salesperson from a list.

3 Complete any of the other fields as needed.

4 Click Save. The salesperson is added to Sage ERP 
MAS 500 and can have access to the eSalesforce Web 
site.

Changing 
salesperson 
records

If you change salesperson records, note the following effects 
on eSalesforce:

• Only active salespeople have access to eSalesforce. 
When you set the status to Inactive or Deleted, the 
salesperson no longer has access to eSalesforce.

• If the salesperson is a primary team member of a sales 
team, that person's status must be active. For 
information about sales teams, see the next section, 
Setting Up Sales Teams.
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Setting Up Sales Teams

Introduction You can organize salespeople into sales teams. Members of a 
sales team can be permitted to view and process orders by any 
other member. This feature enables a team to serve a large 
customer or for a team of salespeople to serve customers in a 
product line or geographical area.

Primary member Each team can have a primary member, who is usually the 
team's manager or supervisor. 

The primary member enables you to set up teams that match 
the department's management hierarchy. If the primary 
member has a sales manager, that manager can view and 
process orders for the primary member's team.

Setup procedure To set up sales teams, perform the following in Accounts 
Receivable:

1 Select Accounts Receivable Maintenance menu > 
Maintain Sales Teams. The following window appears:

2 Type an identification code for the sales team in the 
Team field. Then, type a longer description in the field 
to the right of the Team field.
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3 Select a primary team member. If the primary team 
member has a sales manager, that manager and the 
manager's manager, if any, appear in the Sales Manager 
field.

4 Add members to the team as follows:
� Type or select a salesperson to add to the team.

� Select whether the member can view and process 
customers for other team members. Put a check in a 
box to enable each option.

5 Click Save to accept all of the information you added to 
the sales team.

Viewing a list of 
sales teams

Run the Sales Team listing to view information about sales 
teams. You can generate the listing by doing either of the 
following:

• Click the Print button in the Maintain Sales Teams 
window.

• Select Accounts Receivable Reports menu > Other Lists > 
Sales Team List.

Changing and 
deleting sales 
teams

Use Maintain Sales Teams to change the membership of a 
sales teams or delete it.

Select a sales team from the Team field. You can add or 
remove members and save the changes. To delete a team, 
click the Delete button.

Note: Deleting a sales team does not affect any 
transactional data.
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Setting Up Customers

Overview

Ways to set up 
customers

With eSalesforce, you can create customers in the following 
ways:

• When you complete a credit application in the 
eSalesforce Web site, a customer record is created in 
Sage ERP MAS 500.

• Create a customer in Accounts Receivable Maintain 
Customers.

This section describes considerations for setting up customers 
in Accounts Receivable and how to activate customers created 
through the eSalesforce Web site. For more information, see 
the Accounts Receivable and eSalesforce Help system.

Creating Customers in Accounts Receivable

Differences from 
standard Accounts 
Receivable 
procedures

Create new customers in Accounts Receivable using the same 
procedure shown in the Accounts Receivable Help system, with 
the following exceptions:

• Provide a primary sales contact. Complete the Primary 
Contact section on the Main tab. Click Other Contacts 
to add additional contacts.

• On the Sales Order tab, select an option at the Closest 
Warehouse field. A warehouse is required in this field.
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Activating Customers Created from the Web Site

Initial state of 
customers created 
from the Web site

When a salesperson generates a credit application from a 
potential customer, a customer record is created in Accounts 
Receivable with the following defaults:

• Credit limit: 0.00

• Use Credit Limit option: Selected

• Closest Warehouse: As configured in Set Up SO 
Options.

Approving 
customers

To enable a customer to place orders, perform the following:

• Type the approved credit limit, or select a customer 
class to use the defaults for that type of customer.

• On the Sales Order tab, change the warehouse at the 
Closest Warehouse field if you need to use a warehouse 
other than the default.

E-mail 
notification Of 
credit limit 
change

When the credit manager changes the credit limit or 
customer status, an e-mail is sent to each salesperson for each 
address associated with the customer, if the e-mail features 
are enabled.

To set up e-mail for use in Sage ERP MAS 500, see the Help 
system.
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Changing eSalesforce Settings

Overview

Introduction This section describes Web site settings that you can change 
and view for eSalesforce.

Viewing and Changing the Web Site

Introduction Like eCustomer, eSalesforce has a Web Site Maintenance page 
that shows the Web site settings and enables you to select the 
processing company and put a message in the status bar. You 
must open and set this page to activate the eSalesforce site. 
Also use this page if there are problems with processing or to 
add a message to the status bar.

You can open the page either remotely from a browser or 
from the Web server.

Procedure To use the Web Site Maintenance page, perform the 
following:

1 Do either of the following:
� To launch the page from the Web server: Select 

Windows Start menu > All Programs > Sage ERP 
MAS 500 > Internet Applications > eSalesforce > 
eSalesforce Site Maintenance.

� From Internet Explorer: Open the following Web 
page:

http://server/folder/administration/sitemaint.asp
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Where server is the Web server and folder is where 
the eSalesforce Web components are installed. For 
an explanation of how the address of the site is 
determined, see Determining the URL on page 38.

The following Web page appears.

2 Select the company. The Web site supports only one 
company at a time.

3 In the Status Bar Message field, type a message of up to 
128 characters. Because this message is not saved in the 
database, it should not be used for long-term messaging.

4 Click Update to make the change.

When changes 
take effect

If there are people using the Web site when you make 
changes, they will see and use the new settings as they refresh 
data in the browser and process information.
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7Configuring 
Business 
Insights 
Dashboard 7
This chapter shows how to configure Business Insights 
Dashboard. See the following sections for instructions on 
performing these tasks. For more information about 
individual windows, see the Business Insights Dashboard 
Help system.

In this chapter
Configuring the Dashboard for Users . . . . . . . . . . . . . . . . . 134
Configuring ASP.NET. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
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Configuring the Dashboard for Users

Introduction Now that you have installed Business Insights Dashboard, use 
the instructions in this section to set up users, set up the 
Dashboard URL for users to access the Web site, set security 
for Web Parts, and update data.

Setting Up the Users

Setting Up Users After installing Business Insights Dashboard, make sure the 
users running the Business Insights Dashboard Web site are 
set up in the Maintain Users task in Sage ERP MAS 500. For 
more information about setting up users in Sage ERP 
MAS 500, refer to your Sage ERP MAS 500 Installation and 
System Configuration guide.

The Business Insights Dashboard Forms Authenticated users 
(Dashboard users who are not Windows authenticated) must 
have passwords set up for their Sage ERP MAS 500 accounts.
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Users who are Windows authenticated into the Dashboard 
Web site must also be Sage ERP MAS 500 users. Use Maintain 
Users to add a user. 

Updating Data

Updating data The data that appears in the Business Insights Dashboard site 
is updated according to the schedule you set in Set Up CI 
Options. You can also generate manual updates. For more 
information, see Setting Site Options in Sage ERP MAS 500 on 
page 78.
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Setting security 
for Web parts

Use Maintain Security Groups (accessed from the System 
Manager module) to establish permissions for the Web Parts 
available in Business Insights Dashboard. For more 
information, refer to your Sage ERP MAS 500 Installation and 
System Configuration guide.

Setting Up Security for Dashboard Actions
In addition to the permissions for each Web part task, the 
Dashboard Enter Shared Scope and Dashboard Add Content 
tasks relate to the maintenance actions of the Dashboard 
pages.

Dashboard Add 
Content

A user with normal or supervisory permissions to Dashboard 
Add Content can add or delete content on the Dashboard 
page in Personal view.

A user who is also granted normal or supervisory permissions 
to Dashboard Enter Shared Scope can add or delete content 
from the Shared view on the Dashboard page. 
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Dashboard Enter 
Shared Scope

A user with normal or supervisory permissions can perform 
the following tasks in Dashboard Enter Shared Scope:

• View the Dashboard page in Shared view, which only 
shows the Web part content that is shared among all 
users.

Note: Users given permission to Enter Shared Scope 
should also be given normal or supervisory 
permission to Dashboard Add Content for 
maintaining shared content.

• Create additional Dashboard pages, name them, and 
provide display names and descriptions.

• Change display name and description of the standard 
Dashboard page.

• Delete any additional Dashboard pages. The standard 
Dashboard page cannot be deleted. 

Setting up the Dashboard

Introduction After installing the Business Insights Dashboard as an IIS 
application on the same Web server as the other Internet 
applications, you can set a shortcut on the user's instance of 
Internet Explorer using the following convention: 
 
\\servername\BusinessInsightsDashboard

You should also set the Business Insights Dashboard Web site 
as a trusted site in Internet Explorer.

Customizing 
Dashboard Web 
pages

You can customize the Business Insights Dashboard Web site 
with Microsoft Visual Studio 2010.
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Configuring ASP.NET

Introduction This section contains information about registering a 
different server or database to contain the ASP.NET tables, 
changing the property settings in ASP.NET without 
modifying the application code, and securing the Business 
Insights Dashboard connection.

ASP.NET Database Registration

Registering a 
different server or 
database

If you need to register a different server or database to 
contain the ASP.NET tables, perform the following tasks:

1 Run the aspnet_regsql.exe file located on your Web 
server at: drive:\\Windows\Microsoft.net\Framework\ 
VersionNumber

2 In SQL Management Studio, load and execute the 
ASPNET_REGMAS500.SQL script found on the 
Installation DVD for Internet Applications in the 
InternetApps\SupportFiles folder.

3 Reset IIS. You can restart the server or run the 
IISReset.exe command.

4 Verify the Web site has been started by launching the 
Internet Information Services (IIS) Manager from 
Administrative Tools. If the Web site has not been 
started, select the default Web site and click the Run 
button.

To enable Business Insights Dashboard to use the newly 
created ASP.NET database, change the ASP.NET 
LocalSqlServer connections string. For more information, see 
Setting the Connection Strings on page 141.
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Configuring ASP.NET Settings

Configuration 
resources

The ASP.NET configuration settings allow you to change the 
properties of the ASP.NET application without modifying the 
application code. These settings are stored in a Web.Config 
file for the Business Insights Dashboard application. Revising 
any configuration settings updates this configuration file.

For more information about configuring ASP.NET, visit the 
following sites:

� For Internet Information Services (IIS) versions 5 
and 6, go to: 
http://msdn.microsoft.com/en-us/library/
ms186189(VS.80).aspx

� For Internet Information Services (IIS) version 7, go 
to: 
http://msdn.microsoft.com/en-us/library/
ms178477.aspx

Configuration 
settings

This section describes the configuration settings that can be 
changed for your Business Insights Dashboard application.

Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify ASP.NET configuration settings 
in Windows XP and Windows 2003 Server:

1 Open the Internet Information Services (IIS) Manager 
program from the Administrative Tools folder.

2 Select the name of the installed Business Insights 
Dashboard, which resides under Web Sites\Default Web 
Sites.

3 From the menu, select Action, and then Properties.
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4 Click the ASP.NET tab.

5 Click Edit Configurations.

Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to modify ASP.NET configuration settings 
in Windows Vista, Windows 2008 Server, and Windows 7:

1 Open the Internet Information Services (IIS) Manager 
program from the Administrative Tools folder.

2 Select the name of the installed Business Insights 
Dashboard, which resides under Sites\Default Web Site.
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3 On the Actions pane click Basic Settings. Ensure the 
Edit Application settings are as follows:

4 Double-click Authentication setting under 
BusinessInsightsDashboard and ensure Anonymous 
Authentication is enabled.

Setting the Connection Strings

Introduction The following section contains information and procedures 
for setting and modifying LocalSqlServer and MAS500App 
connection strings.

Setting the 
LocalSqlServer 
connection string

Use the following procedures to set the LocalSqlServer 
connection string. LocalSqlServer is used by ASP.NET to 
connect to the data used by ASP.NET.

Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to set the LocalSqlServer connection string 
in Windows XP and Windows 2003 Server:

1 In the ASP.NET Configuration Settings window, click 
the General tab.
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2 In the Connection string section, select the 
LocalSqlServer connection string.

3 Click Edit.

4 In the Edit/Add Connection String window, modify the 
connection string as needed.

Data Source: Name of the SQL Server
Initial Catalog: Name of the database in SQL Server
User ID: User ID used to log on to the server
Password: Password used to log on to the server

Note: Do not modify or remove Application Name.

5 Click OK.

Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to set the LocalSqlServer connection string 
in Windows Vista, Windows 2008 Server, and Windows 7:

1 Double-click Connection Strings setting under 
BusinessInsightsDashboard to set up LocalSqlServer 
connection string.
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2 In the Connection Strings section, select the 
LocalSqlServer connection string.

3 On the Actions pane click Edit.

4 In the Edit Connection String window, modify the 
connection string as needed.

Data Source: Name of the SQL Server

Initial Catalog: Name of the database in SQL Server

User ID: User ID used to log on to the server

Password: Password used to log on to the server

Note: Do not modify or remove Application Name.

5 Click OK.

Modifying the 
MAS500App 
connection string

Use the following procedures to modify the MAS500App 
connection string. MAS500App is used to access Sage ERP 
MAS 500 data.
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Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify the MAS500App connection 
string in Windows XP and Windows 2003 Server:

1 In the ASP.NET Configuration Settings window, click 
the General tab.

2 In the Connection string section, select the MAS500App 
connection string.

3 Click Edit.

4 In the Edit/Add Connection String window, modify the 
connection string as needed.

Data Source: Name of the SQL Server
Initial Catalog: Name of the database in SQL Server
User ID: User ID used to log on to the server
Password: Password used to log on to the server

Note: Do not modify or remove the Application 
Name and Persist Security Info entries.

5 Click OK and close the ASP.NET Configuration Settings 
window.

6 On the Properties window, click OK.
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7 Close IIS.

Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to modify the MAS500App connection 
string in Windows Vista, Windows 2008 Server, and 
Windows 7:

1 Double-click Connection Strings setting under 
BusinessInsightsDashboard to set up MAS500App 
connection string.

2 In the Connection Strings section, select the 
MAS500App connection string.

3 On the Actions pane click Edit.
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4 In the Edit Connection String window, modify the 
connection string as needed.

Data Source: Name of the SQL Server

Initial Catalog: Name of the database in SQL Server

User ID: User ID used to log on to the server

Password: Password used to log on to the server

Note: Do not modify or remove Application Name.

5 Click OK.
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Securing the Business Insights Dashboard 
Connection

Security measures Business Insights Dashboard stores two connections to the 
database in the web.config file. One connection, 
LocalSqlServer, is used by ASP.NET to connect to the data 
used by ASP.NET. The other connection, MAS500App, is used 
to access Sage ERP MAS 500 data. Typically, these 
connections are created using a SQL Server user ID and are 
stored in the web.config file. This is usually sufficient because 
the web.config file is protected by Internet Information 
Services (IIS) Manager by not allowing the file to be 
transferred to a client. There also is protection from access 
outside of IIS using normal NTFS protection. 

Additional steps can be taken to further increase the security 
of these connection strings, such as encrypting the 
connection strings in the web.config file, implementing a 
trusted subsystem configuration, and impersonating the 
application level. The following section describes these 
methods.

Encrypting the 
connection string

Encrypting the connection string is not difficult to do and 
will protect the connection string information from being 
accessed in case the web.config file is compromised.

Note: The steps in the following procedure can be 
implemented independently.

To encrypt the connection string:

1 From the machine that is running the Web server, run 
the following command line utility:

aspnet_regiis -pe "connectionStrings" -app "/
BusinessInsightsPortal" -prov 
"DataProtectionConfigurationProvider"
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� aspnet_regiis is located in the %systemroot%/
Microsoft.Net/Framework/<version> folder where 
%systemroot% is typically C:\Windows and 
<version> is the version of the .NET framework in 
use.

� /BusinessInisghtsDashboard is the name of the web 
application.

� DataProtectionConfigurationProvider is 
implemented in .NET Framework 4.0 and provides 
the encryption facilities.

The .NET Framework 4.0 Software Developer's Kit (SDK) 
provides two different Protected Configuration providers, 
which you use with the aspnet_regiis.exe tool:

� RSAProtectedConfigurationProvider. This is the 
default provider and uses the RSA public key 
encryption to encrypt and decrypt data. Use this 
provider to encrypt configuration files for use on 
multiple Windows Servers in a Web farm. 

� DPAPIProtectedConfigurationProvider. This 
provider uses the Windows Data Protection API 
(DPAPI) to encrypt and decrypt data. Use this 
provider to encrypt configuration files for use on a 
single Windows Server.

Implementing a 
trusted subsystem

In the trusted subsystem model, the database server trusts the 
Web application identity and allows the Web application to 
make calls on behalf of the original caller.

Procedure To implement a trusted subsystem:

1 Modify the MAS500App Connection String to use 
integrated security as follows:

Data Source=YourSQLServerMachine;Initial 
Catalog=mas500_app;Integrated Security=True

Where YourSQLServerMachine is the name of the SQL 
Server, and mas500_app is the name of the MAS500 
database.
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2 Grant access to the SQL Server for the identity of the 
ASP.NET application. Typically this is <machinename>/
ASPNET. You can determine the correct user ID using 
Task Manager and looking at the User Name for the 
aspnet_wp object.

Allowing the <machinename>/ASPNET user access to your 
SQL Server can pose a potential risk because anyone using 
ASP.NET on the Web server will have access to the SQL 
Server. The potential of risk can be reduced by also 
impersonating the application level.

Impersonating 
application levels

A good practice for building a trusted subsystem is to also use 
the application impersonation method. After implementing a 
trusted subsystem, isolate the access to the database for the 
Business Insights Dashboard application. This allows the 
Business Insights Dashboard application to have its own 
identity, separate from the identity used by other ASP.NET 
applications. This allows you to grant database access tailored 
to the needs of the Business Insights Dashboard application. 

To implement application impersonation, set the 
impersonation identity for the Business Insights Dashboard 
application by accessing the IIS properties for the Business 
Insights Dashboard application and updating the ASP.NET 
configuration to set the local impersonation setting as shown 
in the following window.
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For more information, refer to the following article on the 
Microsoft Web site:

http://msdn2.microsoft.com/en-us/library/ms998292.aspx

Protecting the 
LocalSqlServer 
connection string

In Business Insights Dashboard, AppRole functionality is not 
supported for the LocalSqlServer connection string. The best 
approach for securing this connection string is to limit the 
access to only the database objects accessed using this 
connection. Use the following procedure to secure this 
connection string.

Procedure To secure the LocalSqlServer connection string:

1 Create a database role (DBRole) that has access to 
objects that start with aspnet.

2 Select a Windows Authenticated user ID that is a Sage 
ERP MAS 500 user, has the MAS500 AppRole option 
selected, and is a member of the database role created in 
step 1.
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3 Modify the LocalSqlServer and MAS500App connection 
strings to use Integrated Security.

4 Modify the Dashboard application to impersonate the 
user selected in step 2.

5 Encrypt the web.config file.

Encrypting and 
decrypting 
connection strings

You can encrypt and decrypt sections in the web.config file 
using the aspnet_regiis.exe command-line tool, which can be 
found in the 
%WINDOWSDIR%\Microsoft.Net\Framework\version 
folder, normally located at: 
 
C:\Windows\Microsoft.Net\Framework\v4.0.30319. 

Encryption:

aspnet_regiis.exe -pef "connectionStrings" 
"C:\Inetpub\wwwroot\BusinessInsightsDashboard" -prov 
"DataProtectionConfigurationProvider"

-- or -

aspnet_regiis.exe -pe "connectionStrings" -app "/
BusinessInsightsDashboard" -prov 
"DataProtectionConfigurationProvider"

Decryption:

aspnet_regiis.exe -pdf "connectionStrings" 
"C:\Inetpub\wwwroot\ BusinessInsightsDashboard"

-- or -

aspnet_regiis.exe -pd "connectionStrings" -app "/
BusinessInsightsDashboard"

Note: You may need to replace 
BusinessInsightsDashboard with the name given the 
site at time of install. 
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Encrypting still allows you to use the ASP.NET configuration 
to maintain the connection strings through the ASP.NET 
configuration.

Handling Large Sets of Data

Overview To handle performance issues with large sets of data, Business 
Insights Explorer data within the Business Insights 
Dashboard uses the Top feature of SQL Server to limit the 
amount of data delivered back to the server and client. This 
value is stored as an application setting and can be modified 
at the installed site. The following steps describe how to 
modify this value.

Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify the Top value in Windows XP 
and Windows 2003 Server:

1 In the ASP.Net Configuration Settings window, click the 
General tab.

2 Select BIExplorerTopRows from the Application settings 
section.

3 Click Edit.

4 Type the integer value, and then click OK. 

5 In the ASP.NET Configurations Settings window, click 
OK. 

6 In the Properties window, click OK. 
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7 Close IIS.

You can also handle large sets of data for the selection filter 
in the Lookup window. The default is 0 to return all the rows, 
but can be modified by selecting BILookupTopRows from the 
Application settings section. 

Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to modify the Top value in Windows Vista, 
Windows 2008 Server, and Windows 7:

1 Double-click Application Settings under 
BusinessInsightsDashboard to maintain the Top value.

2 In the Application Settings section, select 
BIExplorerTopRows.

3 Click Edit.

4 Type the integer value, and then click OK.
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5 Close IIS.

You can also handle large sets of data for the selection filter 
in the Lookup window. The default is 0 to return all rows, but 
it can be modified by selecting BILookupTopRows from the 
Application Settings section.
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Displaying a Specific Number of Rows

Overview Business Insights Explorer within Business Insights 
Dashboard uses a paging model to display only a specified 
number of rows to the user. The default size is 20 but can be 
modified at the installed site. The following procedure 
describes how to modify this value.

Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify the number of rows to display in 
Windows XP and Windows 2003 Server:

1 In the ASP.NET Configuration Settings window, click 
the General tab.

2 Select BIExplorerPageSize from the Application settings 
section.

3 Click Edit.

4 Type the integer value, and then click OK. 

5 In the ASP.NET Configurations Settings window, click 
OK. 

6 In the Properties window, click OK. 
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7 Close IIS.

Windows Vista, 
Windows 2008 
Server and 
Windows 7 
Procedure

Follow these steps to modify the number of rows to display 
in Windows Vista, Windows 2008 Server and Windows 7:

1 Double-click Application Settings under 
BusinessInsightsDashboard to maintain the Top value.

2 In the Application Settings section, select 
BIExplorerPageSize.

3 Click Edit.

4 Type the integer value, and then click OK.
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5 Close IIS.

Modifying the Filter On Numerics Setting

Overview The Filter on Numerics setting is used to enable or disable 
filtering on numeric data. The version of the Infragistics 
control used by the Business Insights Dashboard has 
problems with numerics formatted with a group separator or 
percent symbol. Performing the following procedure provides 
a way to allow filtering on numeric values; however, doing so 
does not allow group separators.

Note: Percentage columns do not allow filtering.
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Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify the Filter on Numerics setting in 
Windows XP and Windows 2003 Server:

1 In the ASP.NET Configuration Settings window, click 
the General tab.

2 Select BIExplorerFilterOnNumerics in the Application 
settings section.

3 Click Edit.

4 Type the bit integer (0, 1) value, and then click OK. 

Note: Percentage columns do not allow filtering.

5 In the ASP.NET Configurations Settings window, click 
OK.

6 In the Properties window, click OK. 

7 Close IIS.
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Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to modify the Filter on Numerics setting in 
Windows Vista, Windows 2008 Server, and Windows 7:

1 To maintain the Top value, double click Application 
Settings under BusinessInsightsDashboard.

2 In the Application Settings section, select 
BIExplorerFilterOnNumerics.

3 Click Edit.

4 Type the bit integer (0, 1) value, and then click OK.

Note: Percentage columns do not allow filtering.

5 Close IIS.
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Modifying the Immediate Results Setting for 
Explorer

Overview The Immediate Results setting is used to enable or disable the 
ability to view Explorer results immediately when selecting the 
Explorer task. A Web site can disable immediate results when 
there is the possibility of large data sets being returned, or to 
allow being able to enter a filter condition to limit the results 
instead of viewing the larger set of data first. The Sage ERP  
MAS 500 client default setting for immediate results is enabled 
as is the Business Insights Explorer Immediate Results setting. 
You can disable the immediate results for the client as a setting 
per Explorer task. The Business Insights Dashboard observes 
this setting when it is disabled. 

Note: To view immediate results, both client and 
Dashboard setting must be enabled.

Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify the Immediate Results setting in 
Windows XP and Windows 2003 Server:

1 In the ASP.Net Configuration Settings window, click the 
General tab.

2 Select BIExplorerImmediateResults from the 
Application settings section.

3 Click Edit.

4 Type the bit integer (0, 1) value, and then click OK. 

5 In the ASP.NET Configurations Settings window, click 
OK.

6 In the Properties window, click OK. 
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7 Close IIS.

Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to modify the Immediate Results setting in 
Windows Vista, Windows 2008 Server, and Windows 7:

1 To maintain the Top value, double click Application 
Settings under BusinessInsightsDashboard.

2 In the Application Settings section, select 
BIExplorerImmediateResults.

3 Click Edit.

4 Type the bit integer (0, 1) value, and then click OK.
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5 Close IIS.

Modifying the Immediate Results for Filter 
Setting

Overview The Immediate Results for Filter setting is used to determine if 
the data is loaded when a filter is applied for the Explorer view. 
When a filter exists and the value for this setting is 1, this 
setting will display the data for the filtered view. Setting this 
value to 0 is designed to force the user to select the Refresh 
button to view the results. This setting is ignored when Drill 
Into is performed to another data view. The Business Insights 
Dashboard observes this setting when it is disabled. 

Note: To view immediate results, both client and 
Dashboard setting must be enabled.
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Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify the Immediate Results for Filter 
setting in Windows XP and Windows 2003 Server:

1 In the ASP.Net Configuration Settings window, click the 
General tab.

2 Select BIExplorerImmediateResultsForFilter from the 
Application settings section.

3 Click Edit.

4 Type the bit integer (0, 1) value, and then click OK. 

5 In the ASP.NET Configurations Settings window, click 
OK.

6 In the Properties window, click OK. 

7 Close IIS.
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Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to modify the Immediate Results for Filter 
setting in Windows Vista, Windows 2008, and Windows 7:

1 Double click Application Settings under 
BusinessInsightsDashboard to maintain the Top value.

2 In the Application Settings section, select 
BIExplorerImmediateResultsForFilter.

3 Click Edit.

4 Type the bit integer (0, 1) value, and then click OK.

5 Close IIS.
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Enabling or Disabling Custom Errors

Overview The capability to implement custom errors is enabled to 
provide messages within Business Insights Dashboard. If the 
custom error messages do not provide enough detail, you can 
disable custom messaging, which allows you to provide more 
detailed descriptions to problems.

Custom error 
setting for IIS 5 
and 6

To modify the custom error mode setting for Internet 
Information Services (IIS) versions 5 and 6

1 In the ASP.NET Configuration Settings window, click 
the Customer Errors tab.

2 At the Custom error mode field, select the custom error 
mode to use. The following mode options are available:
� On: Custom errors are displayed for local and 

remote clients.

� Off: Detailed custom errors are displayed for local 
and remote clients.

� Remote Only: Custom errors are displayed for 
remote clients and detail errors are displayed for 
local clients. This option is the installation default 
option.
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3 In the ASP.NET Configurations Settings window, click 
OK.

4 In the Properties window, click OK. 

5 Close IIS.

Custom error 
setting for IIS 7

To modify the custom error mode setting for Internet 
Information Services (IIS) version 7

1 Locate the installation folder for the Business Insights 
Dashboard. Unless a virtual folder is used for this 
application, the folder is under the IIS Server hard drive 
as shown in the following example:

C:\Inetpub\wwwroot\BusinessInsightsDashboard

2 Open the web.config file in Notepad.

3 Locate the customErrors mode section in the web.config 
file as follows:

<customErrors mode=”RemoteOnly”>
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4 Enter the custom error mode. The following options are 
available:
� On: Custom errors are displayed for local and 

remote clients.

� Off: Detailed custom errors are displayed for local 
and remote clients.

� RemoteOnly: Custom errors are displayed for 
remote clients and detail errors are displayed for 
local clients. This option is the installation default 
option.

5 Save the web.config file.

Modifying the Maximum Request Length 
Exceeded

Overview An error may occur if the value for the MaxRequestLength is 
not large enough to allow for data to be posted back to the 
server. When custom errors are disabled, this error is 
identified by a ''Maximum request length exceeded.'' error 
message. 

Procedure To resolve this problem, use the following method. The 
web.config file for Business Insights Dashboard requires 
modification.

1 Locate the installation folder for the Business Insights 
Dashboard. Unless a virtual folder is used for this 
application, the folder is under the IIS Server hard drive 
as shown in the following example:

C:\Inetpub\wwwroot\BusinessInsightsDashboard

2 Make a backup copy of the web.config file.

3 Open the web.config file in Notepad.

4 Locate the httpRuntime markup in the web.config file 
as follows:

<httpRuntime   maxRequestLength="12288" />
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5 Adjust the value by some increment (for example, by 
1024).

6 Save the web.config file.

7 You may need to continue to adjust this value until the 
problem is resolved. 

Note: When changing the maxRequestLength 
property, be aware of the setting provided for the 
executionTimeout property. This property sets the 
time (in seconds) for a request to attempt to execute 
to the server before ASP.NET shuts down the request 
(whether or not it is finished). You receive a timeout 
error notification in the browser if the time limit is 
exceeded. If you are going to permit larger requests, 
remember that they take longer to execute than 
smaller ones. If you increase the size of the 
maxRequestLength property, you should examine 
whether to increase the executionTimeout property 
as well.

For more information, refer to the following article on the 
Microsoft Web site: 
 
http://support.microsoft.com/default.aspx?scid=kb;EN-
US;295626

Troubleshooting 
Business Insights 
Dashboard

For more information about troubleshooting Business 
Insights Dashboard issues, see Troubleshooting Business Insights 
Dashboard on page 197.
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Modifying the Execution Timeout Value

Overview Execution timeout indicates that maximum number of 
seconds that a request is allowed to execute before being 
automatically shut down by ASP.NET.

Windows XP and 
Windows 2003 
Server Procedure

Follow these steps to modify the execution timeout value in 
Windows XP and Windows 2003 Server:

1 Launch Internet Information Services (IIS) Manager 
from the Administrative Tools folder.

2 Select the name of the installed Business Insights Portal, 
which resides under Web Sites\Default Web Sites.

3 Select Action menu > Properties.

4 Click the ASP.NET tab.

5 Click Edit Configurations.

6 Click the Application tab.

7 Enter the numbers in seconds for the Request execution 
timeout entry. 
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8 In the ASP.NET Configurations Settings window, click 
OK. 

9 In the Properties window, click OK. 

10 Close IIS.

Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

Follow these steps to modify the execution timeout value in 
Windows Vista, Windows 2008 Server, and Windows 7:

1 Open the Internet Information Services (IIS) Manager 
program from the Administrative Tools folder.

2 Select the name of the installed Business 
InsightsDashboard, which resides under Sites\Default 
Web Site.

3 Double click ASP Settings under 
BusinessInsightsDashboard to set the Request Queue 
Time-out.

4 In the ASP Settings section, open the Limits Properties 
node.

5 Select Request Queue Time-out.

6 Enter appropriate time in hours, minutes and seconds. 
Enter 00:00:00 to wait indefinitely.
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7 Close IIS.
Internet Applications 171



Chapter 7
172 Internet Applications



8Resolving 
Issues with 
eCustomer and 
eSalesforce 8
This chapter gives you suggestions on how to resolve issues if 
they occur with the Web site. You have a number of 
diagnostic tools you can use, including special pages 
provided with the Web site and Windows administrative 
tools such as Component Services and Computer 
Management.

In this chapter
Diagnostic Web Pages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Troubleshooting Issues  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
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Diagnostic Web Pages

Overview

Introduction The eCustomer and eSalesforce Web sites have several pages 
that provide information about the Web site and report 
errors. These pages are your first source of information about 
Web site conditions. You can customize some of these pages 
to provide additional information to your customers.

Web Site Maintenance Pages

Description The Web Site Maintenance page is the first place to look if 
the Web site is not working. There are Web Site Maintenance 
Pages for eCustomer and eSalesforce. See the following pages 
for information on opening them:

• eCustomer: See Configuring the Web Site on page 91.

• eSalesforce: See Viewing and Changing the Web Site on 
page 130.

eCustomer Web 
Site Maintenance 
page

The page for eCustomer site shows the following:

Field Description

Server The SQL Server to which the Web site is 
attached.

Database The Sage ERP MAS 500 Internet 
application database used by the Web 
site.

Open Sessions The number of people using the Web 
site.
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You can also use this page to open the site if it is closed or 
resume processing. For instructions on opening and using the 
page, see Configuring the Web Site on page 91.

eSalesforce Web 
Site Maintenance 
page

The page for the eCustomer site shows the following:

Customizing Error Message Pages

Changes that can 
be made

You can customize the pages that appear when an HTML 
error, eCustomer, or eSalesforce-specific error occurs. The 
changes you can make include the following:

• Add a company logo and name.

• Provide more descriptive information about the error. 
For an authorization error page, you can add that you 
need a logon and password to enter the site and 
describe who to contact to get them.

Unprocessable 
Sales Orders

The number of transactions in the queue 
that have not completed processing. (For 
more information, see Processing Orders in 
Queues on page 183.)

Field Description

Field Description

Database Server The SQL Server to which the Web site is 
attached.

Database Name The Sage ERP MAS 500 Internet 
application database used by the Web 
site.

Database Status Whether the database connection is 
online or offline.

Web Server Open 
Sessions

The number of people using the Web 
site.
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• Provide contact information customers can use to get 
help. You can include a phone number and generic e-
mail address.

These are described in the following sections.

eCustomer-
specific error 
message pages

eCustomer has the following error message pages that 
indicate conditions of the site. These pages are located in the 
eCustomer Common folder:

• BrowserError.htm: Indicates that the customer is trying 
to view the eCustomer Web site with a browser that is 
not supported.

• SiteNotConfigured.htm: Indicates that the Web site is 
not configured for a company in the Sage ERP MAS 500 
database.

• StoreClosed.htm: Indicates that the store is closed. For 
more information, see Managing the Site on page 93.

eSalesforce-
specific error 
message pages

eSalesforce has the following error message pages. These are 
located in the eSalesforce Common folder:

• AccessDenied.htm: Indicates that the salesperson does 
not have access rights to use the Web site. Make sure 
that the salesperson has been properly set up as shown 
in Setting Up Salespeople on page 124.

• Error.htm: Indicates that eCustomer has not been set up 
and configured, if you are using it with eSalesforce.

• SiteNotConfigured.htm: Indicates that the eSalesforce 
Web site has not been set up correctly and cannot be 
opened.

Customizing 
HTML error 
message pages

To customize HTML error messages and pages, run Internet 
Information Services. You should be knowledgeable about 
HTML errors and what causes them.
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Perform the following:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Internet Information Services.

2 In the Tree pane, expand the server name, and then 
Default Web Site. Look for the name you assigned to 
the eCustomer Web site.

3 Right-click the eCustomer Web site name and select 
Properties. In the Properties window, click Custom 
Errors. The following figure shows the Custom Errors 
tab.

4 Double-click the error you want to change. A properties 
window for the error opens. You can change the 
attributes to have the Web server display the default 
text, open an error page, or jump to another URL if the 
error occurs.
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5 To make an error page appear, specify the location of 
the page on the Web server. Normally, the error page 
files are located at 
C:\Windows\help\iisHelp\common.

You can edit the error pages in Visual InterDev or any 
HTML editing tool. Add the information, links, and 
images you want and save the file. Make sure that the 
Internet Information Services refers to that page if the 
error occurs.
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Troubleshooting Issues

Overview

Introduction This section shows how to use the diagnostic tools to resolve 
issues.

Viewing System Messages

Introduction The Event Viewer lists activity that occurred on the system, 
including system and error messages. If there is an error in 
using the Web site, use Event Viewer to see the details.

Procedure To view system events, follow these steps:

1 You can either start Event Viewer directly, or you can 
view system events from the Component Services 
window. Start the Event Viewer by doing either of the 
following:
� To see events in the Components Services window: 

Select Windows Start menu > All Programs > 
Administrative Tools > Components Services. In the 
Component Services window, look for “Event 
Viewer (Local)” near the bottom of the Tree pane. 
Expand the folder for Event Viewer to see the type 
of events listed.

� To open the Event Viewer directly: Select Windows 
Start menu > All Programs > Administrative Tools > 
Event Viewer.
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2 Click Application to view the events related to the 
Internet Applications. The following figure shows an 
example of system messages.

3 To view details about an item in the Event Viewer, 
double-click it to open the Event Properties window.
180 Internet Applications



Resolving Issues with eCustomer and eSalesforce
Processing Sales Orders with Errors

Introduction When customers generate sales orders from the eCustomer 
Web site, they are saved in a staging area in the Internet 
application database. If the order does not have errors, it 
updates the system immediately and is removed from the 
staging area. If the sales order has errors, it remains in the 
staging area.

You can identify sales orders with errors from Sage ERP 
MAS 500 by using the Import Sales Order task in Sales Order. 
Then, you can either correct the sales orders and try 
processing them again or purge them.

Errors that can be 
corrected

If a sales order has an error, it might be from one of the 
following reasons:

• The data was entered incorrectly at the Web site, such 
as the buyer left off a quantity. The buyer should 
correct the sales order at the Web site. If the buyer 
cannot correct the sales order, purge it from Sage ERP 
MAS 500 and either have the buyer reenter the order or 
try to recreate it yourself from Sage ERP MAS 500 based 
on the information from the error report.

• The item ordered is inactive, discontinued, deleted, or 
the quantity ordered converted to the sale unit of 
measure is below the minimum sale quantity entered in 
Maintain Items. 

• A change was made to Sage ERP MAS 500 so that the 
order is invalid, such as removing an item from 
inventory or deleting a ship-to address. You need to 
correct the problem in Sage ERP MAS 500 and then 
attempt to process the order again.
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Procedure for 
sales orders with 
errors

Follow these steps:

1 Select Sales Order Activities menu > SO Utilities > 
Import Sales Orders. The following window appears:

2 Run a report of errors first. Make sure that only the Print 
SO with Errors check box is selected. Clear all the other 
check boxes. In the Output field, select to send the 
report directly to a printer or display it in a preview 
window. Click the Proceed button.

3 Correct the conditions that caused the errors, such as 
replacing a unit of measurement or item that was 
removed. Then, in the Import Sales Orders window, 
select the Submit SOs for Importing and Print SO with 
Errors check box and click the Proceed button. 

Sales orders that no longer have errors are updated in the 
system and removed from the staging area. The report 
runs after the system attempts to update the database. 
Any sales orders that could not be updated appear on the 
report.

4 To purge sales orders with errors, select the Purge SOs 
with Errors check box only and click the Proceed button. 
All sales orders with errors are removed from the staging 
area and cannot be recovered.

Process
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Requirement for ProcessWebSOUser

Introduction ProcessWebSOUser is a Sage ERP MAS 500 user assigned to all 
sales orders as they are populated in the application database. 
The system requires a valid Sage ERP MAS 500 user ID in 
order to add transactions to the database.

Recreating 
ProcessWebSO-
User

If you delete the user ProcessWebSOUser, no more sales 
orders can be added to the application database until the user 
is recreated. For instructions on how to recreate a user, refer 
to the Installation and System Configuration guide. Use these 
general steps:

1 Create ProcessWebSOUser as a user of the SQL Server 
where the Sage ERP MAS 500 databases are located. You 
can assign any password.

Important: Type ProcessWebSOUser in the exact case 
and spelling shown. If you do not type the user 
name exactly, the logon will not work and sales 
orders will not be added to the application database. 

2 In System Manager, use Maintain Users to make 
ProcessWebSOUser a Sage ERP MAS 500 user for one of 
the companies. Assign it to the Public security group. 
This logon is strictly for database access only and is not 
used for logging into the client.

Processing Orders in Queues

Description If transactions are unprocessable and does not appear in the 
database, or if buyers are unable to view information they 
requested, it could be because the transactions are still in the 
queue. This section explains how to fix them.

How queues work This section explains how queues are used in eCustomer. This 
information can help you in resolving problems with 
unprocessable sales orders.
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The following queues are set up for eCustomer:

• A normal input queue, eapplicationprocessso, that is 
used for normal transaction transmission.

• Five retry queues. If the transaction fails in the normal 
input queue, it goes into the first retry queue. The 
system tries three times to process a transaction in a 
queue before it goes to the next retry queue. In each 
level of retry queue, the system waits for an increasing 
amount of time before attempting processing at the 
next level.

The queues are numbered _0 through _4, with _0 as the 
first retry queue.

• A final resting queue that is used when a transaction 
cannot be processed in any of the retry queues. 
Transactions in this queue remain until they are 
manually moved or purged. The name of this queue 
ends with _deadqueue.

The Web Site Maintenance page enables you to retry 
processing on transactions that are in the _deadqueue.

The following table lists how long the system keeps a 
transaction in a retry queue before sending it to the next retry 
queue:

Queue
Queue 
ID

Delay before 
retries begin (in 
minutes)

First retry queue _0 1

Second retry queue _1 2

Third retry queue _2 4

Fourth retry queue _3 8

Fifth retry queue _4 16
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Methods for 
processing 
transaction in the 
queue

If transactions are stuck in the queue, you can do either of 
the following to fix them:

• Retry the transactions through the Web Site 
Maintenance page. The COM+ applications retry 
processing of all eCustomer transactions in _deadqueue.

• View the queues for the COM+ applications in the 
Computer Management window. You can then retry or 
purge transactions in the queue.

Retrying 
unprocessable 
transactions

Perform the following to retry unprocessable transactions 
through the Web Site Maintenance page:

1 Open the Web Site Maintenance page as shown in 
Configuring the Web Site on page 91.

2 Look at the Unprocessable Sales Orders field to see how 
many transactions are in the queue.

3 Click Retry unprocessable sales orders. The COM+ 
applications attempt to process the transactions in the 
queue.

4 Refresh the page. If the COM+ applications are 
successful in processing the transactions, the 
Unprocessable Sales Orders field will indicate 0.

Procedure for 
viewing queues

Follow these steps:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Computer Management.
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2 In the left pane, expand the listing of Services and 
Applications. Then, expand the folder for Message 
Queuing. Click Private Queues. The right pane shows 
the private queues in the system, including the ones for 
the Internet Applications. A column shows how many 
transactions are still in the queue.

3 Click the queues to view information in them. Drill 
down to view details. You can purge all tasks in the 
queue as needed. For information about the queues and 
how to resolve problems, see the Computer 
Management online help.

Troubleshooting COM+ Applications

Introduction If you have transactions in the queue, it might be caused by a 
COM+ application that stopped processing. After you restart 
it, the transaction should finish processing and clear the 
queue. This section explains how to restart COM+ 
applications and fix them so they do not stop processing.
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Restarting 
stopped COM+ 
applications

To restart a stopped COM+ application, perform the 
following:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Component Services. The 
Component Services window appears.

2 In the Tree pane, click Component Services to expand 
the list. Then click the Computers folder, and then My 
Computer. Click COM+ Applications. The COM+ 
applications on your system appear in the right pane as 
shown:

3 Notice that on some of the icons, the ball with the + 
symbol is rotating. This indicates that the COM+ object 
is active. To view the status of all the COM+ objects, 
from the View menu, select Status View. A column 
indicates whether the COM+ object is running.
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4 There are two COM+ applications that directly affect 
order processing:
� eApplication

� eApplicationProcessSO

5 To restart a COM+ application, right-click it and from 
the menu that appears, select Start.

Links Not Working

Introduction This error can occur when using the Web server as the client. 
For example, when the site administrator is verifying a good 
installation. To change the default distributed COM 
properties, use the following procedure.

Procedure To change the default distributed COM properties, follow 
these steps:

1 On the Web server, select Windows Start menu > All 
Programs > Administrative Tools > Component Services.

2 In the Tree pane, click Component Services to expand 
the list. Then click the Computers folder, and then My 
Computer.

3 Right-click My Computer, and click the Default 
Properties tab.

4 At the Authentication Level field, select Connect.

5 At the Impersonation Level field, select Identify.

6 Click OK, and Yes at the message dialog box.
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Internet Explorer Client Appearance and Script 
Errors

Introduction These errors can occur when the form of styles is not applied, 
images do not appear, or script error problems appear when 
using Internet Explorer version 8. These errors usually occur 
when the Compatibility View is disabled.

Procedure To enable the Compatibility View on the client, follow these 
steps:

1 From Internet Explorer, select Tools.

2 Select Compatibility View. 

Note: If the Compatibility View option is disabled, 
the option is already turned on for this site. This 
means there are other issues with the site. 

Tip:  The error may also occur if Internet Explorer 
version 8 with a Web server installation is running 
Internet Information Services (IIS) 5. Consider 
upgrading IIS 5 to a higher version.

Alternate setting If the Compatibility View is disabled, follow these steps to 
add the site.

1 From Internet Explorer, select Tools.

2 Select Compatibility View Settings. 

3 Select the Display intranet sites in Compatibility View 
check box, and click Close.

Note: If you do not want to select all intranet sites, 
click Add to add only this site in the compatibility 
list.
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Changing Settings

Overview

Introduction The default settings created by the installation can be 
changed as shown in this section. These procedures require a 
familiarity with Windows Server and IIS.

Changing the COM+ Logon

Introduction To change the logon used for COM+ applications, set up a 
dedicated user and assign the user name and password to the 
COM+ applications. For an explanation of COM+ 
applications and dedicated users, see Settings Generated 
Automatically by the Installation on page 56.

Procedure Follow these steps:

1 On the Web server, create a local administrator user. 
This can be a local user on the Web server or one in the 
domain where the Web server is located. Perform the 
following:
� Select Windows Start menu > All Programs > 

Administrative Tools > Computer Management.

� In the Tree pane of the Computer Management 
window, click Local Users and Groups.

� In the Computer Management window, click 
Groups. A list of security groups appears. Right-click 
Administrators and select Add to Group.

� Click Add and add the user you want to the 
Administrators group.
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If the user does not exist on the computer or on the 
domain where the computer is connected, create the user. 
Perform the following:

� Right-click the Users folder and select New User. 

� Create a logon and password. Make sure that the 
password is at least six characters and is different 
from the user name.

� Grant the dedicated user Admin rights over COM+ 
applications. The user does not need rights over 
anything else.

2 In SQL Server, grant the user access to SQL Server and 
the Sage ERP MAS 500 databases. Perform the following:
� Select Windows Start menu > All Programs > 

Microsoft SQL Server > Enterprise Manager.

� In the left pane, click the SQL Server. Then, click 
Security.

� Right-click Logins and select New Login.

� On the General tab, type the user’s name and select 
either Windows authentication or SQL Server 
authentication.

To grant sa status to the user, on the Server Roles tab, put 
a check in the System Administrator box.

On the Database Access tab, put checks in the Permit box 
for each of the Sage ERP MAS 500 databases. In the 
Database roles box for each database, put a check in the 
db_owner. 

3 Make a note of the user’s logon and password so that 
you can enter them when you run the installation.

You do not need to grant access from within Sage ERP 
MAS 500 as you would with any other Sage ERP MAS 500 
user.

4 Open Component Services. Select Windows Start menu 
> All Programs > Administrative Tools > Component 
Services.
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5 In the Tree pane, expand this list for Component 
Services to list the Computers folder, and then My 
Computer. Expand My Computer and then click COM+ 
Applications. 

6 Right-click the COM+ application and select Properties.

7 Click the Identity tab. The Properties window looks like 
this:

Select “This user.” Type the user name and password of a 
dedicated SQL Server and Sage ERP MAS 500 user and click 
OK.
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Changing the Link to the Database

Introduction You need to configure the data link files for each of the 
Internet Application Web sites. For each data link file, assign 
the name (and password, if you use SQL Server 
authentication) of any user with DBO privileges for the Sage 
ERP MAS 500 database.

Using Windows 
integrated 
security

If you are using a logon with Windows integrated security for 
the data link file, perform the following:

• Set up OLE DB access to the SQL Server.

• Make sure that the logon is authenticated in the 
domain where the SQL Server is located.

• For trusted connections, use Named Pipes or Winsock.

Changing the link To change the link, follow these steps:

1 Log into the Windows Server where the Web server is 
located.

2 Do either of the following to open the DataLink 
Properties window:
� Select Windows Start menu > All Programs > Sage 

ERP MAS 500 Internet Applications. In Sage ERP 
MAS 500 Internet Applications, select the Web site 
you are configuring and click the Data Link 
Configuration command.
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� In Windows Explorer, locate icConn.udl in the 
Setup folder for the Internet Application. (For 
eSalesforce, the file is in 
C:\inetpub\wwwroot\eSalesforce\Setup). Double-
click the file.

3 Click the Connection tab. Set the options in the 
Connection tab as follows:
� Under number 1, select the SQL Server where the 

Sage ERP MAS 500 databases are located. If the 
server you need does not appear, click Refresh or 
type the name of the server into the field.

� Under number 2, select how you log into the SQL 
Server. You can use either Windows authentication 
or the SQL Server logon of any database owner. 

� To use SQL Server, select “Use a specific user name 
and password.” If the user has a password, enter it. 
If the user does not have a password, leave the 
Password field blank and select the box “Blank 
password.” In either case, select “Allow saving 
password.”

� To use Windows integrated security, select “Use 
Windows NT integrated security.”
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� Under number 3, select the Sage ERP MAS 500 
database for the Web site:

� If the database does not appear on the list, click 
Refresh to the right of the server selection field.

The other tabs do not need to be changed.

4 To verify the settings, click Test Connection. A dialog 
box appears that indicates whether or not the 
connection worked.

5 Click OK. The connection to the Internet application 
database is established.

Changing settings You can run the data link file at any time to change the 
database to which the Web site is connected. For example, 
you might connect to a demo database when developing the 
site and then connect to the production database when you 
are ready to go live.

If there are people using the Web site when you make 
changes to the data link file, they will continue to use the old 
settings until the application is unloaded or the data link file 
is reloaded; therefore, you should have all users log off of the 
Web site while you make changes.

Internet Application Connect to database

eCustomer _iapp

eSalesforce and Business 
Insights Dashboard

_app
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9Troubleshooting 
Business Insights 
Dashboard 9
This chapter gives you suggestions on how to resolve issues if 
they occur with the Web site. You have a number of 
diagnostic tools you can use, including special pages 
provided with the Web site and Windows administrative 
tools such as Component Services and Computer 
Management.

In this chapter
Verify the Correct ASP.NET Version Is Used . . . . . . . . . . . . 198
Script Error Message on Login Page . . . . . . . . . . . . . . . . . . . 200
Failure to Access the IIS Metabase . . . . . . . . . . . . . . . . . . . . 202
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Verify the Correct ASP.NET Version Is 
Used

Overview Use the following procedure to verify the version number 
when using ASP.NET with Business Insights Dashboard.

Windows XP and 
Windows 2003 
Server Procedure

To determine the ASP.NET version number

1 Launch Internet Information Services (IIS) Manager 
from Administrative Tools folder. 

2 Select the name of the installed Business Insights 
Dashboard, which resides under Web Sites\Default Web 
Sites.

3 From the menu, select Action, and then Properties.

4 Click the ASP.NET tab.

5 Verify the site is using the supported ASP.NET version. 
For supported version information, see the Sage ERP 
MAS 500 Compatibility and Resource Guide.
198 Internet Applications



Troubleshooting Business Insights Dashboard
Windows Vista, 
Windows 2008 
Server, and 
Windows 7 
Procedure

To determine the ASP.NET version number

1 Open the Internet Information Services (IIS) Manager 
program from the Administrative Tools folder.

2 Select the name of the installed Business Insights 
Dashboard, which resides under Sites\Default Web Site.

3 On the Actions pane click Basic Settings. Verify the site 
is using the supported ASP.NET version. For supported 
version information, see the Sage ERP MAS 500 
Compatibility and Resource Guide.
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Script Error Message on Login Page

Overview The script error “Sys is undefined” appears only on the login 
page and does not affect the behavior of the site or the 
functionality of any of its features. This error can occur on 
Internet Explorer version 8 clients using Forms 
Authentication for the site installed on a Web server running 
Internet Information Services (IIS) version 7. To change the 
site application pool to Classic.Net, perform the following 
procedure.

Procedure To change the site application pool to Classic.Net

1 Launch Internet Information Services (IIS) Manager 
from Control Panel > Administrative Tools. 

2 Select the <server> > Sites > Default Web Site.

3 Right-click the BusinessInsightsDashboard site, and 
select Managed Applications > Advanced Settings.

4 In the General section of the property list, select the 
Application Pool row.

5 Click the ellipses button on the right section of the 
current value. 

6 At the Application Pool field, select Classic.Net 
AppPool, and click OK.

7 Click OK again until you are returned to the Internet 
Information Services (IIS) Manager.

8 Close the IIS Manager window.
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Additional 
information

For more information, refer to the following Microsoft Web 
sites:

� http://learn.iis.net/page.aspx/101/introduction-to-
iis7-architecture/

� http://msdn.microsoft.com/en-us/library/
microsoft.web.administration.applicationpool.manag
edpipelinemode.aspx

� http://msdn.microsoft.com/en-us/library/
microsoft.web.administration.managedpipelinemode.
aspx
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Failure to Access the IIS Metabase

Overview This problem may be caused by a missing ASP.NET windows 
process account. The ASP.NET windows process account is an 
operator for the IIS Default Web site. To correct the problem, 
perform the following procedure.

Procedure To add the ASP.NET windows process account

1 Launch Internet Information Services (IIS) Manager 
from Administrative Tools folder. 

2 Expand to find the Default Web site.

3 Right-click the Default Web site and select Properties.

4 Click the Operators tab.

5 If LOCALMACHINE\ASPNET is not in the list (where 
LOCALMACHINE is the name of the IIS Machine, for 
example KMSWINSQL), click Add.

6 Type LOCALMACHINE\ASPNET, and then click OK. For 
example (KMSWINSQL\ASPNET) as shown below:

7 Click OK on the Default Web Site Properties window.
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8 Run Business Insights Dashboard to determine if the 
problem is corrected. If the problem persists, refer to the 
following articles on the Microsoft Web site:
� http://support.microsoft.com/kb/267904

� http://support.microsoft.com/kb/555583

If the problem continues to persist, perform the following:

1 Select Windows Start menu > Run and type cmd. Click 
OK.

2 Change the IIS hard drive: + \inetpub\AdminScripts 
folder. For example, c:\inetpub\AdminScripts

3 Type cscript adsutil.vbs, and delete w3svc/1/
AdminACL. 
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HTTP 403 Error Message

Overview Use the following procedure to verify that the default 
document is Default.aspx in the IIS Properties window.

Procedure To verify that the default document is Default.aspx 

1 Launch Internet Information Services (IIS) Manager 
from the Administrative Tools folder. 

2 Select the name of the installed Business Insights 
Dashboard, which resides under Web Sites\Default Web 
Sites.

3 Select Action menu > Properties.

4 Click the Documents tab. 

5 Verify the Enable Default Document check box is 
selected and Default.aspx is the first entry in the list. If 
it is not in the list, then add it and make sure it is 
moved to the top of the list. 
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Verifying 
anonymous access

Verify the Anonymous access check box is cleared in 
Directory Security. To do this, perform the following 
procedure.

Procedure To verify the Anonymous access setting

1 Launch Internet Information Services (IIS) Manager 
from Administrative Tools folder. 

2 Select the name of the installed Business Insights 
Dashboard, which resides under Web Sites\Default Web 
Sites.

3 Select Action menu > Properties.

4 Click the Directory Security tab. 

5 Click Edit for Authentication methods. 

6 Verify that the Anonymous access check box is cleared.

Verifying 
ASP.NET allows 
permissions

For a Windows 2003 Server, verify the ASP.NET is allowed 
permissions.

Procedure To verify ASP.NET allows permissions

1 Launch Internet Information Services (IIS) Manager 
from Administrative Tools folder. 

2 Expand the appropriate nodes in the IIS to locate the 
Webservice Extensions node

3 Select Action menu > Properties.

4 Select Webservice Extensions.

5 Find a list of prohibited extensions on the right.

6 Select ASP.NET and allow it.
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Links Not Working

Introduction This error can occur when using the Web server as the client. 
For example, when the site administrator is verifying a good 
installation. To change the default distributed COM 
properties, use the following procedure.

Procedure To change the default distributed COM properties, follow 
these steps:

1 On the Web server, select Windows Start menu > All 
Programs > Administrative Tools > Component Services.

2 In the Tree pane, click Component Services to expand 
the list. Then click the Computers folder, and then My 
Computer.

3 Right-click My Computer, and click the Default 
Properties tab.

4 At the Authentication Level field, select Connect.

5 At the Impersonation Level field, select Identify.

6 Click OK, and Yes at the message dialog box.
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Internet Explorer Client Appearance 
and Script Errors

Introduction These errors can occur when the form of styles is not applied, 
images do not appear, or script error problems appear when 
using Internet Explorer version 8. These errors usually occurs 
when the Compatibility View is disabled.

Procedure To enable the Compatibility View on the client, follow these 
steps:

1 From Internet Explorer, select Tools.

2 Select Compatibility View. 

Note: If the Compatibility View option is disabled, 
the option is already turned on for this site. This 
means there are other issues with the site. 

Tip:  The error may also occur if Internet Explorer 
version 8 with a Web server installation is running 
Internet Information Services (IIS) 5. Consider 
upgrading IIS 5 to a higher version.

Alternate setting If the Compatibility View is disabled, follow these steps to 
add the site.

1 From Internet Explorer, select Tools.

2 Select Compatibility View Settings. 

3 Select the Display intranet sites in Compatibility View 
check box, and click Close.

Note: If you do not want to select all intranet sites, 
click Add to add only this site in the compatibility 
list.
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Unable to Export to Excel

Introduction In certain instances the "The file is corrupt and cannot be 
opened" error message may appear when exporting the 
contents of the grid to Excel. This error indicates that Excel 
2010 security settings are prohibiting the exported file from 
being opened.

Procedure Follow these steps to change Excel 2010 security settings so 
the exported file can be opened:

1 Open Excel 2010.

2 Click File and select Options.

3 In the Excel Options window, click Trust Center.

4 In the Excel Options Trust Center pane, click Trust 
Center Settings.

5 In the Trust Center window, clear the following:
� Enable Protected View for files originating from the 

internet

� Enable Protected View for files located in 
potentially unsafe locations.

6 Click OK to close the Trust Center window.
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7 Click OK to close the Excel Options window.
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Error Messages

Connection 
failure

If you receive a connection failure message similar to the 
following, refer to Configuring ASP.NET on page 138.

Invalid character 
error when 
viewing a 
Dashboard

The following error message appears when you open the Web 
page to view the Dashboard: “A name was started with an 
invalid character. Error processing resource ‘http://
ws2003ent/BusinessInsightsDashboard/” Line 1. 

To resolve this issue, run aspnet_regiis.exe. 

No data appears 
for the financial 
Dashboard 
content

Use Set Up CI Options to update data. 

1 Select Common Information Maintenance menu > CI 
Setup > Set Up CI Options. 

2 On the Internet Applications tab in the Set Up CI 
Options window, click Update Now.

If the data is still showing all zeros in the Dashboard content, 
there is a possibility that the user set up to run the SQL Agent 
job to populate the tables does not have the appropriate 
security setup to execute the stored procedure the job uses. 
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Perform the following steps for SQL Server:

1 Launch SQL Server Management Studio.

2 Connect to the server you are using.

3 Under Management, launch the SQL Server Agent.

4 Select Jobs.

5 Find the job for the Dashboard (for example, MAS 500 
mas500_app Dashboard).

6 Right-click the job and select Properties. Change the 
owner to a user who has permissions to run the stored 
procedure. 

7 In Sage ERP MAS 500, run Set Up CI Options to update 
the data (accessed by selecting the Common 
Information Maintenance menu > CI Setup menu > Set 
Up CI Options).

Perform the following steps for SQL 2005:

1 Launch SQL Management Studio.

2 Connect to the server you are using.

3 Open the SQL Server Agent.

4 Find the Dashboard job (for example, MAS 500 
mas500_app Dashboard).

5 Right-click the job and select Properties. Change the 
owner to a user who has permissions to run the stored 
procedure.

6 In Sage ERP MAS 500, run Set Up CI Options to update 
the data (accessed by selecting the Common 
Information Maintenance menu > CI Setup menu > Set 
Up CI Options). 
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10Customizing 
eCustomer 
and 
eSalesforce 10
The eCustomer and eSalesforce Web sites can be customized. 
This chapter provides information about how to modify the 
appearance of these Web sites. 

This chapter briefly describes how the Web pages interact 
with COM+ applications to use information in the Sage ERP 
MAS 500 database. 

The Business Insights Dashboard Web site can be customized 
using Visual InterDev or Visual Studio.

In this chapter
Web Site Design and Layout . . . . . . . . . . . . . . . . . . . . . . . . 214
Customization Techniques  . . . . . . . . . . . . . . . . . . . . . . . . . 219
Site Customization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222
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Web Site Design and Layout

Overview

Introduction This section explains the design and format of the eCustomer 
and eSalesforce Web sites and the tools used to develop them 
so that you can decide how to customize the Web pages.

Requirements for 
customizing sites

Before using the information in this section, you should have 
knowledge in developing and editing Web pages with HTML, 
Active Server Pages, and cascading style sheets (CSS).

eCustomer Standard Page Layout

Description Pages in the eCustomer Web site use a frameset with menus, 
contents, and navigational controls. The following figure 
shows the frames:

Navigation Frame Toolbar Frame

Task Frame Content Frame
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Navigation frame The navigation frame provides links to important pages of 
the Web site. It also contains the company name and logo.

Toolbar frame The toolbar frame contains buttons that perform certain 
functions, such as displaying, hiding, and updating 
information in the task or content frame.

Task frame The task frame contains navigation controls specific to the 
material in the content frame.

Content frame The content frame shows the results of the tasks performed 
from the task or toolbar frame. Depending on the function, 
the content frame might contain additional nested frames.

Nesting of frames The following figure shows how the frames are nested within 
each other according to the HTML coding of the main frame. 

Recommendation 
on customizing 
layout

You should keep the User Login branch of the Web site in its 
default layout. If you want to make significant changes to the 
layout of these pages, you need information about how data 
is drawn from the COM+ applications. You should also plan 
for substantial development and testing time.
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Appearance when 
launched from 
eSalesforce

When users launch the eCustomer Web site directly, it 
appears as shown on page 214. When salespeople launch the 
eCustomer site from eSalesforce, the eCustomer site uses the 
stylesheets for eSalesforce. The Navigation frame changes 
slightly to show just the company name and not the logo.

eSalesforce Standard Page Layout

Layout The layout for eSalesforce is similar to eCustomer. It is 
divided into frames.

Stylesheets and Themes

Introduction to 
themes

The appearance of each Web site is set by a theme. You can 
change the appearance of the site by changing the theme as a 
whole or modifying individual cascading stylesheets.

Stylesheets The eCustomer and eSalesforce Web sites have the following 
stylesheets. These are located in the Theme\CSS folder:

• Main.css contains master styles that apply throughout 
the site.

• Individual pages have CSS files that apply to that 
particular page.

Most pages in the Web site refer to both the main and a page-
specific stylesheet. These are declared in the page source as 
shown in the following example:

<link REL="stylesheet" TYPE="text/css" HREF="../Themes/
Main.css"> 
<link REL="stylesheet" TYPE="text/css" HREF="../Themes/
Navigation.css">

The page-specific CSS file is declared last so that the styles 
override those in Main.css.
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If you are just using the global Web site styles, you only need 
to link to the Main.css stylesheet. If you are planning to 
create styles that are specific to the page you are creating, 
create a separate CSS file for that page. Do not add or modify 
styles in Main.css because the changes will affect all pages on 
your site.

Cascading 
stylesheet rules

The eCustomer and eSalesforce Web sites follow standard 
HTML cascading stylesheet rules. The page-specific stylesheet 
(in this case, Navigation.css) overrides styles in Main.css. If 
there are inline formats in the HTML or Active Server Pages 
file, those override the settings in both stylesheets.

Avoiding inline 
styles

The pages in the Web sites, as installed, do not use inline 
styles. Change formats only by modifying the stylesheets and 
do not apply formats manually to the pages. This makes it 
easier for you to make future format changes to the Web site.

eCustomer and 
eSalesforce 
stylesheets

The eCustomer and eSalesforce stylesheets are separate and 
not interchangeable. Each set of stylesheets needs to be in the 
Themes folder for their Web site.

Images

Location of site 
images

Buttons, icons, backgrounds, logos, and other graphics used 
by the Web site are located in the Images folder. The Images 
folder does not include images of items sold through the Web 
site. For more information about item images, see Adding 
Images and Descriptions to an Item on page 107.

The eCustomer and eSalesforce Web sites each have a 
separate Images folder. Link only to files in the Images folder 
for the site. If you have a graphic in the eCustomer site that 
you want to use on the eSalesforce site, copy the file to the 
Images folder for eSalesforce.
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Graphic formats The graphics provided with the Web site are basic GIF and 
JPG files that you can edit in any graphics editor that 
supports these formats. You can add animated GIFs and other 
graphic formats supported by Internet Explorer. 

Requirements for 
graphics

Note the following as you customize graphics:

• Note the color depth and resolution of the graphic. If 
you modify an existing graphic, retain the same color 
depth and resolution, if possible. Saving the graphic 
with different settings might affect the image quality 
and possibly change the size.

• Keep the graphic at the same size, if possible. If you 
need to change the size of a graphic, you might also 
need to change the settings on the pages and frameset.

• Keep the graphics in the Images folder. The Web pages 
are written to look for graphics in that folder. If you 
change the folder or add subfolders, adjust the 
references to the graphics on your pages.

• Test the Web site with the new graphics. Make sure that 
all the graphics are visible. Consider looking at the site 
with different numbers of colors.

• Make sure you have legal rights to all graphics you use.

Graphics of 
upgraded sites

If you are upgrading an existing eCustomer or eSalesforce 
Web site, note that the locations of the Web page folders will 
change when you upgrade. Update any specific folder 
references made in your Web pages.
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Customization Techniques

Overview

Introduction This section provides general guidelines and techniques for 
customizing the eCustomer and eSalesforce Web sites. It is 
assumed that you know how to write Active Server and HTML 
pages and use Visual InterDev. If you have questions, see the 
Visual InterDev documentation and books on Active Server 
Pages and HTML.

Making extensive 
changes

If you make more extensive changes than those shown here, 
make them on a copy of the original Web site and plan on 
extensive development and testing time.

Use of Visual InterDev

Recommendation 
for Visual 
InterDev

The eCustomer and eSalesforce Web sites were originally 
designed with Microsoft Visual InterDev provided with Visual 
Studio 6.0. You should use Visual InterDev or Visual Studio to 
customize the Web sites, including the Business Insights 
Dashboard Web site. See the Visual InterDev and Visual 
Studio documentation for instructions on using the software.

Setting up sites as 
Visual InterDev 
projects

You can set up each of the Web sites as Visual InterDev 
projects to make them easier for you to manage and update. 
You first need to install Server Extensions on the site in order 
to open it as a Web project in Visual InterDev. Follow these 
steps to apply the extensions and open the site as a project:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Internet Information Services.

2 In the Tree pane, expand the list for the Web server, 
and then the list for Default Web Site.
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3 Right-click a Web site, select All Tasks, and then 
Configure Server Extensions. The New Subweb Wizard 
appears. Complete the questions in the wizard. When 
you are finished, close Internet Information Services.

4 Perform the following to import the project into Visual 
InterDev:

a Start Visual InterDev. The New Project wizard starts 
automatically. If it does not, select New from the 
File menu.

b In the New tab, select New Web Project. Follow the 
instructions in the window to assign a name and 
location to the site.

c When prompted, select the server where the 
eCustomer or eSalesforce Web site is located. You 
should use Local mode so that changes do not affect 
the Web site until you are ready to send the new 
files to the server. Click Next to continue.

d To specify the Web site, select “Connect to an 
existing Web application on” and then select the 
eCustomer or eSalesforce Web site. If you do not see 
the Web site in the Name field, apply the Server 
Extensions to it. Cancel the wizard and repeat 
step 3. 

e Click Finish to start importing the Web site. If you 
are prompted to install the Visual InterDev Script 
Library, click Yes.

5 Repeat steps 3 and 4 for the other Web site.
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Customizing How Databases Communicate with 
Pages

Introduction The Active Server Pages communicate with the COM+ 
applications to retrieve data from and send it to the Sage ERP 
MAS 500 databases. These pages do not communicate directly 
with the databases.

Use of COM+ 
components and 
JScript

When the Active Server Pages draw data from COM+ 
applications to render on a Web page, they use JScript that 
calls classes in the stylesheet to determine how the data 
appears. This is how each line of a list of items appears in 
alternating shades and is highlighted when you move the 
mouse over it.

Making extensive 
customizations

To make more extensive customizations in how the Active 
Server Pages use data, use the SDK. The SDK contains 
information about Sage ERP MAS 500 database tables and 
how to customize databases as needed. To customize the 
COM+ applications to change what information is retrieved 
from and sent to the databases, contact Sage for information 
about source code availability.

Use extreme caution in customizing Active Server Pages and 
COM+ applications to change how the Web site uses data. 
Errors in programming can render the Web site unusable and 
possibly corrupt the databases. Always develop 
customizations on backups of the Web site and databases and 
verify that they work before using them on production data.
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Site Customization

Overview

Introduction The eCustomer and eSalesforce Web sites can be customized 
to fit your existing Web site and use your company fonts and 
color scheme.

This section describes the customizations that can be 
performed on the site. Unless noted otherwise, this 
information applies to both eCustomer and eSalesforce.

Required Customizations

Introduction This section describes customizations that need to be made to 
the eCustomer and eSalesforce Web sites.

eSalesforce 
customizations

The eSalesforce Web site does not need to be customized in 
order for you to use it. The Web site draws the company 
name from the Sage ERP MAS 500 database and displays it in 
the Navigation frame. 

You can customize the eSalesforce Web site, but these 
changes are not needed before going live with the site.

eCustomer 
customizations

The eCustomer Web site requires some customizations before 
using it. These customizations are described here. There are 
several changes that are necessary to make your Web site 
ready to go online:

• Configure your existing home page or create a new one.

• Add your company logo and name.

• Add contact information.

• Change to your corporate colors and text formats.
222 Internet Applications



Customizing eCustomer and eSalesforce
• Change links on the home page.

• Link to your production database.

Configuring or 
creating a home 
page

You probably have a Web site of your own to which you are 
adding the eCustomer Web site. If so, perform the following:

• Link the eCustomer Web site to your existing home 
page. The eCustomer Web site has a logon page, 
LoginDirect.asp, that is designed to integrate with 
existing Web sites. It does not have the navigation 
frame and home page menu.

Have this page open in a separate browser window. After 
the user logs in, the eCustomer Web site uses a frameset 
that requires the whole browser window.

• Run Internet Information Services and set the default 
home page for the eCustomer Web site to be the home 
page of your site. If buyers type the URL for the 
eCustomer Web site, they will go to your main home 
page instead. For more information, see the section 
about changing the default home page in Customizing 
the Sample eCustomer Home Page on page 226.
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• Change the home page link on the Navigation frame to 
jump to your home page. For instructions, see 
Customizing Navigation Links on page 228.

If you do not already have a home page, you can use the 
sample site provided with eCustomer to create one. For 
instructions, see Customizing the Sample eCustomer Home Page 
on page 226.

Adding your 
company logo 
and name

The company name and logo appear in the Navigation frame 
of eCustomer in Common/navigation.asp.

In the Navigation frame, the company name is derived 
automatically from the Sage ERP MAS 500 database. Make 
sure that the company name is how you want it to appear on 
the Web site. For instructions on entering company 
information, refer to the Installation and System Configuration 
guide.

The background color and font for the company name and 
buttons are determined by the stylesheet navigation.css. You 
can change the background color or use a graphic. Make sure 
that the text color contrasts with the background so that it is 
visible.

The company logo is provided by logo.jpg. Replace this file 
with one containing your company's logo, but keep the new 
graphic the same size and use the same filename. If you 
change the size of the graphic, you might also need to change 
the dimensions of the frameset. If you use a different 
filename, change the references to the file in navigation.asp.

If you plan to modify the sample home page to use as your 
company's home page, you also need to modify the home 
page content frame, Home/samplehomeintroduction.htm. 
This document provides an introduction to your site. Revise 
it to describe your company and highlight the features of the 
site.
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Adding contact 
information

The following pages have links to the webmaster or other 
contact you designate at your company:

• Home page menu frame (if used): 
Home\samplehomemenu.htm

• Help page: Help\help.htm

You might want to set up a generic mailbox to be used as a 
contact point at your company, such as 
webmaster@yourcompany.com, instead of a specific person. 
This way, you do not need to change the Web site if the 
contact person changes. Create an e-mail link to the address 
you choose.

Changing to 
company colors 
and text formats

The stylesheets contain the color and text format settings. 
You might want to change these to match the colors and 
formats used by your company.

Modify the Main.css stylesheet first. This stylesheet contains 
the basic formats that apply to all pages. Then, look at the 
Web site as a whole and see what changes need to be applied 
to the stylesheets of individual pages.

Note the following in making decisions on colors and text 
formats:

• To change fonts, consider using the standard Windows 
Web fonts, such as Verdana, Arial, and Times. Provide 
alternate font choices if the user does not have the font 
of your choice available.

• Test the colors at different color depths. If the user is 
running the system at a low number of colors, such as 
256, there might be palette collisions that affect the 
appearance of your site.

Linking to your 
production 
database

When you are ready to go live with the Web site, connect the 
site to your production Internet application database. Run 
icConn.udl in the Setup folder to change the connection. For 
instructions, see Changing the Link to the Database on page 193. 
Make sure that you set up a logon that has access to the SQL 
Server and database.
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Customizing the Sample eCustomer Home Page

Introduction The section applies only to eCustomer.

The sample eCustomer home page can be modified so that 
you can use it as the home page for your Web site. This 
section explains changes that you can make to the content 
and operation of the site.

How the home 
page opens

The default sample home page for the eCustomer Web site is 
default.asp. This page is designed to check for proper 
configuration and the correct version of the browser as it 
opens:

• If the Web site is not configured for a company on the 
Sage ERP MAS 500 databases, it opens 
SiteNotConfigured.htm to indicate the error.

• If the Web site does not open in the correct browser or 
version, it opens BrowserError.htm to indicate the error.

• If the Web site is configured correctly, it opens 
Home.asp that contains the sample home page.

Changing links on 
the home page 
menu

The home page menu frame, Home\samplehomemenu.htm, 
can be used to provide links to pages you add to your site, 
such as pages for support, company news, and other 
information. By default, the text is not linked. Revise the 
text, add links to the pages you need, and remove the sample 
text and table cells you do not need. Reserve one link as an e-
mail link to your contact as shown in Adding contact 
information on page 225.

The frame where the home page menu appears is designed to 
scroll, so you can add a long list of links. You might consider 
creating an expanding and contracting table of contents to 
manage the contents and enable them to fit on the screen. 
There are a number of sample scripts available on the Internet 
for producing this type of table of contents.
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Changing the 
default home 
page

To change IIS to call a different home page, perform the 
following:

1 Select Windows Start menu > All Programs > 
Administrative Tools > Internet Information Services.

2 In the Tree pane, expand the server name, and then 
Default Web Site. Look for the name you assigned to 
the eCustomer Web site.

3 Right-click the eCustomer Web site name and select 
Properties. In the Properties window that appears, click 
Documents.

4 In the Documents tab, make sure that Enabled Default 
Document is checked. Add the new home page you 
want. In the Document tab, there are several alternate 
pages that can be open if the default page is not 
available. The pages are opened in the order they are 
listed on the tab. Make sure the pages are in the order 
you want.

Adding Other Pages

Suggestions for 
adding pages

When adding pages to the Web site, make sure they are 
consistent with the overall appearance of the Web site. The 
following are suggestions on how to design new pages for the 
site.

• Use Main.css as your stylesheet. If you need to create 
styles specific to the page, use one of the other page-
specific stylesheets that apply or create a new one. 
Avoid using inline styles.

• If you are creating a page off the home page, have the 
page hosted in the main frame of 
Home\samplehome.htm. This maintains the design of 
the page and keeps the menu and navigation frames 
open at all times.
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• Add links to new pages to the home page menu frame. 
Avoid adding links to the Navigation frame because it is 
designed to hold only a few key links. If you need to 
change the settings of the navigation frame, see 
Customizing Navigation Links.

Customizing Navigation Links

Introduction The eCustomer and eSalesforce Web site pages have 
navigation links at the top. Both sites have a link to the help 
file. eCustomer has two other links, one to the logon page 
and another to the home page. 

You can customize the links for either site, but the method of 
changing the links is different. Follow the instructions that 
apply to the Web site.

Restrictions on 
customizing the 
navigation frame

Because of the limited amount of space, restrict the number 
of links on the navigation frame; however, you can add more 
buttons as needed.

Changing the 
links in 
eSalesforce

eSalesforce has only one navigation link to Help. The link is 
located in the top banner file, Common\TopBanner.asp. It is 
a standard HTML link within a table:

<td class="Help">

<a href="../Help/Help.htm" title="Help" 
target="fraContent">Help</a>&nbsp&nbsp

</td>

You can change the link to another file and add more links 
within the same table cell.

Changing the 
links in 
eCustomer

The navigation frame has links and text that are drawn from 
the Internet application database. This enables you to create a 
single Web site for different companies and provide different 
common links for different companies. For example, you 
might have a different home page for each company.
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To change the text and links that appear in the navigation 
frame, modify the ticIappNavBarBtn table in the Internet 
application database. Use SQL Server Enterprise Manager or 
other SQL Server database tool.

Important: At least one of the links must be to the 
logon page. You can either use the Login.asp, which 
contains the navigation frame in a frame, or 
LoginDirect.asp, which does not. If you link to 
Login.asp, see this section about linking to this 
page.

The following lists the columns in the table:

Column name Description What to enter

IappNavBarBtnKey Key field that 
identifies the 
link.

A unique 
number for each 
link.

BtnNo The order of the 
links in the 
navigation frame 
from left to 
right.

A unique 
number for each 
link. Links are 
listed in order 
from lowest to 
highest.

BtnText Text that appears 
on the 
navigation frame 
to identify 
buttons.

Name of the 
link.

CompanyID ID of the 
company that 
uses the link. 
Navigator links 
are company-
specific.

Company ID.
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Hyperlink Address of the 
page opened by 
the link.

Correct file name 
and path. 
Relative paths 
are 
recommended, 
such as “Home/
Home.hlp.”

Target Where the page 
will open, which 
can be a frame in 
the same 
window, or a 
separate 
window.

A frame in the 
active frameset 
or an HTML code 
to indicate how 
the page opens. 
For example, 
SageMain opens 
in the 
"SageMain" 
frame, or 
"_window" opens 
the page in a 
separate 
window.

ToolTipText Text that appears 
when the mouse 
hovers over the 
link.

Add brief, but 
descriptive text. 
For example, 
enter “Log in to 
place orders” for 
the Login 
window.

UseCurrWindow Whether the 
page is opened 
in the current 
window.

0: No

1: Yes

Visible Whether the link 
is visible on the 
page.

0: No

1: Yes

Column name Description What to enter
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Customizing Help

Forms of user 
assistance

The eCustomer and eSalesforce Web sites provide the 
following forms of user assistance:

• Help pages that explain how the Web site works.

• Tooltips that appear when you leave the mouse pointer 
over a button or certain links for a few seconds.

You can change any of the provided online user assistance or 
add more help pages. Before customizing help, you should be 
aware of principles of designing help for Web sites.

Customizing the 
help page

The file help.htm in the Help folder contains the help for the 
Web site. You can customize the help to add your contact 
information.

To create a new help file with a name other than help.htm, 
change the destination of the Help link in the Navigation 
frame. For more information, see Customizing Navigation Links 
on page 228.

Customizing 
tooltips

You can add tooltips to a button, link, or input field. The text 
appears when the user leaves the mouse pointer over the 
button or link for a moment.

To add a tooltip, type the text in the Title field in the 
Properties sheet for the button or link. You can also edit the 
code defining the button as shown in this example. The title 
code is in italics:

<button id="btnRestoreCart" class="clsLoudButton" 
title="Restores the last saved version of the cart. This discards 
any changes you made since the last time you saved." 
language="javascript" onclick="return 
btnRestoreCart_onclick()" STYLE="cursor:hand">

Adding tooltips to the links on the eCustomer navigation 
frame is done differently. For more information, see 
Customizing Navigation Links on page 228.
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11Web Part 
Development 11
The Business Insights Dashboard is composed of Web parts 
that can be customized. This chapter provides information 
about how to create Web parts, modify their appearance, and 
serves as a guide to creating additional Web parts. 

The Business Insights Dashboard Web parts can be 
customized using Microsoft Visual Studio 2010.

In this chapter
Introduction to Sage Web Parts . . . . . . . . . . . . . . . . . . . . . . 234
Setting up the Project. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
Creating the Web Part User Control . . . . . . . . . . . . . . . . . . 238
Creating the Web Control Project . . . . . . . . . . . . . . . . . . . . 243
Upgrading Web Parts Created in Sage ERP MAS 500 Version 

7.05  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253
Other Techniques and Methods  . . . . . . . . . . . . . . . . . . . . . 257
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Introduction to Sage Web Parts

Introduction Sage Web Parts were built using ASP.NET technologies as Web 
user controls. They were designed as a replacement for and 
share the same data structure as the Sage Business Insights 
Dashboard. This chapter is intended to show how these Web 
parts were created and to serve as a guide in creating 
additional Web parts for the Business Insights Dashboard.

During the course of this chapter, an example Web part will 
be created that shows the daily sales order total for the top 
five salespersons. It will use a data-bound grid to display the 
information.

Creating Web
parts from user 
controls

There are advantages and disadvantages to creating Web parts 
as user controls as opposed to compiled assemblies. The 
advantages are a user-friendly design surface, control 
property pages, and available wizards. Creating Web parts 
using this technology allows easy access to global objects on 
the Web site such as connection and default company 
information. You also have the ability to use some of the Sage 
control components used on this Web site.  

The main disadvantage is that the code must be in Visual 
Basic. The language selection is a site-wide option. Also, Web 
parts built using user controls are not as easily portable as 
assemblies.

Compiled Web 
parts that load 
user controls

The Web parts created for the Business Insights Dashboard 
use Web part classes that inherit from the Web Part object 
and load user controls at runtime. Compiling these classes to 
a .NET .dll file allows the Web part code to be language 
independent from the Web site. This also provides a design 
surface for the user interface (UI) of the Web part as well as 
allowing for simple deployment.
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Setting up the 
development 
environment

Sage Web parts were developed in Visual Studio 2008 with no 
special libraries or templates added. SQL Server 2005 or 2008 
are required for the back end with IIS. You must have Sage 
ERP MAS 500 version 7.30 or higher and the Business Insights 
Dashboard installed along with the appropriate security 
setup. 
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Setting up the Project

Use the following steps to set up the Web part project.

1 Open Microsoft Visual Studio 2010.

2 Select File menu > Open Web Site.

3 At the Web site location field, type the URL of the 
Business Insights Dashboard. This will add all of the 
files from the Web site to your project.

Global objects There are two global objects in the Business Insights 
Dashboard that are important to discuss before creating a 
Web part. First, the connection used to connect to the Sage 
ERP MAS 500 database is called ''MAS500App.'' This 
connection string is stored at the application level in the 
Web.config file and can be administered either through the 
IIS Management Console or by editing the Web.config file 
manually.

1 In the IIS Management Console, right-click the Business 
Insights Dashboard folder and select Properties to 
modify the connection string. 

2 Click the Edit Configuration button on the ASP.NET tab 
to view configuration information.
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The connection can be accessed in code by using the 
following reference:

Accounting.Web.Framework.Session.OpenConnection

The second global object that you need to reference is the 
default Sage ERP MAS 500 company ID. This value is set on 
the Dashboard master page and is stored at the application 
level in the Profile object in the Web.Config file. This value 
can be accessed in code with the following reference: 

HttpContext.Current.Profile.Item("CompanyID"). 
ToString.Trim
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Creating the Web Part User Control

Use the following steps to create a Web part user control.

1 In Visual Studio, click the Explorer button in the 
WebPart Custom Gallery folder. 

2 Click a folder and select Add New Item. 

3 Type a name for the new Web User Control (for 
example, DailySalesTotal.ascx). Clear the Place code in 
separate file check box.

Adding controls 
to the ASCX file

The control will display in the development window with a 
blank design surface. 

1 Add three panel controls from the standard toolbox to 
the User Control. 

2 Set the ID property of the top control to pnlSelector, 
the middle to pnlContent, and the bottom to 
pnlErrorMsg. 

3 Drag and drop a GridView control from the data 
toolbox on to the design surface in the middle panel.

4 Set the ID property of the GridView to gvSalesTotals.
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5 Use the Property Manager for the GridView control to 
edit the columns and add formatting. 

Click Edit Columns to add two BoundFields and configure 
them as follows: 

First BoundField

Second BoundField

Property Value

HeaderText Salesperson

DataField Salesperson

HTMLEncode False

Property Value

HeaderText Sales Total

DataField SOTotal

HTMLEncode False

DataFormatString {0:$###,###,##0}
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6 Clear the Auto-generate fields check box.

7 Select the .ascx file and click the Source button. Add 
SkinID="WebPart" inside the <asp:GridView> tag. 
This adds the style skin to match the Sage Web Parts.

8 For the grid cells to match the Web Parts, add 
<ItemStyle CssClass="DefaultCell" /> between 
the <asp:BoundField> tag and the  
</asp:BoundField> end tag. 

9 For the first BoundField, set the CssClass cell equal to 
DefaultCell1 and all the rest of the cells equal to 
DefaultCell. This sets the borders around the cells to 
match the existing Web parts.

10 Add a label control from the standard toolbox inside 
the pnlErrorMsg control and set the ID property to 
lblErrorMessage.
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Adding the 
Company Selector 
control to the 
ASCX file

Use the following procedure to add Company Selector 
controls to the ASCX file. 

1 Add a reference to the BIControls.dll to the top of the 
ascx file as follows: 
<%@ Register Assembly= "Accounting. 
Web.Framework. BIControls"  
Namespace="Accounting.Web.Framework" 
TagPrefix="cc1" %>

2 Add the Company Selector control to pnlSelector.

3 Add the following line between the beginning and 
ending tag of the Selector panel: 
<cc1:CompanySelector ID="CompanySelector1" 
runat="server" />

4 Save the ASCX file.

Note: Because the Company Selector control is late 
bound using the load control method, just as our 
Web part, a ''can't render'' error occurs in the 
pnlSelector control when in design mode for the 
DailySalesTotals.ascx file. This error can be ignored 
as the designer does not support this type of late 
binding.

Editing the 
Company Selector 
control to the 
ASCX file

In all the panel controls, verify there are no height and width 
properties specified. In addition to the SkinID for the grid, 
you can set the width of the grid cells to fit your specific data. 
Editing the ASCX file and adding an ItemStyle and 
HeaderStyle tag to the bound columns allow you to set the 
attributes of the grid control. The following is the code for 
the Daily Sales Totals grid:

<asp:BoundField DataField="Salesperson" 
HeaderText="Salesperson" HtmlEncode="False" >

<HeaderStyle HorizontalAlign="Left" Wrap="false" 
VerticalAlign="Bottom"></HeaderStyle >

<ItemStyle HorizontalAlign="Left" Wrap="False" 
Width="80px" CssClass="DefaultCell1" ></ItemStyle>

</asp:BoundField >
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<asp:BoundField DataField="SOTotal" 
HeaderText="SalesTotal" HtmlEncode="False" >

<HeaderStyle HorizontalAlign="Left" Wrap="false" 
VerticalAlign="Bottom"></HeaderStyle >

<ItemStyle HorizontalAlign="Left" Wrap="False" 
Width="80px" CssClass="DefaultCell" ></ItemStyle>

</asp:BoundField>

Set the visible properties of all of the panel controls as 
follows:

pnlSelector Visible="true" 
pnlContentVisible="true" 
pnlErrorMsg Visible="false"
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Creating the Web Control Project

Layout Use the following steps to create the Web control project.

1 Open Visual Studio and create a new project. 

2 Select the Class Library template.

3 In the Solution Explorer, rename the class file Class1.vb 
to DailySalesTotal.vb. 

4 Save the project and close Visual Studio. This project 
can now be added to the Business Insights Dashboard 
Web site project. 

5 Select File menu > Add > Existing project. Navigate to 
the Sample Web Part project you just created. 

6 Add the following .NET references to the Sample Web 
Part project: 
 
System.Web 
System.Data
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7 Add the following Business Insights Framework 
references to the Sample Web Part project using the 
browse control: 
 
Accounting.Web.Framework.dll 
Accounting.Web.Framework.BIControls.dll 
 
These framework dlls can be found in the Bin folder of 
the Business Insights Dashboard Web site.

8 Select the SampleWebPart.vb from the Solution 
Explorer. Edit the file and add the following import 
statements to the top of your class: 
 
Imports System 
Imports System.Web 
Imports System.Web.UI 
Imports System.Web.UI.WebControls 
Imports System.Web.UI.WebControls.WebParts 
Imports System.Data 
Imports System.Data.SqlClient 
Imports System.ComponentModel 
Imports Accounting.Web.Framework 
Imports System.Text

9 The class inherits from the WebPart class, so add the 
following to the class file: 
 
Inherits 
System.Web.UI.WebControls.WebParts.WebPart

Adding properties 
to the class

Use the following steps to add properties to the Web Part and 
override certain inherited properties from the Web Part class. 
Be sure to add a default value for each property.

1 Add two local private variables to hold the Property 
values: 
 
Private _Title As String = "Daily Sales 
Totals" 
Private _CompanyID As String = ""
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2 Add the CompanyID default constant: 
 
Private Const DEFAULT_TEXT As String = 
"[Default]"

3 Override the Title property: 
 
<Personalizable(), DefaultValue("Daily 
Sales Totals")> _ 
Public Overrides Property Title() As String

        Get

            Return _Title

        End Get

        Set(ByVal value As String)

            _Title = value

        End Set

    End Property 

4 Add The CompanyID property: 
 
<Personalizable(), 
DefaultValue(DEFAULT_TEXT)> _ 
Public Property CompanyID() As String 
Get 
Return _CompanyID 
End Get 
Set(ByVal value As String) 
_CompanyID = value 
End Set 
End Property
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Building the 
ASCX controls to 
DailySalesTotal 
class 

A reference must be made to all the controls on the ASCX 
page in the class. The reference is performed in the Init event 
that is inherited from the WebPart class. You must declare 
the private variables in the declarations section of the class 
for all the controls on the ASCX user control as well as the 
User Control itself.

Private DailySalesUserControl As UserControl

Private WithEvents CompanySelector1 As 
CompanySelector

Private pnlSelector As Panel

Private pnlContent As Panel

Private pnlErrorMsg As Panel

Private gvSalesTotals As GridView

Private lblErrorMessage As Label

To bind the controls, add the following code to the Init Event 
in the DailySalesTotals class. Binding the User Control uses 
the LoadControl command:

DailySalesUserControl = 
DirectCast(Page.LoadControl("~/WebPart/
CustomGallery/DailySalesTotals.ascx"), UserControl)

DailySalesUserControl.ID = "DailySales"

        Me.Controls.Add(DailySalesUserControl

After the control is loaded, the variables can be set for the 
controls using the FindControl Method of each parent 
control. You can set the variable for the panel controls as 
follows: 

pnlSelector = 
DirectCast(DailySalesUserControl.FindControl 
("pnlSelector"), Panel)

pnlContent = 
DirectCast(DailySalesUserControl.FindControl 
("pnlContent"), Panel)
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pnlErrorMsg = 
DirectCast(DailySalesUserControl.FindControl 
("pnlErrorMsg"), Panel)

The child controls can now be set using the FindControl 
method of the panel controls as follows:

CompanySelector1 = 
DirectCast(pnlSelector.FindControl 
("CompanySelector1"), CompanySelector)

gvSalesTotals = 
DirectCast(pnlContent.FindControl("gvSalesTotals"), 
GridView)

        lblErrorMessage = 
DirectCast(pnlErrorMsg.FindControl 
("lblErrorMessage"), Label)

These calls should be surrounded by a Try/Catch block and 
some error handling should be added. Refer to the following 
Catch portion of the call. Because the controls are not 
rendered at this point, you must add a label control to display 
the error message.

        Catch ex As Exception

            Dim errLabel As Label = New Label

            errLabel.ID = "DailySalesTotalError"

            errLabel.Text = "DailySalesTotal_Init:" 
& ex.Message 
Me.Controls.Add(errLabel)

End Try  
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Populating the 
grid control and 
rendering the 
Web part

The bulk of the work in the Web part is performed in the 
PreRender event that is inherited from the WebPart class.

Because you are using the Sage ERP MAS 500 common 
routine for error handling, you must first set the control's 
visible properties before rendering, in case the last rendering 
of the Web part returns no data or has an error. You must 
create a method to reset the controls to the correct state and 
call it at the beginning of the PreRender event. Create the 
method:

Private Sub ResetControls()

        lblErrorMessage.Text = ""

        pnlErrorMsg.Visible = False

        pnlContent.Visible = True

        pnlSelector.Visible = True

End Sub

Next, make the call at the beginning of the PreRender event:

ResetControls()

This is also where you must link any Help files. In the 
following example, the DailySalesHelp.htm is created to 
demonstrate the linking method, and added to the Help 
folder in the Business Insights Dashboard Web site. The 
following is the code to link the file:

        Me.HelpMode = WebPartHelpMode.Modeless

        Me.HelpUrl = "~/Help/DailySalesHelp.htm"

Using the 
Company Selector 
control

The Sage ERP MAS 500 Web parts also have a control to select 
a company other than the default company set in the portal 
master page. There are several steps that must be taken to 
implement this control. You have already added the control 
to your Web part .ascx file and a personalized property to 
store the CompanyID value. This saves the value for the user 
between sessions. You can also encapsulate the code in a Try/
Catch block and use the Common Error routine to display 
any error messages that may occur. 
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You must first instantiate the Web part common class to use 
the Show Error method. Add the code to the declarations 
section of your class to instantiate the WebPartCommon 
class:

Private wpc As New WebPartCommon 

Add the following code to the PreRender event:

Dim userProfileCompanyID As String = ""

Try

' get the default company from the Profile object

userProfileCompanyID = 
HttpContext.Current.Profile.Item("CompanyID").ToStr
ing. Trim

Catch ex As Exception

lblErrorMessage.Text = wpc.ShowError(ex.Message, 
DailySalesUserControl)

End Try

' variable to hold CompanyID that is used

        ' _CompanyID could be [Default]

        Dim UseCompanyID As String

        ' if there is no value for _CompanyID use the 
default company from Profile

        If _CompanyID.Trim.Length = 0 Or _CompanyID 
= DEFAULT_TEXT Then

            If userProfileCompanyID.Trim.Length = 0 
Then 'if no default set then show error message

                lblErrorMessage.Text = 
wpc.ShowError(wpc.NoDfltCmpnyMsg, 
DailySalesUserControl)

                Exit Sub

            End If
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            ' set the CompanyID property to save

            _CompanyID = DEFAULT_TEXT

            ' use the default company

            UseCompanyID = userProfileCompanyID.Trim

        Else ' if there is a saved value, use it

            UseCompanyID = _CompanyID

        End If

Try ' set the company selector to match the 
companyID property

            CompanySelector1.CompanyID = _CompanyID

        Catch ex As Exception

            lblErrorMessage.Text = 
wpc.ShowError(ex.Message, DailySalesUserControl)

            Exit Sub

        End Try

The wpc.ShowError method clears all the controls on the 
Web part and displays a message that it is passed in a label.

Lastly, the ValueChanged event must be handled by the Web 
part to change the CompanyID value when the selector's 
value changes. Add the following code to handle the event 
from the selector:

Protected Sub CompanySelector1_ValueChanged() 
Handles CompanySelector1.ValueChanged

_CompanyID = CompanySelector1.CompanyID

End Sub 

The Company Selector is now ready to be used.
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Creating the SQL 
command object 
and binding the 
grid

A parameterized SQL statement is used for data retrieval with 
the CompanyID as the parameter. Normally, you can use a 
parameter for the date of the sales orders. For demonstration 
purposes, you can hard-code a date compatible with data in 
the SOA demo company. Use the following code for setting 
up the SQL Command object:

Dim SqlSelect As String

Dim _dtSales As New System.Data.DataTable

' set up the profit grid

Try

Dim str As New StringBuilder(277)

str.AppendLine("SELECT S.SperID[Salesperson], 
SUM(SO.TranAmt)[SOTotal] FROM tsoSalesOrder SO")

str.AppendLine("INNER JOIN tarSalesperson S")

str.AppendLine("ON SO.PrimarySperKey = S.SperKey")

str.AppendLine("GROUP BY S.SperID, SO.TranDate, 
SO.CompanyID")

str.AppendLine("HAVING SO.TranDate = '2008-06-05'")

str.AppendLine("AND SO.CompanyID = @CompanyID")

str.AppendLine("ORDER BY SUM(SO.TranAmt) DESC")

SqlSelect = str.ToString

Dim sqlCmd As SqlCommand = New SqlCommand

With sqlCmd

.CommandType = CommandType.Text

.CommandText = SqlSelect

.CommandTimeout = 
Accounting.Web.Framework.Session.QueryTimeout
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.Parameters.AddWithValue("@CompanyID", 
UseCompanyID)

Dim con As SqlConnection = 
Accounting.Web.Framework.Session.OpenConnection

.Connection = con

End With

Dim _daSales As SqlDataAdapter = New 
SqlDataAdapter(sqlCmd)

_daSales.Fill(_dtSales)

Catch ex As Exception

lblErrorMessage.Text = wpc.ShowError(ex.Message, 
DailySalesUserControl)

Exit Sub

End Try

' if no rows exist then clear and show no data 
message

If _dtSales.Rows.Count = 0 Then

lblErrorMessage.Text = wpc.ShowError(wpc.NoDataMsg, 
DailySalesUserControl)

Exit Sub

End If

gvSalesTotals.DataSource = _dtSales 
gvSalesTotals.DataBind()
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Upgrading Web Parts Created in Sage 
ERP MAS 500 Version 7.05

This section provides information about deploying Web 
parts, such as compiling Web parts, using selectors other 
than the Company Selector, and upgrading user-created Web 
parts from the Sage ERP MAS 500 version 7.05 Business 
Insights Dashboard. 

Compiling the 
Web part

The Daily Sales Totals Web part is now be ready to be 
compiled. 

1 Select Build SampleWebPart from the Build menu. 

2 After the .dll is built, copy it to the Bin folder of the 
Web site. 

3 The ASCX file should be in the WebParts 
CustomGallery folder and the Help file should be 
placed in the Help folder of the Web site. By placing the 
.dll in the bin folder, your Web part should now appear 
in the Custom Content 2 section when Add Content is 
selected. 

Using other 
selectors 

The other selectors available for the Sage ERP MAS 500 Web 
parts are for warehouse, budget type, and purchase product 
line. The code for these selectors is very similar to the 
Company Selector and is implemented in much the same 
manner. If you are using more than one selector, verify that 
the company selector is used first, because other selectors are 
usually dependent on the CompanyID being set. Refer to the 
following code for implementing the Warehouse Selector in 
the Top Items Web part. In the PreRender event of the Web 
part, this code follows the company selector code.

        Try

            WhseSelector1.Initialize(UseCompanyID)

        Catch ex As Exception
Internet Applications 253



Chapter 11
            lblErrorMessage.Text = 
wpc.ShowError(ex.Message, DailySalesUserControl)

            Exit Sub

        End Try

        If _Warehouse.Trim.Length = 0 Then

            _Warehouse = WhseSelector1.WhseID.Trim

        Else

            WhseSelector1.WhseID = _Warehouse.Trim

        End If

        Dim WhseKey As Int32

        Try

            WhseKey = wpc.GetWhseKey(_Warehouse.Trim, 
UseCompanyID)

        Catch ex As Exception

            lblErrorMessage.Text = 
wpc.ShowError(ex.Message, DailySalesUserControl)

            Exit Sub

        End Try

The following property is used to store the warehouse value 
at runtime:

Private _Warehouse As String = ""

    <Personalizable()> _

    Public Property Warehouse() As String

        Get

            Return _Warehouse

        End Get

        Set(ByVal value As String)

            _Warehouse = value

        End Set
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    End Property

The following event handler is used for the warehouse 
selector control:

Protected Sub WhseSelector1_ValueChanged() Handles 
WhseSelector1.ValueChanged

        _Warehouse = WhseSelector1.WhseID.Trim

    End Sub

The event handler for the company selector control must be 
changed to the following to set the warehouse to ''All'' when 
the company is changed:

    Protected Sub CompanySelector1_ValueChanged() 
Handles CompanySelector1.ValueChanged

        _CompanyID = CompanySelector1.CompanyID

        _Warehouse = "All"

        WhseSelector1.WhseID = "All"

    End Sub

This is the general methodology used for filtering data sets in 
DataViews and passing user values into GetData and Fill 
methods in data adapters. This same methodology can be 
used to create any necessary filters or user selected 
parameters.

Upgrading user-
created Web parts 
from Business 
Insights 
Dashboard 
version 7.05

The custom user control Web parts created for Sage ERP 
MAS 500 version 7.05 Business Insights Dashboard are still 
supported in this version with only minor changes to the 
ASCX files. 

The path in the Web site is changed from 
BusinessInsightsPortal to BusinessInsightsDashboard. All of 
the files you have created in the version 7.05 Business 
Insights Dashboard must be moved to the same folder in the 
current Dashboard. Be sure to include the 
CustomGallery1.ascx file that contains the list of your Web 
parts. 
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Because the common controls for the Sage ERP MAS 500 Web 
parts are now contained in a .dll, the reference to the controls 
must be changed in the user controls .ascx file. Remove any 
references to Sage ERP MAS 500 common controls, for 
example:

<%@ Register Src="../CompanySelector.ascx" 
TagName="CompanySelector" TagPrefix="uc1" %>

Add a reference to the Common Controls dll:

<%@ Register 
Assembly="Accounting.Web.Framework.BIControls" 
Namespace="Accounting.Web.Framework" 
TagPrefix="uc1" %>

This reference only needs to be added once for all the selector 
controls. Your selector controls now should use the same 
prefix that is specified in the register statement. If your Web 
parts use the common error messaging routine in 
WebPartCommon, make sure all controls are contained 
inside Panel controls as described in the sample Web part 
instructions above. The Web parts should now be compatible 
with the Business Insights Dashboard.
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Other Techniques and Methods

The sample Web part created for this document serves as a 
guide to creating compatible Web parts for the Business 
Insights Dashboard. You can find examples of topics not 
covered in this document, including various filtering 
methods, database access, and working with data sets and 
data views, throughout the Sage ERP MAS 500 Web parts. 

You can find additional information about the development 
of ASP.NET compatible Web parts at the following Web sites 
by typing the keywords ''Web parts'':

http://www.asp.net

http://www.theserverside.net

http://www.codeproject.com

The MSDN Library also contains useful information. At the 
following Web site, select the .NET Development menu > 
ASP.NET > Building ASP.NET Applications > Web Parts.

http://msdn2.microsoft.com/en-us/library/
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Source Code Listings for Sample Web Part

Source code for 
DailySalesTotal.vb

The following is the source code for the DailySalesTotal.vb 
class.

Imports System

Imports System.Web

Imports System.Web.UI

Imports System.Web.UI.WebControls

Imports System.Web.UI.WebControls.WebParts

Imports System.Data

Imports System.Data.SqlClient

Imports System.ComponentModel

Imports System.Text

Imports Accounting.Web.Framework

Public Class DailySalesTotal

    Inherits WebPart

Private _Title As String = "Daily Sales Totals"

    Private _CompanyID As String = ""

Private Const DEFAULT_TEXT As String = "[Default]"

Private DailySalesUserControl As UserControl

    Private WithEvents CompanySelector1 As 
CompanySelector

    Private pnlSelector As Panel

    Private pnlContent As Panel

    Private pnlErrorMsg As Panel

    Private gvSalesTotals As GridView

    Private lblErrorMessage As Label

    Private wpc As New WebPartCommon
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    <Personalizable(), DefaultValue("Daily Sales 
Totals")> Public Overrides Property Title() As 
String

        Get

            Return _Title

        End Get

        Set(ByVal value As String)

            _Title = value

        End Set

    End Property

    <Personalizable(), DefaultValue(DEFAULT_TEXT)> _

    Public Property CompanyID() As String

        Get

            Return _CompanyID

        End Get

        Set(ByVal value As String)

            _CompanyID = value

        End Set

    End Property

    Private Sub DailySalesTotal_Init(ByVal sender As 
Object, ByVal e As System.EventArgs) Handles Me.Init

        Try

            ' call the load control method to load 
the Daily Sales User Control

            DailySalesUserControl = 
DirectCast(Page.LoadControl("~/WebPart/
CustomGallery/DailySalesTotal.ascx"), UserControl)

            DailySalesUserControl.ID = "DailySales"

            Me.Controls.Add(DailySalesUserControl)
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' set the control variables for the controls 
contained in the user control

            pnlSelector = 
DirectCast(DailySalesUserControl.FindControl 
("pnlSelector"), Panel)

            pnlContent = 
DirectCast(DailySalesUserControl.FindControl 
("pnlContent"), Panel)

            pnlErrorMsg = 
DirectCast(DailySalesUserControl.FindControl 
("pnlErrorMsg"), Panel)

            CompanySelector1 = 
DirectCast(pnlSelector.FindControl 
("CompanySelector1"), CompanySelector)

            gvSalesTotals = 
DirectCast(pnlContent.FindControl("gvSalesTotals"), 
GridView)

            lblErrorMessage = 
DirectCast(pnlErrorMsg.FindControl 
("lblErrorMessage"), Label)

        Catch ex As Exception

            ' display the error message if necessary

            Dim errLabel As Label = New Label

            errLabel.ID = "DailySalesTotalError"

            errLabel.Text = "DailySalesTotal_Init:" 
& ex.Message

            Me.Controls.Add(errLabel)

End Try

    End Sub

Private Sub DailySalesTotal_PreRender(ByVal sender 
As Object, ByVal e As System.EventArgs) Handles 
Me.PreRender
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' call to reset the visible state of all controls

        ResetControls()

        'set the help path

        Me.HelpMode = WebPartHelpMode.Modeless

        Me.HelpUrl = "~/Help/DailySalesHelp.htm"

        Dim userProfileCompanyID As String = ""

        Try

            ' get the default company from the Profile 
object

            userProfileCompanyID = 
HttpContext.Current.Profile.Item("CompanyID"). 
ToString.Trim

        Catch ex As Exception

            lblErrorMessage.Text = 
wpc.ShowError(ex.Message, DailySalesUserControl)

        End Try

        ' variable to hold CompanyID that is used

        ' _CompanyID could be [Default]

        Dim UseCompanyID As String

        ' if there is no value for _CompanyID use the 
default company from Profile

        If _CompanyID.Trim.Length = 0 Or _CompanyID 
= DEFAULT_TEXT Then

            If userProfileCompanyID.Trim.Length = 0 
Then 'if no default set then show error message

lblErrorMessage.Text = 
wpc.ShowError(wpc.NoDfltCmpnyMsg, 
DailySalesUserControl)

                Exit Sub

            End If

            ' set the CompanyID property to save
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            _CompanyID = DEFAULT_TEXT

            ' use the default company

            UseCompanyID = userProfileCompanyID.Trim

        Else ' if there is a saved value, use it

            UseCompanyID = _CompanyID

        End If

        Try ' set the company selector to match the 
companyID property

            CompanySelector1.CompanyID = _CompanyID

        Catch ex As Exception

            lblErrorMessage.Text = 
wpc.ShowError(ex.Message, DailySalesUserControl)

            Exit Sub

        End Try

        ' set up the sales totals grid

        Dim SqlSelect As String

        Dim _dtSales As New System.Data.DataTable

        ' Sql statement for the grid data adapter

        Try

            Dim str As New StringBuilder(277)

            str.AppendLine("SELECT 
S.SperID[Salesperson], SUM(SO.TranAmt)[SOTotal] 
FROM tsoSalesOrder SO")

str.AppendLine("INNER JOIN tarSalesperson S")

            str.AppendLine("ON SO.PrimarySperKey = 
S.SperKey")

            str.AppendLine("GROUP BY S.SperID, 
SO.TranDate, SO.CompanyID")

            str.AppendLine("HAVING SO.TranDate = 
'2008-06-05'")
262 Internet Applications



Web Part Development
            str.AppendLine("AND SO.CompanyID = 
@CompanyID")

            str.AppendLine("ORDER BY SUM(SO.TranAmt) 
DESC")

            SqlSelect = str.ToString

            Dim sqlCmd As SqlCommand = New SqlCommand

            ' setup the sql Command object

            With sqlCmd

                .CommandType = CommandType.Text

                .CommandText = SqlSelect

                .CommandTimeout = 
Accounting.Web.Framework.Session.QueryTimeout

                
.Parameters.AddWithValue("@CompanyID", 
UseCompanyID)

                Dim con As SqlConnection = 
Accounting.Web.Framework.Session.OpenConnection

                .Connection = con

            End With

            Dim _daSales As SqlDataAdapter = New 
SqlDataAdapter(sqlCmd)

            _daSales.Fill(_dtSales)

        Catch ex As Exception

            lblErrorMessage.Text = 
wpc.ShowError(ex.Message, DailySalesUserControl)

            Exit Sub

        End Try

        ' if no rows exist then clear and show no 
data message

        If _dtSales.Rows.Count = 0 Then
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            lblErrorMessage.Text = 
wpc.ShowError(wpc.NoDataMsg, DailySalesUserControl)

            lblErrorMessage.Text = 
lblErrorMessage.Text & " For " & UseCompanyID

            Exit Sub

        End If

        'bind the grid control

        gvSalesTotals.DataSource = _dtSales

        gvSalesTotals.DataBind()

End Sub

    Private Sub ResetControls()

        lblErrorMessage.Text = ""

        pnlErrorMsg.Visible = False

        pnlContent.Visible = True

        pnlSelector.Visible = True

    End Sub

    Private Sub CompanySelector1_ValueChanged(ByVal 
sender As Object, ByVal e As System.EventArgs) 
Handles CompanySelector1.ValueChanged

        _CompanyID = CompanySelector1.CompanyID

    End Sub

End Class

Source code for 
DailySalesTotal.as
px

The following is the source code for the DailySalesTotal.aspx 
class.

<%@ Control Language="VB" AutoEventWireup="false" 
EnableViewState="true" %>

<%@ Register 
Assembly="Accounting.Web.Framework.BIControls" 
Namespace="Accounting.Web.Framework" 
TagPrefix="cc1" %>
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<asp:Panel ID="pnlSelector" runat="server" 
Visible="true">

    <cc1:CompanySelector ID="CompanySelector1" 
runat="server" />

</asp:Panel>

<asp:Panel ID="pnlContent" runat="server"  
Visible="true">

    <asp:GridView ID="gvSalesTotals" runat="server" 
SkinID="WebPart" AutoGenerateColumns="False">

        <Columns>

            <asp:BoundField DataField="Salesperson" 
HeaderText="Salesperson" HtmlEncode="False" >

                <HeaderStyle HorizontalAlign="Left" 
Wrap="false" VerticalAlign="Bottom"></HeaderStyle >

                <ItemStyle HorizontalAlign="Left" 
Wrap="False" Width="80px" CssClass="DefaultCell1" > 
</ItemStyle>

            </asp:BoundField >

            <asp:BoundField DataField="SOTotal" 
HeaderText="SalesTotal" HtmlEncode="False" >

                <HeaderStyle HorizontalAlign="Left" 
Wrap="false" VerticalAlign="Bottom"></HeaderStyle >

                <ItemStyle HorizontalAlign="Left" 
Wrap="False" Width="80px" CssClass="DefaultCell" 
></ItemStyle> 
</asp:BoundField>

        </Columns> 
</asp:GridView> 
</asp:Panel>

<asp:Panel ID="pnlErrorMsg" runat="server" 
Visible="false"> <asp:Label ID="lblErrorMessage" 
runat="server" CssClass="ErrorLabel" Visible="true" 
></asp:Label>

</asp:Panel> 
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Numerics
128-bit encryption 36

A
Activation, customers 129
Active Server Pages (ASP)

connection to databases 221
description of 12
login page 223
Navigation frame 224
product categories in 97

ActiveX Data Objects (ADO) 12
Address, Web sites 38
Administrators

description of 113
requirements for 113
See also Buyers

Allow Inquiry rights 113
Allow Maintenance rights 113
Anonymous login

configuring 72
description of 33

ASP. See Active Server Pages
Authenticated access 72

B
Business Insights Dashboard

client requirements 40
configuring 133
configuring ASP .NET 138
custom errors 165
customizing Dashboard Web pages 

137
data processing 28
description of 22
displaying a specific number of rows 

155
enabling and disabling custom errors 

160
handling large sets of data 147
modifying the execution timeout value 

169
modifying the Filter On Numerics 

setting 157
modifying the Immediate Results for 

Filter setting 162
modifying the Immediate Results 

setting 160
requirement for 24, 40
scheduling updates 80
securing the connection 147
security 24
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Business Insights Dashboard (continued)
setting connection strings 138
setting security for Web Parts 136
setting up 136
setting up users 134
updating data 135
Web browser configuration 40

Business Insights Dashboard Web site
customizing 213, 233
Windows authentication 33

Buyers
access rights 113
adding in Sage ERP MAS 500 117
changing information 118
deleting 118
description of 112
effective time of changes 120
links to customer 115
password 116
transaction limits 114

C
Cancelled orders 17
Cascading Stylesheets (CSS). See Stylesheets
Case sensitivity 41
Checklist, installation 54
Client workstation

Business Insights Dashboard settings 
40

Closed orders 17
Closing, eCustomer Web site 94
Co-location hosting 29
COM+ applications

applying logins to 190
data inquiries and 26
description of 11
ordering processing and 27
player 27
recorder 27
restarting 187
security for 34
user for 56
viewing queues 183

COM+ user
changing 190
default 56

Common Information, options to set in 78
Company

colors and text formats 225
logo and name 224

Configuration
anonymous access 71
Business Insights Dashboard 133
database link 193
image folder 78
security 71
Web site 91

connection strings
LocalSqlServer, setting 141
MAS500App, modifying 143

Content frame 215
Credit limits

changing for approved customers 129
eCustomer 114

Credit manager, setup 122
CSS. See Stylesheets
Currency, transaction limits and 115
Customers

activating 129
buyer links to 115
credit limits and 114
definition of 20
description of 112
levels of access rights 113
setting up for eSalesforce 128
transaction limits 114
warehouse for 116

D
Data link configuration

assigning default COM+ user 57
eCustomer, Business Insights 

Dashboard, and eSalesforce 193
setup in installation 56
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Database Utilities. See Database Utilities, 
Financial and Database Utilities, 
Manufacturing

Databases
changing 225
connecting to 193
connection to Web site 221
description of 13
sales orders updating in 183
See also Internet application database

Diagnostic Web site pages 174

E
eCustomer

adding items for sale 95
architecture of 11
case sensitivity 41
company for 92
credit limits and 114
database requirements 13
eSalesforce integration 21
item descriptions 110
item images 107
opening for orders 92
queued processing 27
removing items from 103
settings for 78

eCustomer Web site
adding pages 227
address of 38
changing default home page 227
closing 94
company logo and name 224
diagnostic pages 174
effects of opening 226
help for 231
home page 223
login page 223
organization of 14
page layout 214, 236
required customizations 222
security recommendations 32
Site Maintenance page 174
status of 93

eCustomer Web site (continued)
Visual InterDev and 219
See also Web sites

E-mail notification 129
Error messages, customizing pages 175
eSalesforce

case sensitivity 41
data processing 28
description of 18
eCustomer integration 21
sales cycle and 20
setting changes 130

eSalesforce Web site
address of 38
customization requirements 222
help for 231
help link 228
navigation links 228
organization of 19
page layout 216, 243
security recommendations 33
Site Maintenance page 175
Visual InterDev and 219
See also Web sites

eTimesheets
address of 38

Event Viewer, using 179

F
Firewalls

hosting and 29
protecting Web server with 33

Folder names, changing with upgrades 38
Frames

eCustomer Web site 214, 236
eSalesforce Web site 216, 243

FTP, sending installation with 57

H
Help

changing link to 228
customizing 231

Home page
changing link to 228
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Home Page (continued)
customizing sample 226
default 227
effects of opening 226
linking to eCustomer login page 223

Hosting
internal 29
Internet service provider (ISP) 30

I
IAppUser, description of 56
icConn.udl, See Data link configuration
IIS. See Internet Information Services (IIS)
Images, item

browsing for 110
description of 13
folder for 90
folder name requirement 79
requirements for 107
security and 36
size of 107
specifying folder for 78
UNC designation for folder 91
where to store 107

Images, Web sites 217
Installation

checklist 54
Internet Applications 57
methods of 54
Microsoft Messaging Queue (MSMQ) 

46, 47
selecting modules to install 62
wizard 57

Internal hosting 29
Internet application database

changing 225
connection to 193
connection to Web site 221
description of 13
Navigation frame table in 229

Internet Information Services (IIS)
authenticated access 72
configuring 71

Internet Information Services (IIS) 
(continued)
data inquiries and 26
description of 12
folder names 37
NTFS requirement 34
ordering processing and 27
security and 33
upgrades and application names 38

Internet service provider (ISP)
hosting 30
sending installation files to 57

Internet Services Manager, using 71
Inventory items

selling through Web site 12
warehouse requirement 95
See also Items sold through site

Inventory Management, product 
categories 96

ISP. See Internet service provider (ISP)
Items sold through site

assigning to product categories 101
description of 110
description of images for 13
including on Web site 95
removing from product categories 103
warehouse requirement 95

L
LocalSqlServer connection string, setting 

141
Login page

description of 223
linking to 228

M
Maintain Items window

adding items to Web site 104
assigning images and descriptions 109

Maintain Non-Inventory Items window
adding items to Web site 104
assigning images and descriptions 109
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MAS500App connection string, modifying 
143

Microsoft Messaging Queue (MSMQ)
description of 12
installing 46, 47
See also Queues

Modules, registering and activating 50

N
Navigation frame

company logo and name in 224
customizing 228
description of 215, 238

NetBIOS access
internal hosting and 29
Internet service provider (ISP) hosting 

and 30
item images and 91

Non-inventory items 12
See also Items sold through site

NTFS
security requirements and 34
selecting volume for installation 61

O
OLE DB, description of 12
Order processing

cancelled orders 17
closed orders 17
COM+ applications and 27
Web site links to Sales Order 15

P
Page layout

eCustomer Web site 214, 236
eSalesforce Web site 216, 243

Passwords
adding to COM+ applications 190
buyers 116
replacing lost 118

Primary member, sales teams 126

ProcessWebSOUser
description of 117
recreating 183

Product categories
appearance in eCustomer 97
assigning items to 101
changing 99
creating 98
deleting 100
description of 12
groups and subgroups of 96
naming requirements 97
removing items from 103
structure of 96

Q
Queues

description of 27
software used for 12
viewing 183
Web Site Maintenance page and 185

S
Sage ERP MAS 500

buyers, adding in 117
buyers, changing 118
customer setup 128
installation and upgrade process 49
installation instructions for 48
modules to register and activate 50
required version of 48
salespeople setup 124

Sales cycle, eSalesforce and 20
Sales Order

correctable 181
credit limits 114
ensuring update of application 

databases 183
processing orders with errors 182
Web site orders in 15

Sales teams
listing of 127
setting up 126
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Salespeople
e-mail notification 129
maximum number of 124
setup 124
teams of 126

Secure Socket Layers (SSL)
description of 35
item images and 108

Security
128-bit encryption 36
administrative pages 74
authenticated access 72
Business Insights Dashboard 24
COM+ applications 34
description of 33
firewalls 33
images and 36
rights in Sage ERP MAS 500 51
Secure Socket Layers (SSL) 35
setting in Internet Services Manager 71
standard setting 72
transaction process 34
user access and 113
Web Site Maintenance page 74

SQL Server
case sensitivity 41
reviewing scheduled events 82

SQL Server Agent, running 82
Status bar message

eCustomer 93
eSalesforce 131

Stylesheets
description of 216, 244
modifying 225
Navigation frame 224

Supervisors, description of 113
System messages 179

T
Task frame 215
Themes. See Stylesheets
ticIappNavBarBtn table 229
Tool tips, customizing 231

Toolbar frame 215, 238
Transaction limits 114
Troubleshooting

Business Insights Dashboard-specific 
errors 197

COM+ applications 186
eCustomer-specific errors 176
eSalesforce-specific errors 176
queues 183
retrying unprocessable transactions 

185
sales order corrections 181
sales orders not in application database 

183
system messages 179
unprocessable sales orders 183
Web Site Maintenance page and 174

U
Uninstallation

client software 68
during upgrade 59

Universal Naming Convention (UNC) 
designation 91

Upgrades
folder and IIS application name 

changes 38
Sage ERP MAS 500 and 48
Web components 59

URL, Web sites 38

V
Virtual private network (VPN), use in 

hosting 30
Visual InterDev, customizing Web sites 

with 219

W
Warehouses

customers and 116
requirement for inventory items 95

Web components
changing and reinstalling software 68
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Web components (continued)
complete installation 60
custom installation 61
folder for installing 38
installing 57
removing software 68
selecting path for 62
uninstalling 59
upgrading 59

Web server
Microsoft Messaging Queue (MSMQ) 

installation 46, 47
name changing 38
settings in Sage ERP MAS 500 78

Web Site Maintenance page
eSalesforce 130
retrying unprocessable transactions 

185
securing 74
troubleshooting with 174
using 92, 130

Web sites
addresses of 38
Common Information settings for 78
database connections 221
required customizations 222
uninstallation during upgrades 59
See also eCustomer Web site and 

eSalesforce Web site
Windows Installer, description of 57
Windows integrated security

Business Insights Dashboard 
requirement 33

data link configuration and 193
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